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The following documentation is split into four parts. About Bio-Formats explains the goal of the software, discusses
how it processes metadata, and provides other useful information such as version history and how to report bugs. User
Information focusses on how to use Bio-Formats as a plugin for ImageJ and Fiji, and also gives details of other software
packages which can use Bio-Formats to read and write microscopy formats. Developer Documentation covers more
indepth information on using Bio-Formats as a Java library and how to interface from non-Java codes. Finally, Formats
is a guide to all the file formats currently supported by Bio-Formats.
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About Bio-Formats
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Bio-Formats is a standalone Java library for reading and writing life sciences image file formats. It is capable of
parsing both pixels and metadata for a large number of formats, as well as writing to several formats.

The primary goal of Bio-Formats is to facilitate the exchange of microscopy data between different software packages
and organizations. It achieves this by converting proprietary microscopy data into an open standard called the OME
data model', particularly into the OME-TIFF? file format.

We believe the standardization of microscopy metadata to a common structure is of vital importance to the community.
A brief article on the benefits of standardization® from thinkstandards.net* provides an excellent summary.

Thttp://genomebiology.com/2005/6/5/R47
Zhttp://www.openmicroscopy.org/site/support/ome-model/ome-tiff
3http://www.thinkstandards.net/benefits.html
“http://www.thinkstandards.net/



http://genomebiology.com/2005/6/5/R47
http://genomebiology.com/2005/6/5/R47
http://www.openmicroscopy.org/site/support/ome-model/ome-tiff
http://www.thinkstandards.net/benefits.html
http://www.thinkstandards.net/

CHAPTER
ONE

BIO-FORMATS METADATA PROCESSING

Pixels in microscopy are almost always very straightforward, stored on evenly spaced rectangular grids. It is the
metadata (details about the acquisition, experiment, user, and other information) that can be complex. Using the OME
data model enables applications to support a single metadata format, rather than the multitude of proprietary formats
available today.

Every file format has a distinct set of metadata, stored differently. Bio-Formats processes and converts each format’s
metadata structures into a standard form called the OME data model', according to the OME-XML? specification.
We have defined an open exchange format called OME-TIFF® that stores its metadata as OME-XML. Any software
package that supports OME-TIFF is also compatible with the dozens of formats listed on the Bio-Formats page,
because Bio-Formats can convert your files to OME-TIFF format.

To facilitate support of OME-XML, we have created a library in Java* for reading and writing OME-XML’ metadata.
There are three types of metadata in Bio-Formats, which we call core metadata, original metadata, and OME metadata.

1. Core metadata only includes things necessary to understand the basic structure of the pixels: image resolution;
number of focal planes, time points, channels, and other dimensional axes; byte order; dimension order; color
arrangement (RGB, indexed color or separate channels); and thumbnail resolution.

2. Original metadata is information specific to a particular file format. These fields are key/value pairs in the
original format, with no guarantee of cross-format naming consistency or compatibility. Nomenclature often
differs between formats, as each vendor is free to use their own terminology.

3. OME metadata is information from #1 and #2 converted by Bio-Formats into the OME data model. Perform-
ing this conversion is the primary purpose of Bio-Formats. Bio-Formats uses its ability to convert proprietary
metadata into OME-XML as part of its integration with the OME and OMERO servers— essentially, they are
able to populate their databases in a structured way because Bio-Formats sorts the metadata into the proper
places. This conversion is nowhere near complete or bug free, but we are constantly working to improve it.
We would greatly appreciate any and all input from users concerning missing or improperly converted metadata
fields.

Thttp://genomebiology.com/2005/6/5/R47
Zhttp://www.openmicroscopy.org/site/support/ome-model/ome-xml
3http://www.openmicroscopy.org/site/support/ome-model/ome-tiff
“http://www.openmicroscopy.org/site/support/ome-model/ome-xml/java-library.html
Shttp://www.openmicroscopy.org/site/support/ome-model/ome-xml
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CHAPTER
TWO

HELP

For help, see the Bio-Formats', File Formats® and OME-XML and OME-TIFF? sections of the OME FAQ* for answers
to some common questions. Please contact us’ if you have any questions or problems with Bio-Formats. There is a
guide for reporting bugs here.

For advanced users and developers, further information is available on the troubleshooting page.

2.1 Reporting a bug

2.1.1 Before filing a bug report

If you think you have found a bug in Bio-Formats, the first thing to do is update your version of Bio-Formats to the
latest trunk version. It is possible that the problem has already been addressed. For both Fiji and ImagelJ users, select
Update LOCI Plugins under the LOCI menu. Select Trunk Build.

You can also download the newest version of Bio-Formats®. If you are not sure which version you need, select the
Trunk Build under LOCI Tools complete bundle.

2.1.2 Sending a bug report

If you can still reproduce the bug after updating to the newest version of Bio-Formats, please send us a bug report. To
ensure that any inquiries you make are resolved promptly, please include the following information:

» Exact error message. Copy and paste any error messages into the text of your email. Alternatively, attach a
screenshot of the relevant windows.

* Version information. Indicate which release of Bio-Formats, which operating system, and which version of
Java you are using.

* Non-working data. If possible, please send a non-working file. This helps us ensure that the problem is fixed
for next release and will not reappear in later releases. We can provide you with an FTP server for uploading
your file(s) if needed. Note that any data provided is used for internal testing only; we do not make images
publicly available unless given explicit permission to do so.

* Metadata and screenshots. If possible, include any additional information about your data. We are especially
interested in the expected dimensions (width, height, number of channels, Z slices, and timepoints). Screenshots
of the image being successfully opened in other software are also useful.

Uhttp://www.openmicroscopy.org/site/support/fag/bio-formats
Zhttp://www.openmicroscopy.org/site/support/faq/file-formats
3http://www.openmicroscopy.org/site/support/fag/ome-xml-and-ome-tiff
“http://www.openmicroscopy.org/site/support/faq
Shttp://www.openmicroscopy.org/site/community/mailing-lists
Shttp://www.openmicroscopy.org/site/products/bio-formats/downloads/



http://www.openmicroscopy.org/site/support/faq/bio-formats
http://www.openmicroscopy.org/site/support/faq/file-formats
http://www.openmicroscopy.org/site/support/faq/ome-xml-and-ome-tiff
http://www.openmicroscopy.org/site/support/faq
http://www.openmicroscopy.org/site/community/mailing-lists
http://www.openmicroscopy.org/site/products/bio-formats/downloads/

Bio-Formats Documentation, Release 4.4.8-DEV

* Format details. If you are requesting support for a new format, we ask that you send as much data as you
have regarding this format (sample files, specifications, vendor/manufacturer information, etc.). This helps us
to better support the format and ensures future versions of the format are also supported.

Once you have gathered all the relevant information, send it as an e-mail to the OME Users mailing list’.

Please be patient - it may be a few days until you receive a response, but we reply to every email inquiry we receive.

2.2 Troubleshooting

This page is aimed at anyone who is responsible for supporting Bio-Formats, but may also be useful for advanced
users looking to troubleshoot their own problems. Eventually, it might be best to move some of this to the FAQ or
other documentation.

2.2.1 General tips
» Make sure to read the FAQS, particularly the “File Formats”, “Bio-Formats”, and “OME-XML & OME-TIFF”
sections

« If this page doesn’t help, it is worth quickly checking the following places where questions are commonly asked
and/or bugs are reported:

— OME Trac’

Fiji Bugzilla (for Imagel/Fiji issues)'”

ome-devel mailing list'" (searchable using google with ‘site:lists.openmicroscopy.org.uk’)

tIZ

— ome-users mailing list'~ (searchable using google with ‘site:lists.openmicroscopy.org.uk’)

Image] mailing list (for Imagel/Fiji issues)'?

» Make sure to ask for a _specific_ error message or description of the unexpected behavior, if one is not provided
(“it does not work”™ is obviously not adequate).

* “My (12, 14, 16)-bit images look all black when I open them” is a common issue. In ImagelJ/Fiji, this is almost
always fixable by checking the “Autoscale” option; with the command line tools, the “-autoscale -fast” options
should work. The problem is typically that the pixel values are very, very small relative to the maximum possible
pixel value (4095, 16383, and 65535, respectively), so when displayed the pixels are effectively black.

« If the file is very, very small (4096 bytes) and any exception is generated when reading the file, then make sure
it is not a Mac OS X resource fork'#. The ‘file’ command should tell you:

$ file /path/to/suspicious-file
suspicious—-file: AppleDouble encoded Macintosh file

7http://lists.openmicroscopy.org.uk/mailman/listinfo/ome-users/
8http://www.openmicroscopy.org/site/support/faq
9http://trac.openmicroscopy.org.uk/ome
10http://fiji.sc/cgi-bin/bugzilla/index.cgi
http://lists.openmicroscopy.org.uk/pipermail/ome-devel
Zhttp://lists.openmicroscopy.org.uk/pipermail/ome-users
Bhttp://imagej.1557.n6.nabble.com/
14http://en.Wikjpedial.01rg/wiki/Resource_fork#The,_Macintosh_ﬁle_system
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2.2.2 Tips for ImagedJ/Fiji

» The Bio-Formats version being used can be found by selecting “Help > About Plugins > LOCI Plugins”.
* “How do I make the options window go away?” is a common question. There are a few ways to do this:

— To disable the options window only for files in a specific format, select “Plugins > LOCI > LOCI Plugins
Configuration”, then pick the format from the list and make sure the “Windowless” option is checked.

— To avoid the options window entirely, use the “Plugins > LOCI > Bio-Formats Windowless Importer”
menu item to import files.

— Open files by calling the Bio-Formats importer plugin from a macro.

* A not uncommon cause of problems is that the user has multiple copies of loci_tools.jar in their ImagelJ plugins
folder, or has a copy of loci_tools.jar and a copy of bio-formats.jar. It is often difficult to determine for sure
that this is the problem - the only error message that pretty much guarantees it is a “NoSuchMethodException”.
If the user maintains that they downloaded the latest version and whatever error message/odd behavior they are
seeing looks like it was fixed already, then it is worth suggesting that they remove all copies of loci_tools.jar
and download a fresh version.

2.2.3 Tips for command line tools

* When run with no arguments, all of the command line tools will print information on usage.

e When run with the ‘-version’ argument, ‘showinf’ and ‘bfconvert’ will display the version of Bio-Formats that
is being used (version number, build date, and Git commit reference).

2.2.4 Tips by format

31/0lympus Slidebook (.sld)

* Slidebook support is generally not great, despite a lot of effort. This is the one format for which it is recom-
mended to just export to OME-TIFF from the acquisition software and work with the exported files. Happily,
there is free software from 31 which can do the export post-acquisition: https://www.slidebook.com/reader.php

DICOM

» Health care or institutional regulations often prevent users from sending problematic files, so often we have to
solve the problem blind. In these cases, it is important to get the exact error message, and inform the user that
fixing the problem may be an iterative process (i.e. they might have to try a couple of trunk builds before we
can finally fix the problem).

ZVI

e If the ZVI reader plugin is installed in ImageJ/Fiji, then it will be used instead of Bio-Formats to read ZVI files.
To check if this is the cause of the problem, make sure that the file opens correctly using “Plugins > LOCI >
Bio-Formats Importer”; if that works, then just remove ZVI_Reader.class from the plugins folder.
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CHAPTER
THREE

BIO-FORMATS VERSIONS

Bio-Formats is updated whenever a significant bug fix is made, or whenever a new version of OMERO' is released.
The version number is three numbers separated by dots; e.g., 4.0.0. See the version history for a list of major changes
in each release.

The latest stable version of Bio-Formats is 4.4.8-DEV. For future development directions, see the 4.5% and 5.0°
roadmaps.

3.1 Version history

3.1.1 4.4.6 (2013 February 7)

* Many bug fixes

3.1.2 4.4.5 (2012 November 13)

* Restructured and improved documentation

* Many bug fixes, including:
- File grouping in many multi-file formats
— Maven build fixes

— ITK plugin fixes

3.1.3 4.4.4 (2012 September 24)

* Many bug fixes

3.1.4 4.4.2 (2012 August 22)

¢ Security fix for OMERO plugins for ImageJ

Thttp://www.openmicroscopy.org/site/support/omero4/
Zhttp://trac.openmicroscopy.org.uk/ome/query?group=status&component=Bio-Formats&milestone=OMERO-4.5
3http://trac.openmicroscopy.org.uk/ome/query?group=status&component=Bio-Formats&milestone=OMERO-5.0
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3.1.5 4.4.1 (2012 July 20)

* Fix a bug that prevented BigTIFF files from being read

* Fix a bug that prevented PerkinElmer .flex files from importing into OMERO

3.1.6 4.4.0 (2012 July 13)

e Many, many bug fixes
¢ Added support for:

.nd2 files from Nikon Elements version 4

PerkinElmer Operetta data

MIPEG-compressed AVIs

MicroManager datasets with multiple positions
Zeiss CZI data
IMOD data

3.1.7 4.3.3 (2011 October 18)

* Many bug fixes, including:
— Speed improvements to HCImage/SimplePCI and Zeiss ZVI files

Reduce memory required by Leica LIF reader

More accurately populate metadata for Prairie TIFF datasets

Various fixes to improve the security of the OMERO plugin for ImageJ

Better dimension detection for Bruker MRI datasets

Better thumbnail generation for histology (SVS, NDPI) datasets

Fix stage position parsing for Metamorph TIFF datasets

Correctly populate the channel name for PerkinElmer Flex files

3.1.8 4.3.2 (2011 September 15)

* Many bug fixes, including:
— Better support for Volocity datasets that contain compressed data
— More accurate parsing of ICS metadata
— More accurate parsing of cellSens .vsi files

* Added support for a few new formats

— .inr

Canon DNG
Hitachi S-4800
Kodak .bip
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* Updated Zeiss LSM reader to parse application tags

JPX
Volocity Library Clipping (.acff)
Bruker MRI

* Various performance improvements, particularly for reading/writing TIFFs

» Updated OMERO ImageJ plugin to work with OMERO 4.3.x

3.1.9 4.3.1 (2011 July 8)

 Several bug fixes, including:

— Fixes for multi-position Deltavision files

Fixes for MicroManager 1.4 data

Fixes for 12 and 14-bit JPEG-2000 data

— Various fixes for reading Volocity .mvd2 datasets

* Added various options to the ‘showinf” and ‘bfconvert’ command line tools

* Added better tests for OME-XML backwards compatibility

* Added the ability to roughly stitch tiles in a multi-position dataset

3.1.10 4.3.0 (2011 June 14)

* Many bug fixes, including:

— Many fixes for reading and writing sub-images

— Fixes for stage position parsing in the Zeiss formats

File type detection fixes

» Updated JPEG-2000 reading and writing support to be more flexible

* Added support for 9 new formats:

InCell 3000
Trestle
Hamamatsu .ndpi
Hamamatsu VMS
SPIDER

Volocity .mvd2
Olympus SIS TIFF
IMAGIC

cellSens VSI

» Updated to 2011-06 OME-XML schema

* Minor speed improvements in many formats

» Switched version control system from SVN to Git

3.1. Version history
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Moved all Trac tickets into the OME Trac: http://trac.openmicroscopy.org.uk
* Improvements to testing frameworks
* Added Maven build system as an alternative to the existing Ant build system

¢ Added pre-compiled C++ bindings to the download page

3.1.11 4.2.2 (2010 December 6)

* Several bug fixes, notably:
— Metadata parsing fixes for Zeiss LSM, Metamorph STK, and FV1000
— Prevented leaked file handles when exporting to TIFF/OME-TIFF
— Fixed how BufferedImages are converted to byte arrays

* Proper support for OME-XML XML annotations

* Added support for SCANCO Medical .aim files

* Minor improvements to ImagelJ plugins

* Added support for reading JPEG-compressed AVI files

3.1.12 4.2.1 (2010 November 12)

* Many, many bug fixes

¢ Added support for 7 new formats:
CellWorX .pnl

— ECAT7

Varian FDF

Perkin Elmer Densitometer
FEI TIFF
Compix/SimplePCI TIFF
Nikon Elements TIFF

* Updated Zeiss LSM metadata parsing, with generous assistance from Zeiss, FMI, and MPI-CBG
* Lots of work to ensure that converted OME-XML validates

¢ Improved file stitching functionality; non-numerical file patterns and limited regular expression-style patterns
are now supported

3.1.13 4.2.0 (2010 July 9)

* Fixed many, many bugs in all aspects of Bio-Formats

* Reworked ImageJ plugins to be more user- and developer-friendly

¢ Added many new unit tests

* Added support for approximately 25 new file formats, primarily in the SPM domain

» Rewrote underlying I/O infrastructure to be thread-safe and based on Java NIO

3.1. Version history 11
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* Rewrote OME-XML parsing/generation layer; OME-XML 2010-06 is now supported
* Improved support for exporting large images

* Improved support for exporting to multiple files

Updated logging infrastructure to use slf4j and log4j

3.1.14 4.1.1 (2009 December 3)

* Fixed many bugs in popular file format readers
4.1 (2009 October 21):
* Fixed many bugs in most file format readers
* Significantly improved confocal and HCS metadata parsing
* Improved C++ bindings
 Eliminated references to Java AWT classes in core Bio-Formats packages
* Added support for reading Flex datasets from multiple servers
* Improved OME-XML generation; generated OME-XML is now valid
* Added support for Olympus ScanR data
* Added OSGi information to JARs
* Added support for Amira Mesh files
* Added support for LI-FLIM files
* Added more informative exceptions
* Added support for various types of ICS lifetime data
* Added support for Nikon EZ-C1 TIFFs
* Added support for Maia Scientific MIAS data

3.1.15 4.0.1 (2009 June 1)

* Lots of bug fixes in most format readers and writers

* Added support for Analyze 7.1 files

* Added support for Nifti files

¢ Added support for Cellomics .cOl files

* Refactored ImagelJ plugins

* Bio-Formats, the common package, and the ImagelJ plugins now require Java 1.5
* Eliminated native library dependency for reading lossless JPEGs

* Changed license from GPL v3 or later to GPL v2 or later

Updated Olympus FV1000, Zeiss LSM, Zeiss ZVI and Nikon ND2 readers to parse ROI data
* Added option to ImagelJ plugin for displaying ROIs parsed from the chosen dataset

Fixed BufferedImage construction for signed data and unsigned int data
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3.1.16 4.0.0 (2009 March 3)
* Improved OME data model population for Olympus FV1000, Nikon ND2, Metamorph STK, Leica LEI, Leica
LIF, InCell 1000 and MicroManager
* Added TestNG tests for format writers
* Added option to ImageJ plugin to specify custom colors when customizing channels
* Added ability to upgrade the ImageJ plugin from within Imagel
* Fixed bugs in Nikon ND2, Leica LIF, BioRad PIC, TIFF, PSD, and OME-TIFF
* Fixed bugs in Data Browser and Exporter plugins
* Added support for Axon Raw Format (ARF), courtesy of Johannes Schindelin
* Added preliminary support for IPLab-Mac file format

3.1.17 2008 December 29

* Improved metadata support for Deltavision, Zeiss LSM, MicroManager, and Leica LEI
* Restructured code base/build system to be component-driven

* Added support for JPEG and JPEG-2000 codecs within TIFF, OME-TIFF and OME-XML
* Added support for 16-bit compressed Flex files

* Added support for writing JPEG-2000 files

* Added support for Minolta MRW format

* Added support for the 2008-09 release of OME-XML

* Removed dependency on JMagick

* Re-added caching support to data browser plugin

» Updated loci.formats.Codec API to be more user-friendly

» Expanded loci.formats.MetadataStore API to better represent the OME-XML model

* Improved support for Nikon NEF

* Improved support for Till Vision files

* Improved Image] import options dialog

* Fixed bugs with Zeiss LSM files larger than 4 GB

* Fixed minor bugs in most readers

* Fixed bugs with exporting from an Image5D window

* Fixed several problems with virtual stacks in ImageJ

3.1.18 2008 August 30

* Fixed bugs in many file format readers

* Fixed several bugs with swapping dimensions
¢ Added support for Olympus CellR/APL files
* Added support for MINC MRI files
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* Added support for Aperio SVS files compressed with JPEG 2000
* Added support for writing OME-XML files

* Added support for writing APNG files

¢ Added faster LZW codec

Added drag and drop support to ImageJ shortcut window

* Re-integrated caching into the data browser plugin

3.1.19 2008 July 1

* Fixed bugs in most file format readers

* Fixed bugs in OME and OMERO download functionality

* Fixed bugs in OME server-side import

* Improved metadata storage/retrieval when uploading to and downloading from the OME Perl server
 Improved Bio-Formats ImageJ macro extensions

* Major updates to MetadataStore API

* Updated OME-XML generation to use 2008-02 schema by default

¢ Addressed time and memory performance issues in many readers

* Changed license from LGPL to GPL

* Added support for the FEI file format

* Added support for uncompressed Hamamatsu Aquacosmos NAF files
* Added support for Animated PNG files

* Added several new options to Bio-Formats ImageJ plugin

* Added support for writing ICS files

3.1.20 2008 April 17

¢ Fixed bugs in Slidebook, ND2, FV1000 OIB/OIF, Perkin Elmer, TIFF, Prairie, Openlab, Zeiss LSM, MNG,
Molecular Dynamics GEL, and OME-TIFF

* Fixed bugs in OME and OMERO download functionality

* Fixed bugs in OME server-side import

* Fixed bugs in Data Browser

¢ Added support for downloading from OMERO 2.3 servers

* Added configuration plugin

» Updates to MetadataStore API

» Updates to OME-XML generation - 2007-06 schema used by default

* Added support for Li-Cor L2D format

* Major updates to TestNG testing framework

¢ Added support for writing multi-series OME-TIFF files
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* Added support for writing BigTIFF files

3.1.21 2008 Feb 12

* Fixed bugs in QuickTime, SimplePCI and DICOM

* Fixed a bug in channel splitting logic

3.1.22 2008 Feb 8

* Many critical bugfixes in format readers and ImageJ plugins
¢ Newly reborn Data Browser for 5D image visualization

— some combinations of import options do not work yet

3.1.23 2008 Feb 1
* Fixed bugs in Zeiss LSM, Metamorph STK, FV1000 OIB/OIF, Leica LEI, TIFF, Zeiss ZVI, ICS, Prairie, Open-
lab LIFF, Gatan, DICOM, QuickTime
* Fixed bug in OME-TIFF writer
* Major changes to MetadataStore API
* Added support for JPEG-compressed TIFF files
¢ Added basic support for Aperio SVS files
— JPEG2000 compression is still not supported
* Improved “crop on import” functionality
* Improvements to bfconvert and bfview
* Improved OME-XML population for several formats
¢ Added support for JPEG2000-compressed DICOM files
» EXIF data is now parsed from TIFF files

3.1.24 2007 Dec 28

* Fixed bugs in Leica LEI, Leica TCS, SDT, Leica LIF, Visitech, DICOM, Imaris 5.5 (HDF), and Slidebook
readers

* Better parsing of comments in TIFF files exported from ImageJ

* Fixed problem with exporting 48-bit RGB data

* Added logic to read multi-series datasets spread across multiple files

* Improved channel merging in ImageJ - requires ImageJ 1.391

* Support for hyperstacks and virtual stacks in ImageJ - requires ImageJ 1.391
* Added API for reading directly from a byte array or InputStream

* Metadata key/value pairs are now stored in ImageJ’s “Info” property

¢ Improved OMERO download plugin - it is now much faster
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* Added “open all series” option to ImageJ importer

* ND2 reader based on Nikon’s SDK now uses our own native bindings
* Fixed metadata saving bug in ImageJ

* Added sub-channel labels to ImageJ windows

* Major updates to 4D Data Browser

* Minor updates to automated testing suite

3.1.25 2007 Dec 1

* Updated OME plugin for ImageJ to support downloading from OMERO
* Fixed bug with floating point TIFFs

* Fixed bugs in Visitech, Zeiss LSM, Imaris 5.5 (HDF)

* Added alternate ND2 reader that uses Nikon’s native libraries

* Fixed calibration and series name settings in importer

* Added basic support for InCell 1000 datasets

3.1.26 2007 Nov 21
* Fixed bugs in ND2, Leica LIF, DICOM, Zeiss ZVI, Zeiss LSM, FV1000 OIB, FV1000 OIF, BMP, Evotec Flex,
BioRad PIC, Slidebook, TIFF
* Added new ImageJ plugins to slice stacks and do “smart” RGB merging
* Added “windowless” importer plugin
— uses import parameters from IJ_Prefs.txt, without prompting the user
 Improved stack slicing and colorizing logic in importer plugin
* Added support for DICOM files compressed with lossless JPEG
— requires native libraries
* Fixed bugs with signed pixel data
* Added support for Imaris 5.5 (HDF) files
* Added 4 channel merging to importer plugin
* Added API methods for reading subimages

e Major updates to the 4D Data Browser

3.1.27 2007 Oct 17

¢ Critical OME-TIFF bugfixes

* Fixed bugs in Leica LIF, Zeiss ZVI, TIFF, DICOM, and AVI readers
¢ Added support for JPEG-compressed ZVI images

* Added support for BigTIFF

* Added importer plugin option to open each plane in a new window
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¢ Added MS Video 1 codec for AVI

3.1.28 2007 Oct 1

* Added support for compressed DICOM images

¢ Added support for uncompressed LIM files

* Added support for Adobe Photoshop PSD files

* Fixed bugs in DICOM, OME-TIFF, Leica LIF, Zeiss ZVI, Visitech, PerkinElmer and Metamorph
* Improved indexed color support

* Addressed several efficiency issues

* Fixed how multiple series are handled in 4D data browser

* Added option to reorder stacks in importer plugin

* Added option to turn off autoscaling in importer plugin

¢ Additional metadata convenience methods

3.1.29 2007 Sept 11

* Major improvements to ND2 support; lossless compression now supported

* Support for indexed color images

* Added support for Simple-PCI .cxd files

¢ Command-line OME-XML validation

* Bugfixes in most readers, especially Zeiss ZVI, Metamorph, PerkinElmer and Leica LEI

¢ Initial version of Bio-Formats macro extensions for ImageJ]

3.1.30 2007 Aug 1

* Added support for latest version of Leica LIF
¢ Fixed several issues with Leica LIF, Zeiss ZVI1
* Better metadata mapping for Zeiss ZVI
Added OME-TIFF writer

Added MetadataRetrieve API for retrieving data from a MetadataStore

* Miscellaneous bugfixes

3.1.31 2007 July 16

* Fixed several issues with ImageJ plugins
 Better support for Improvision and Leica TCS TIFF files
* Minor improvements to Leica LIF, ICS, QuickTime and Zeiss ZVI readers

¢ Added searchable metadata window to ImageJ importer
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3.1.32 2007 July 2

* Fixed issues with ND2, Openlab LIFF and Slidebook
¢ Added support for Visitech XYS

* Added composite stack support to ImageJ importer

3.1.33 2007 June 18

* Fixed issues with ICS, ND2, MicroManager, Leica LEI, and FV1000 OIF
¢ Added support for large (> 2 GB) ND2 files

* Added support for new version of ND2

* Minor enhancements to ImageJ] importer

* Implemented more flexible logging

e Updated automated testing framework to use TestNG

* Added package for caching images produced by Bio-Formats

3.1.34 2007 June 6

* Fixed OME upload/download bugs
¢ Fixed issues with ND2, EPS, Leica LIF, and OIF
* Added support for Khoros XV

* Minor improvements to the importer

3.1.35 2007 May 24

¢ Better Slidebook support

* Added support for Quicktime RPZA

* Better Leica LIF metadata parsing

* Added support for BioRad PIC companion files
* Added support for bzip2-compressed files

* Improved ImagelJ plugins

* Native support for FITS and PGM

3.1.36 2007 May 2

¢ Added support for NRRD

* Added support for Evotec Flex (requires LuraWave Java SDK with license code)
* Added support for gzip-compressed files

* Added support for compressed QuickTime headers

* Fixed QuickTime Motion JPEG-B support
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* Fixed some memory issues (repeated small array allocations)

* Fixed issues reading large (> 2 GB) files

* Removed “ignore color table” logic, and replaced with Leica-specific solution
* Added status event reporting to readers

* Added API to toggle metadata collection

* Support for multiple dimensions rasterized into channels

¢ Deprecated reader and writer methods that accept the ‘id” parameter

* Deprecated [FormatWriter.save in favor of savelmage and saveBytes

* Moved dimension swapping and min/max calculation logic to delegates
 Separate GUI logic into isolated loci.formats.gui package

» Miscellaneous bugfixes and tweaks in most readers and writers

* Many other bugfixes and improvements

3.1.37 2007 Mar 16

* Fixed calibration bugs in importer plugin
* Enhanced metadata support for additional formats

¢ Fixed LSM bug

3.1.38 2007 Mar 7

* Added support for Micro-Manager file format

* Fixed several bugs — Leica LIF, Leica LEI, ICS, ND2, and others

* Enhanced metadata support for several formats

* Load series preview thumbnails in the background

 Better implementation of openBytes(String, int, byte[]) for most readers

» Expanded unit testing framework

3.1.39 2007 Feb 28

 Better series preview thumbnails
* Fixed bugs with multi-channel Leica LEI

* Fixed bugs with “ignore color tables” option in ImageJ plugin

3.1.40 2007 Feb 26

* Many bugfixes: Leica LEI ICS, FV1000 OIB, OME-XML and others
* Better metadata parsing for BioRad PIC files

* Enhanced API for calculating channel minimum and maximum values
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Expanded MetadataStore API to include more semantic types
Added thumbnails to series chooser in ImageJ plugin

Fixed plugins that upload and download from an OME server

3.1.41 2007 Feb 7

Added plugin for downloading images from OME server

Improved HTTP import functionality

Added metadata filtering — unreadable metadata is no longer shown
Better metadata table for multi-series datasets

Added support for calibration information in Gatan DM3

Eliminated need to install JAI Image I/O Tools to read ND2 files

Fixed ZVI bugs: metadata truncation, and other problems

Fixed bugs in Leica LIF: incorrect calibration, first series labeling

Fixed memory bug in Zeiss LSM

Many bugfixes: PerkinElmer, Deltavision, Leica LEI, LSM, ND2, and others
IFormatReader.close(boolean) method to close files temporarily
Replaced Compression utility class with extensible Compressor interface

Improved testing framework to use .bioformats configuration files

3.1.42 2007 Jan 5

Added support for Prairie TIFF

Fixed bugs in Zeiss LSM, OIB, OIF, and ND2
Improved API for writing files

Added feature to read files over HTTP

Fixed bugs in automated testing framework

Miscellaneous bugfixes

3.1.43 2006 Dec 22

Expanded ImagelJ plugin to optionally use Image5D or View5SD
Improved support for ND2 and JPEG-2000 files

Added automated testing framework

Fixed bugs in Zeiss ZVI reader

Miscellaneous bugfixes

3.1. Version history
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3.1.44 2006 Nov 30

* Added support for ND2/JPEG-2000

¢ Added support for MRC

* Added support for MNG

* Improved support for floating-point images

* Fixed problem with 2-channel Leica LIF data
* Minor tweaks and bugfixes in many readers

* Improved file stitching logic

* Allow Imagel] plugin to be called from a macro

3.1.45 2006 Nov 2

* Bugfixes and improvements for Leica LIF, Zeiss LSM, OIF and OIB
¢ Colorize channels when they are split into separate windows

* Fixed a bug with 4-channel datasets

3.1.46 2006 Oct 31

¢ Added support for Imaris 5 files
* Added support for RGB ICS images

3.1.47 2006 Oct 30

* Added support for tiled TIFFs
* Fixed bugs in ICS reader

* Fixed importer plugin deadlock on some systems

3.1.48 2006 Oct 27

* Multi-series support for Slidebook

¢ Added support for Alicona AL3D

* Fixed plane ordering issue with FV1000 OIB

* Enhanced dimension detection in FV1000 OIF

* Added preliminary support for reading NEF images
¢ Added option to ignore color tables

* Fixed ImageJ GUI problems

* Fixed spatial calibration problem in ImageJ

* Fixed some lingering bugs in Zeiss ZVI support

* Fixed bugs in OME-XML reader
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Tweaked ICS floating-point logic
Fixed memory leaks in all readers

Better file stitching logic

3.1.49 2006 Oct 6

Support for 3i SlideBook format (single series only for now)
Support for 16-bit RGB palette TIFF

Fixed bug preventing import of certain Metamorph STK files
Fixed some bugs in PerkinElmer UltraView support

Fixed some bugs in Leica LEI support

Fixed a bug in Zeiss ZVI support

Fixed bugs in Zeiss LSM support

Fixed a bug causing slow identification of Leica datasets
Fixed bugs in the channel merging logic

Fixed memory leak for OIB format

Better scaling of 48-bit RGB data to 24-bit RGB

Fixed duplicate channels bug in “open each channel in a separate window”
Fixed a bug preventing PICT import into ImageJ

Better integration with HandleExtraFileTypes

Better virtual stack support in Data Browser plugin

Fixed bug in native QuickTime random access

Keep aspect ratio for computed thumbnails

Much faster file stitching logic

3.1.50 2006 Sep 27

PerkinElmer: support for PE UltraView
Openlab LIFF: support for Openlab v5

Leica LEI: bugfixes, and support for multiple series

ZV1, OIB, IPW: more robust handling of these formats (eliminated custom OLE parsing logic in favor of Apache

POI)
OIB: better metadata parsing (but maybe still not perfect?)
LSM: fixed a bug preventing import of certain LSMs

Metamorph STK: fixed a bug resulting in duplicate image planes

User interface: use of system look & feel for file chooser dialog when available

Better notification when JAR libraries are missing

3.1. Version history
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3.1.51 2006 Sep 6

* Leica LIF: multiple distinct image series within a single file

Zeiss ZVTI: fixes and improvements contributed by Michel Boudinot

» Zeiss LSM: fixed bugs preventing the import of certain LSM files

TIFF: fixed a bug preventing import of TIFFs created with Bio-Rad software

3.1.52 2006 Mar 31

 First release
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CHAPTER
FOUR

USING BIO-FORMATS WITH IMAGEJ AND FIJI

The following sections explain the features of Bio-Formats and how to use it within /mageJ and Fiji:

4.1 ImagedJ

Imagel' is an image processing and analysis application written in Java, widely used in the life sciences fields, with
an extensible plugin infrastructure. You can use Bio-Formats as a plugin for ImageJ to read and write images in the
formats it supports.

4.1.1 Installation

Download loci_tools.jar> and drop it into your ImageJ/plugins folder. Next time you run ImageJ, a new LOCI
submenu with several plugins will appear in the Plugins menu, including the Bio-Formats Importer and Bio-Formats
Exporter.

4.1.2 Usage

The Bio-Formats Importer plugin can display image stacks in several ways:
¢ In a standard ImageJ window (including as a hyperstack)
» Using the LOCI Data Browser® plugin (included)
* With Joachim Walter’s Image5D* plugin (if installed)
« With Rainer Heintzmann’s View5D? plugin (if installed)

ImageJ v1.37 and later automatically (via HandleExtraFileTypes) calls the Bio-Formats logic, if installed, as needed
when a file is opened within ImageJ—e.g., when using File/Open instead of explicitly choosing “Bio-Formats Im-
porter” from the Plugins/LOCI menu.

For a more detailed description of each plugin, see the Bio-Formats page® of the Fiji wiki.

Uhttp://rsb.info.nih.gov/ij/
Zhttp://www.openmicroscopy.org/site/products/bio-formats/downloads/
3http://loci.wisc.edu/software/data-browser
“http://rsb.info.nih.gov/ij/plugins/image5d.html
Shttp://www.nanoimaging.de/ViewSD
Shttp://fiji.sc/wiki/index.php/Bio-Formats
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4.1.3 Upgrading

To upgrade, just overwrite the old loci_tools.jar with the latest one’. Step-by-step upgrade instructions for Windows
are available here.

You may want to download the latest version of Image] first, to take advantage of new features and bug-fixes.

As of the 4.0.0 release, you can also upgrade the Bio-Formats plugin directly from ImageJ. Select “Plug-
ins>LOCI>Update LOCI Plugins” from the ImageJ menu, then select which release you would like to use. You
will then need to restart ImageJ to complete the upgrade process.

4.1.4 Macros and plugins

Bio-Formats is fully scriptable in a macro, and callable from a plugin. To use in a macro, use the Macro Recorder
to record a call to the Bio-Formats Importer with the desired options. You can also perform more targeted metadata
queries using the Bio-Formats macro extensions.

Here are some example ImageJ macros and plugins that use Bio-Formats to get you started:

basicMetadata.txt® - A macro that uses the Bio-Formats macro extensions to print the chosen file’s basic dimensional
parameters to the Log.

planeTimings.txt” - A macro that uses the Bio-Formats macro extensions to print the chosen file’s plane timings to the
Log.

recursiveTiffConvert.txt'? - A macro for recursively converting files to TIFF using Bio-Formats.

bfOpenAsHyperstack.txt'! - This macro from Wayne Rasband opens a file as a hyperstack using only the Bio-Formats
macro extensions (without calling the Bio-Formats Importer plugin).

zvi2HyperStack.txt'? - This macro from Sebastien Huart reads in a ZVI file using Bio-Formats, synthesizes the LUT
using emission wavelength metadata, and displays the result as a hyperstack.

dvSplitTimePoints.txt'? - This macro from Sebastien Huart splits timepoints/channels on all DV files in a folder.
batchTiffConvert.txt'* - This macro converts all files in a directory to TIFF using the Bio-Formats macro extensions.
Read_Image'” - A simple plugin that demonstrates how to use Bio-Formats to read files into ImageJ.

Mass_Importer'® - A simple plugin that demonstrates how to open all image files in a directory using Bio-Formats,
grouping files with similar names to avoiding opening the same dataset more than once.

4.2 Fiji

Fiji'7 is an image processing package. It can be described as a distribution of ImageJ together with Java, Java 3D and
a lot of plugins organized into a coherent menu structure'®. Fiji compares to ImageJ as Ubuntu compares to Linux.

7http://www.openmicroscopy.org/site/products/bio-formats/downloads/
8https://github.com/openmicroscopy/bioformats/blob/develop/components/loci-plugins/utils/macros/basicMetadata. txt
9https://github.com/openmicroscopy/bioformats/blob/develop/components/loci-plugins/utils/macros/plane Timings. txt
10https://github.com/openmicroscopy/bioformats/blob/develop/components/loci-plugins/utils/macros/recursive TiffConvert.txt
Mhttps://github.com/openmicroscopy/bioformats/blob/develop/components/loci-plugins/utils/macros/bfOpen AsHyperstack. txt
2https://github.com/openmicroscopy/bioformats/blob/develop/components/loci-plugins/utils/macros/zvi2HyperStack. txt
Bhttps://github.com/openmicroscopy/bioformats/blob/develop/components/loci-plugins/utils/macros/dvSplit TimePoints.txt
4https://github.com/openmicroscopy/bioformats/blob/develop/components/loci-plugins/utils/macros/batch TiffConvert.txt
I3https://github.com/openmicroscopy/bioformats/blob/develop/components/loci-plugins/utils/Read_Image.java
16https://github.com/openmicroscopy/bioformats/blob/develop/components/loci-plugins/utils/Mass_Importer.java
Thttp://fiji.sc/

8http://fiji.sc/wiki/index.php/Plugins_Menu
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http://fiji.sc/
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Fiji works with Bio-Formats out of the box, because it comes bundled with the Bio-Formats ImageJ plugins.

4.2.1 Upgrading

Upgrading Bio-Formats within Fiji is as simple as invoking the “Update Fiji” command from the Help menu. By
default, Fiji even automatically checks for updates every time it is launched, so you will always be notified when new
versions of Bio-Formats (or any other bundled plugin) are available.

Updates in the Fiji updater are not always Bio-Formats’ most recent trunk build or stable release; they are versions that
are known to remain compatible with other plugins that depend upon Bio-Formats. You should use the Fiji updater
if you use other plugins that might use Bio-Formats. However, if you encounter a bug within Bio-Formats, use
Bio-Formats’ own updater to see if the latest trunk build fixes it.

4.3 Bio-Formats features in ImagedJ and Fiji

When you select Bio-Formats under the Plugin menu, you will see the following features:

* The Bio-Formats Importer is a plugin for loading images into ImageJ or Fiji. It can read over 100 proprietary
life sciences formats and standardizes their acquisition metadata into the common OME data model. Tt will also
extract and set basic metadata values such as spatial calibration'” if they are available in the file.

+ The Bio-Formats Exporter is a plugin for exporting data to disk. It can save to the open OME-TIFF? file
format, as well as several movie formats (e.g. QuickTime, AVI) and graphics formats (e.g. PNG, JPEG).

* The Bio-Formats Remote Importer is a plugin for importing data from a remote URL. It is likely to be less
robust than working with files on disk, so we recommend downloading your data to disk and using the regular
Bio-Formats Importer whenever possible.

¢ The Bio-Formats Windowless Importer is a version of the Bio-Formats Importer plugin that runs with the last
used settings to avoid any additional dialogs beyond the file chooser. If you always use the same import settings,
you may wish to use the windowless importer to save time (Learn more /ere).

¢ The Bio-Formats Macro Extensions plugin prints out the set of commands that can be used to create macro
extensions. The commands and the instructions for using them are printed to the ImageJ log window.

* The Stack Slicer plugin is a helper plugin used by the Bio-Formats Importer. It can also be used to split a stack
across channels, focal planes or time points.

e The LOCI Plugins Configuration dialog is a useful way to configure the behavior of each file format. The
Formats tab lists supported file formats and toggles each format on or off, which is useful if your file is detected
as the wrong format. It also toggles whether each format bypasses the importer options dialog through the
“Windowless” checkbox. You can also configure any specific option for each format. The Libraries tab provides
a list of available helper libraries used by Bio-Formats.

¢ The LOCI Plugins Shortcut Window opens a small window with a quick-launch button for each LOCI plugin.
Dragging and dropping files onto the shortcut window opens them quickly using the Bio-Formats Importer
plugin.

* The Update LOCI Plugins command will check for LOCI Plugins updates. We recommend you update to the
newest Trunk build as soon as you think you may have discovered a bug.

http://fiji.sc/wiki/index.php/Spatial Calibration
20http://www.openmicroscopy.org/site/support/ome-model/ome-tiff
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4.4 Installing Bio-Formats in ImagedJ

(Since FI1JI is essentially ImageJ with plugins like Bio-Formats already built in, people who install Fiji can skip this
section.)

Once you download?®! and install ImagelJ, you can install the Bio-Formats plugin by going to the Bio-Formats download
page®?. For most end-users, we recommend downloading the loci_tools.jar complete bundle. However, you must
decide which version of it you want to install. There are three primary versions of Bio-Formats: the trunk build, the
daily builds, and the Stable Release. Which version you should download depends on your needs:

* The trunk build is automatically updated every time any change is made to the source code on the main “trunk”
branch in Git, LOCI’s software version control system. This build has the latest bug fixes, but it is not well
tested and may have also introduced new bugs.

* The daily build is a compilation of that day’s changes that occurs daily around midnight. It is not any better
tested than the trunk build; but if you download it multiple times in a day, you can be sure you’ll get the same
version each time.

* The stable release is thoroughly tested and has documentation to match. The list of supported formats on the
Bio-Formats site corresponds to the most recent stable release. We do not add new formats to the list until a
release containing support for that format has been completed. The stable release is less likely to contain bugs.

The stable release is also more useful to programmers because they can link their software to a known, fixed version
of Bio-Formats. Bio-Formats’ behavior won’t be changing “out from under them” as they continue developing their
own programs.

We often recommend that most people simply use the trunk build for two reasons. First, trunk may contain bug-
fixes or new features you want anyway; secondly, you will have to reproduce any bug you encounter in Bio-Formats
against the latest trunk build before submitting a bug report. Rather than using the stable release until you find a bug
that requires you to upgrade and reproduce it, why not just use the trunk build to begin with?

Once you decide which version you need, go to the Bio-Formats download page? and save the appropriate
loci_tools.jar to the Plugins directory within ImageJ.

You may have to quit and restart ImageJ. Once you restart it, you will find Bio-Formats in the LOCI option under the
Plugins menu:

2l http://rsbweb.nih.gov/ij/download.html
22http://www.openmicroscopy.org/site/products/bio-formats/downloads/
Zhttp://www.openmicroscopy.org/site/products/bio-formats/downloads/
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Figure 4.1: Plugin Directory for ImageJ: Where in Imagel’s file structure you should place the file once you down-
loaded it.
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You are now ready to start using Bio-Formats.

4.5 Using Bio-Formats to load images into ImagedJ

This section will explain how to use Bio-Formats to import files into ImageJ and how to use the settings on the
Bio-Formats Import Options screen.

4.5.1 Opening files

There are three ways you can open a file using Bio-Formats:
1. Select the Bio-Formats Importer under the LOCI plugins menu.
2. Drag and drop it onto the LOCI Plugins Shortcut window.
3. Use the Open command in the File menu.

Unless you used the LOCI Plugins Configuration dialog to open the file type windowlessly, you know you used Bio-
Formats to open a file when you see a screen like this:
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If you used the File > Open command and did not see the Bio-Formats Import Options screen, ImageJ/Fiji probably
used another plugin instead of Bio-Formats to open the file. If this happens and you want to open a file using Bio-
Formats, use one of the other two methods instead.

4.5.2 Opening files windowlessly

When you open a file with Bio-Formats, the Import Options Screen automatically recalls the settings you last used
to open a file with that specific format (e.g. JPG, TIF, LSM, etc.). If you always choose the same options whenever
you open files in a specific file format, you can save yourself time by bypassing the Bio-Formats Import Options
screen. You can accomplish this two ways:

1. You can select the Bio-Formats Windowless Importer, located in the LOCI menu under Imagel’s Plugin
menu. When you select this option, Bio-Formats will import the file using the same settings you used the last
time you imported a file with the same format.

2. If you invariably use the same settings when you open files in a specific format, you can always bypass the Import
Options Screen by changing the settings in the LOCI Plugins Configuration option, which is also located in the
LOCI menu under ImageJ’s Plugin menu.

Once you select this option, select the file format you are interested in from the list on the left side of the screen.
Check both the Enabled and Windowless boxes. Once you do this, whenever you open a file using the Bio-Formats
Windowless Importer,the Bio-Formats Importer, or the drag-and-drop method described in the previous section,
the file will always open the same way using the last setting used.

Please note that if you want to change any of the import settings once you enable this windowless option, you will
have to go back to the LOCI Plugins Configuration screen, unselect the windowless option, open a file using the
regular Bio-Formats Importer, select your settings, and re-select the windowless option.

4.5.3 Group files with similar names

One of the most important features of Bio-Formats is to combine multiple files from a data set into one coherent,
multi-dimensional image.
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To demonstrate how to use the Group files with similar names feature, you can use the dub?* data set available under
LOCI’s Sample Data® page. You will notice that it is a large dataset: each of the 85 files shows the specimen at 33
optical sections along the z-plane at a specific time.

If you open just one file in ImagelJ/Fiji using the Bio-Formats Importer, you will get an image incorporating three
dimensions (X, y, z). However, if you select Group files with similar names from the Bio-Formats Import Options
screen, you will be able to create a 4-D image (X, y, z, and t) incorporating the 85 files.

After clicking OK, you will see a screen like this:
Bio-Formats Flle Stitching
Axis 1 number of images .35

Axis 1 axis first image 1

Axis 1 axis increment 1

File name contains:

Pattern: . fUsers/lasonPalmer/Deskiop/Sample Data/dub/dub<01-85=.pic

" Cancel [ OK

This screen allows you to select which files within the 85-file cluster to use to create that 4-D image. Some information
will be pre-populated in the fields. Unless you want to change the settings in that field, there is no need to change or
delete it. If you click OK at this point, you will load all 85 files.

However, you can specify which files you want to open by adjusting the “axis information”, the file “name contains,”
or the “pattern” sections. Even though there are three options, you only need to need to make changes to one of them.
Since Bio-Format’s precedence for processing data is from top to bottom, only the uppermost section that you made
changes to will be used. If you change multiple boxes, any information you enter into lower boxes will be ignored.

To return to the example involving the dub data set, suppose you want to open the first image and only every fifth
image afterwards (i.e. dubO1, dub06, dubl1 . . . dub81). This would give you 17 images. There are different ways to
accomplish this:

You can use the Axis Settings only when your files are numbered in sequential order and you want to open only a
subset of the files that have similar names. Since the dub data set is numbered sequentially, you can use this feature.

Axis 1 number of images refers to the total number of images you want to open. Since you want to view 17 images,
enter 17. Axis 1 axis first image specifies which image in the set you want to be the first. Since you want to start with
dub0l1, enter 1 in that box. You also want to view only every fifth image, so enter 5 in the Axis 1 axis increment box.

The File name contains box should be used if all of the files that you want to open have common text. This is
especially useful when the files are not numbered. For example, if you have “Image_Red.tif”, “Image_Green.tif”,
and “Image_Blue.tif” you could enter “Image_" in the box to group them all.

To continue the example involving the dub data set, you cannot use the file name contains box to open every fifth
image. However, if you only wanted to open dub10 thorough dub19, you could enter “dub1” in the file name contains
box.

The pattern box can be used to do either of the options listed above or much more. This box can accept a single file
name like “dubO1.pic.” It can also contain a pattern that use “<” and “>” to specify what numbers or text the file names
contain.

There are three basic forms to the “< >” blocks:

24 http://www.loci.wisc.edu/sample-data/dub
Zhttp://www.loci.wisc.edu/software/sample-data
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e Text enumeration - “Image_<Red,Green,Blue>.tif” is the pattern for Image_Red.tif, Image_Green.tif, Im-
age_Blue.tif. (Note that the order you in which you enter the file names is the order in which they will be
loaded.)

¢ Number range - “dub<1-85>.pic” is the pattern for “dubl.pic”, “dub2.pic”, “dub3.pic” . . . “dub85.pic”.

* Number range with step - “dub<1-85:5>.pic” is the pattern for “dubl.pic”, “dub6.pic”, “dubl1.pic”, “dubl1.pic”
... “dub85.pic”.

It can also accept a Java regular expression®.

4.5.4 Autoscale

Autoscale helps increase the brightness and contrast of an image by adjusting the range of light intensity within an
image to match the range of possible display values. Note that Autoscale does not change your data. It just changes
how it is displayed.

Each pixel in an image has a numerical value ascribed to it to describe its intensity.  The bit depth—the number of
possible values— depends on the number of bits used in the image. Eight bits, for example, gives 256 values to express
intensity where O is completely black, 255 is completely white, and 1 through 254 display increasingly lighter shades
of grey.

ImagelJ can collect the intensity information about each pixel from an image or stack and create a histogram. (You
can see it by selecting Histogram under the Analyze menu.) Here is the histogram of a one particular image:

Histogram of 15test.ome

255
Count: 393216 Min: O
Mean: 19.489 Max: 125
StdDev: 10.967 Mode: 20 (15344)
- %  Value: 202

( List ) ( Copy ) ( Log count: 0

Notice that the histogram heavily skews right. Even though there are 256 possible values, only 0 thorough 125 are
being used.

26http://download.oracle.com/javase/1.5.0/docs/api/java/util/regex/Pattern.html
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Autoscale adjusts the image so the smallest and largest number in that image or stack’s histogram become the darkest
and brightest settings. For this image, pixels with the intensity of 125 will be displayed in pure white. The other
values will be adjusted too to help show contrast between values that were too insignificant to see before.

Here is one image Bio-Formats imported with and without using Autoscale:

oA O 5 1 X 00 retorey (TEEaS 10T ¥-f. T0K

TEA O 5 | 200 rediiaeni (TEET1FL Bl BRAN

Autoscale readjusts the image based on the highest value in the entire data set. This means if the highest value in your
dataset is close to maximum display value, Autoscale’s adjusting may be undetectable to the eye.

Imagel/Fiji also has its own tools for adjusting the image, which are available by selecting Brightness/Contrast, which
is under the Adjust option in the Image menu.
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4.6 Managing memory in ImagedJ/Fiji using Bio-Formats

When dealing with a large stack of images, you may receive a warning like this:

Bio-Formats Memory Usage

Warning: It will require approximately 1051 MB to open this dataset.
However, only 994 MB is currently available. You may receive an error
message about insufficient memory. Are you sure you want to proceed?

P L y
1 1 i
[ Cancel ) [ OK

Ny, -

This means the allotted memory is less than what Bio-Formats needs to load all the images. If you have a very large
data set, you may have to:

* View your stack with Data Browser
* Crop the view area

* Open only a subset of images
 Use Virtual Stack

¢ Increase ImagelJ/Fiji’s memory.

If your files contain JPEG or JPEG-2000 images, you may see this memory warning even if your file size is smaller
than the amount of allocated memory. This is because compressed images like JPEG need to be decompressed into
memory before being displayed and require more memory than their file size suggests. If you are having this issue,
try utilizing one of the memory management tools below.

4.6.1 View your stack with Data Browser
Data Browser is another part of Bio-Formats that enables users to view large 3, 4, or 5-D datasets by caching a subset
of all the images available. This enables users to view a stack that is bigger than the computer’s memory.

You can select Data Browser as an option for View stack with, the leftmost, uppermost option in the Bio-Formats
Import Options screen.
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Note that when you use Data Browser, other features like cropping and specifying range are not available. You can,
however, adjust the size of the image cache in the Data Browser after you open the files. You can read more about it
on LOCI’s Data Browser page”’.

4.6.2 Cropping the view area
Crop on Import is useful if your images are very large and you are only interested in one specific section of the stack

you are importing. If you select this feature, you will see a screen where you can enter the height and width (in pixels)
of the part of image you want to see. Note that these measurements are from the top left corner of the image.

4.6.3 Opening only a subset of images
The Specify Range for Each Series option is useful for viewing a portion of a data set where all the plane images are

encapsulated into one file (e.g. the Zeiss LSM format). If your file has a large quantity of images, you can specify
which channels, Z-planes, and times you want to load.

4.6.4 Use Virtual Stack

Virtual Stack conserves memory by not loading specific images until necessary. Note that unlike Data Browser,
Virtual Stack does not contain a buffer and may produce choppy animations.

4.6.5 Increasing ImagedJ/Fiji’s memory

Finally, you can also increase the amount of the computer memory devoted to Imagel/Fiji by selecting Memory &
Threads under the Edit menu.

2Thttp://www.loci.wisc.edu/software/data-browser
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Generally, allocating more than 75% of the computer’s total memory will cause ImageJ/Fiji to become slow and
unstable.

Please note that unlike the other three features, ImagelJ/Fiji itself provides this feature and not Bio-Formats. You can

find out more about this feature by looking at Image]’s documentation?®.

4.7 Upgrading the Bio-Formats importer for Imaged to the latest trunk
build

1) Download the latest trunk build of loci_tools.jar from Bio-Formats downloads®

Z8http://rsbweb.nih.gov/ij/docs/menus/edit.html#options
http://www.openmicroscopy.org/site/products/bio-formats/downloads/
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2) Internet Explorer will ask you where it should save loci_tools.jar. Select ‘Desktop’.
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3. Start Imagel.
4. Select “Plugins > Utilities > ImageJ Properties...”

4.7. Upgrading the Bio-Formats importer for ImageJ to the latest trunk build

38



Bio-Formats Documentation, Release 4.4.8-DEV

List EForiruta

Tregais

Esrichmark

Ruzet

Mordor Memoey

Sewih

Capture Stregn  Chl+ERates
- e s

Find Commands i+l
el g A

|

Heapant b
Fie Bt Ford

L s DG Tadsn
W iWAnOoes. o
LI YISER Faiae
L raaEst Talse

Menus getMacrosPah’ CFROGRA- Imagefmacms
Press geiHomely COPROCRA- imagel
Prefs getTheeads 1 (1 tore)

Prets npeni DOPercens e

Frefs bisckEathnoara Fais
Prefs. s ieChomsr fahe

Prefa seightedColor Talse

Prefs DiachCaenay fase

Prafy portauiniiesmuie fase

Prefs plirbatihersioe fuse

Prefs requisCont ke e

Prify SimerTngLUE P

Prefs antisizsed Tooks Faie

Prets ussimertinglut fats

_"- EREFT ] S @ L0 - B B | -i"l'_! T

6) Leaving ImagelJ and the Properties window open, click the Start button, then My Computer.
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7) Type the path from step 5 into the address bar in the My Computer window, then hit the Enter key. The path
should look something like this C: \PROGRA~1\ImageJ\plugins\
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10. Close Imagel.
11. Open Imagel.

12) Imagel now recognizes the latest trunk build of the Bio-Formats importer.
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CHAPTER
FIVE

OMERO

OMERO.importer uses Bio-Formats to read image pixels and propagate metadata into the OMERO.server system.
Please refer to the OMERO documentation' for further information.

Uhttp://www.openmicroscopy.org/site/support/omero4/
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CHAPTER
SIX

IMAGE SERVER APPLICATIONS

6.1 BISQUE

The BISQUE' (Bio-Image Semantic Query User Environment) Database, developed at the Center for Bio-Image
Informatics at UCSB, was developed for the exchange and exploration of biological images. The Bisque system
supports several areas useful for imaging researchers from image capture to image analysis and querying. The bisque
system is centered around a database of images and metadata. Search and comparison of datasets by image data and
content is supported. Novel semantic analyses are integrated into the system allowing high level semantic queries and
comparison of image content.

Bisque integrates with Bio-Formats by calling the showinf command line tool.

6.2 OME Server

OME? is a set of software that interacts with a database to manage images, image metadata, image analysis and
analysis results. The OME system is capable of leveraging Bio-Formats to import files.

Please note - the OME server is no longer maintained and has now been superseded by the OMERO server”.

6.2.1 Installation

For OME Perl v2.6.1* and later, the command line installer automatically downloads the latest loci_tools.jar and
places it in the proper location. This location is configurable, but is /OME/java/loci_tools.jar by default.

For a list of what was recognized for a particular import into the OME server, go to the Image details page in the web
interface, and click the “Image import” link in the upper right hand box.

Bio-Formats is capable of parsing original metadata for supported formats, and standardizes what it can into the OME
data model. For the rest, it expresses the metadata in OME terms as key/value pairs using an OriginalMetadata custom
semantic type. However, this latter method of metadata representation is of limited utility, as it is not a full conversion
into the OME data model.

Bio-Formats is enabled in OME v2.6.1 for all formats except:
¢ OME-TIFF
* Metamorph HTD

Uhttp://www.bioimage.ucsb.edu/bisque
Zhttp://openmicroscopy.org/site/support/legacy/ome-server
3http://www.openmicroscopy.org/site/support/omero4/
“http://cvs.openmicroscopy.org.uk/
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¢ Deltavision DV
* Metamorph STK
¢ Bio-Rad PIC

e Zeiss LSM

e TIFF

« BMP

* DICOM

* OME-XML

The above formats have their own Perl importers that override Bio-Formats, meaning that Bio-Formats is not used to
process them by default. However, you can override this behavior (except for Metamorph HTD, which Bio-Formats
does not support) by editing an OME database configuration value:

o)

% psgl ome
To see the current file format reader list:

ome=# select value from configuration where name=’import_formats’;

value
["OME: : ImportEngine: :OMETIFFreader’,’OME: : ImportEngine: :MetamorphHTDFormat’,
"OME: : ImportEngine: :DVreader’,’OME: : ImportEngine: : STKreader’,
"OME: :ImportEngine: :BioradReader’,’OME: : ImportEngine: :LSMreader’,
"OME: : ImportEngine: :TIFFreader’,’OME: : ImportEngine: :BMPreader’,
"OME: : ImportEngine: :DICOMreader’,’OME: : ImportEngine: :XMLreader’,
"OME: :ImportEngine: :BioFormats’ ]

(1 row)

To remove extraneous readers from the list:

ome=# update configuration set value=’ [\'OME::ImportEngine::MetamorphHTDFormat\’,
\’OME: : ImportEngine: :XMLreader\’,\’OME: : ImportEngine: :BioFormats\’]’ where
name='import_formats’;
UPDATE 1
ome=# select value from configuration where name=’import_formats’;

value
["OME: : ImportEngine: :MetamorphHTDFormat’,’OME: : ImportEngine: :XMLreader’,
"OME: :ImportEngine: :BioFormats’ ]

(1 row)

To reset things back to how they were:

ome=# update configuration set value=’ [\’'OME::ImportEngine::OMETIFFreader\’,
\’OME: : ImportEngine: :MetamorphHTDFormat\’, \’OME: : ImportEngine: :DVreader\’,
\’OME: : ImportEngine: :STKreader\’,\’OME: : ImportEngine: :BioradReader\’,

\’OME: : ImportEngine: :LSMreader\’,\’OME: : ImportEngine: : TIFFreader\’,

\’OME: : ImportEngine: :BMPreader\’,\’OME: : ImportEngine: :DICOMreader\’,

\’OME: : ImportEngine: :XMLreader\’,\’OME: : ImportEngine: :BioFormats\’]’ where
name=’'import_formats’;

Lastly, please note that Li-Cor L2D files cannot be imported into an OME server (see this Trac ticket® for details).
Since the OME perl server has been discontinued, we have no plans to fix this limitation.

Shttp://dev.loci.wisc.edu/trac/software/ticket/266
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6.2.2 Upgrading

You can upgrade your OME server installation to take advantage of a new Bio-Formats release® by overwriting the old
loci_tools.jar with the new one.

6.2.3 Source Code

The source code for the Bio-Formats integration with OME server spans three languages, using piped system calls in
both directions to communicate, with imported pixels written to OMEIS pixels files. The relevant source files are:

+ OmeisImporter.java’ — omebf Java command line tool
* BioFormats.pm® — Perl module for OME Bio-Formats importer

* omeis.c” — OMEIS C functions for Bio-Formats (search for “bioformats” case insensitively to find relevant
sections)

Shttp://www.openmicroscopy.org/site/products/bio-formats/downloads/
7https://github.com/openmicroscopy/bioformats/blob/develop/components/scifio/src/loci/formats/ome/OmeisImporter.java
8http://svn.openmicroscopy.org.uk/svn/ome/trunk/src/perl2/OME/ImportEngine/BioFormats.pm
9http://svn.openmicroscopy.org.uk/svn/ome/trunk/src/C/omeis/omeis.c
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CHAPTER
SEVEN

LIBRARIES AND SCRIPTING APPLICATIONS

7.1 Command line tools

There are several scripts for using Bio-Formats on the command line.

7.1.1 Installation

Download bftools.zip', unzip it into a new folder, then download loci_tools.jar? and place it in the same folder.
The zip file contains both Unix scripts and Windows batch files. Currently available tools include:

showinf Prints information about a given image file to the console, and displays the image itself in the Bio-Formats
image viewer.

bfview Launches the Bio-Formats image viewer, displaying the given file (if any).
ijview Displays the given image file in ImagelJ using the Bio-Formats Importer plugin (requires ij.jar).

bfconvert Converts an image file from one format to another. Bio-Formats must support writing to the output file
(determined by extension; see the Supported Formats).

formatlist Displays a list of supported file formats in HTML, plaintext or XML.

xmlindent A simple XML prettifier similar to xml11lint -—-format but more robust in that it attempts to produce
output regardless of syntax errors in the XML.

xmlvalid A command-line XML validation tool, useful for checking an OME-XML document for compliance with
the OME-XML schema.

omeul A command-line client-side import tool for OME.

tiffcomment Dumps the comment from the given TIFF file’s first IFD entry; useful for examining the OME-XML
block in an OME-TIFF file.

All scripts require loci_tools.jar in the same directory as the command line tools.

7.1.2 Tutorial

There is a Bio-Formats command line tools tutorial® on the FARSIGHT web site.

Uhttp://www.openmicroscopy.org/site/products/bio-formats/downloads/
Zhttp://www.openmicroscopy.org/site/products/bio-formats/downloads/
3http://www.farsight-toolkit.org/wiki/FARSIGHT _Tutorials/Bio-Formats
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7.1.3 Using the tools directly from source

If you have checked out the source from the Git repository you already have the command line tools in the tools
directory. You can configure the scripts to use your source tree instead of loci_tools.jar in the same directory by
following these steps:

1. Point your CLASSPATH to the checked-out directory and the JAR files in the jar folder.

* E.g. on Windows with Java 1.6 or later, if you have checked out the source at C: \code\loci, set your
CLASSPATH environment variable to the value C:\code\loci\jar\*;C:\code\loci. You can
access the environment variable configuration area by right-clicking on My Computer, choosing Properties,
Advanced tab, Environment Variables button.

2. Compile the source with ant compile.

3. Set the LOCI_DEVEL environment variable to any value (the variable just needs to be defined).

7.2 FARSIGHT

FARSIGHT* is a collection of modules for image analysis created by LOCI’s collaborators at the Rensselaer Poly-
technic Institute®. These open-source modules are built on the /7K libraries and thus can take advantage of LOCI’s
BF-ITK plugin for processing normally unsupported image types.

The principal FARSIGHT module that benefits from the BF-ITK plugin is the Nucleus Editor®. The Nucleus Editor
has been shown to work well with BF-ITK on Mac and Linux operating systems, but unfortunately not on Windows.
Note that both FARSIGHT and BF-ITK can work independently on Windows.

Warning: you will find links for downloading pre-built versions of both FARSIGHT and the BF-ITK plugin below.
However, currently these have not been shown to work together on any operating system.

In summary, to use the Bio-Formats plugin with a FARSIGHT module, you will need to build the FARSIGHT module
from source and should be using a Linux or Mac-based computer.

To use FARSIGHT and BF-ITK together, there are several tutorials that will guide you through the process of down-
loading and building the source code for these projects:

e This tutorial’” will guide you through building FARSIGHT exclusively. Once FARSIGHT is built, you can
follow the instructions on the /7K page to download and install a pre-built version of BFTIK.

* The tutorials on this page® provide platform-specific guides for building both FARSIGHT and the BF-ITK plugin
from source.

If you are just interested in using FARSIGHT without going through the steps of compiling from source, you can visit
this downloads page” and download stable releases of FARSIGHT.

7.3 i3dcore

i3dcore'”, also known as the CBIA 3D image representation library, is a 3D image processing library developed at

“http://www.farsight-toolkit.org/wiki/Main_Page

Shttp://www.rpi.edu/

Ohttp://www.farsight-toolkit.org/wiki/NucleusEditor
Thttp://www.farsight-toolkit.org/wiki/FARSIGHT _HowToBuild
8http://www.farsight-toolkit.org/wiki/FARSIGHT_Tutorials/Building_Software/Bio-Formats
http://www.farsight-toolkit.org/wiki/Special:FarsightDownloads
1Ohttp://cbia.ﬁ.muni.cz/user_dirs/i?a dlib_doc/i3dcore/index.html
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the Centre for Biomedical Image Analysis''. Together with i3dalgo'? and i4dcore'®, i3dcore forms a continuously
developed templated cross-platform C++ suite of libraries for multidimensional image processing and analysis.

i3dcore is capable of reading images with Bio-Formats using Java for C++'* (javadcpp).
See Also
Download i3dcore'?

CBIA Software Development'®

7.4 ImgLib

ImgLib2!7 (see also the ImgLib Fiji page'®) is a multidimensional image processing library. It provides a general
mechanism for writing image analysis algorithms, without writing case logic for bit depth!”, or worrying about the
source of the pixel data (arrays in memory, files on disk, etc.).

ImgLib provides an ImgOpener?? utility class for reading data using Bio-Formats.

7.5 ITK

The Insight Toolkit>! (ITK) is an open-source, cross-platform system that provides developers with an extensive suite
of software tools for image analysis. Developed through extreme programming methodologies, ITK employs leading-
edge algorithms for registering and segmenting multidimensional data.

ITK provides an ImagelO plug-in structure that works via discovery through a dependency injection scheme. This
allows a program built on ITK to load plug-ins for reading and writing different image types without actually linking
to the ImagelO libraries required for those types. Such encapsulation automatically grants two major boons: firstly,
programs can be easily extended just by virtue of using ITK (developers do not have to specifically accommodate or
anticipate what plug-ins may be used). Secondly, the architecture provides a distribution method for open source soft-
ware, like Bio-Formats, which have licenses that might otherwise exclude them from being used with other software
suites.

The Bio-Formats ITK plug-in provides an ImagelO plug-in for ITK that uses Bio-Formats®® to read and write sup-
ported life sciences file formats. This plug-in allows any program built on ITK to read any of the image types supported
by Bio-Formats.

7.5.1 Prerequisites

If you have not done so already, download®® and build ITK. Note that BF-ITK requires ITK 3.20.0 or newer. It should
also work with the latest ITK source from git**. BF-ITK also requires ITK to be built with the following flags set:

http://cbia.fi.muni.cz/software-development.html
12http://cbia.ﬁ.muni.cz/user_dirs/i3cllib_d0c/i3dal go/index.html
13http://cbia.ﬁ.muni.cz/user_dirs/of_doc/libi4d.htrnl
http://javadcpp.kapott.org/

15http://cbia.ﬁ.muni.cz/user_dirs/i3 dlib_doc/i3dcore/index.html#download
16http://cbia.fi.muni.cz/software-development.html

Thttp:/fimglib2.net/

8http://fiji.sc/wiki/index.php/Imglib
http://en.wikipedia.org/wiki/Color_depth
2https://github.com/imagej/imglib/blob/master/io/src/main/java/net/imglib2/io/lmgOpener.java
2lhttp:/fitk.org/

22http://farsight-toolkit.org/wiki/Bio-Formats
Zhttp://itk.org/ITK/resources/software.html

2 http://www.itk.org/Wiki/ITK/Git
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* ITK_USE_REVIEW = ON
* BUILD_SHARED_LIBS = ON

You will also need Git®, Ant2® and CMake?’ for the installation tutorial.

7.5.2 Installation

1. Clone the Bio-Formats source code:

git clone git://github.com/openmicroscopy/bioformats.git

2. Compile the Bio-Formats tools bundle:

cd bioformats
ant tools

3. Configure your BF-ITK build:

mkdir ../bf-itk-build && cd ../bf-itk-build
ccmake ../bioformats/components/native/bf-itk-pipe

If you prefer, you can use cmake-gui rather than ccmake to configure the project. If you receive a configuration
error stating that the location of ITK cannot be found, then set ITK_DIR to your binary build of ITK.

4. Compile BF-ITK:
On Linux and OSX, simply run make, or on Windows start BioFormatsImageIO.sln.

This will open the solution in Visual Studio. Select Debug or Release from the drop-down menu, as appro-
priate. Press F'7 to compile, or select Build Solution from the Build menu.

5. Package BF-ITK build (optional):

By default, all necessary libraries including 1oci_tools. jar will be copied to dist/bf-itk inside the
BF-ITK build folder.

If desired, everything can be packaged into a single archive by running:

On Linux and OSX, make package or on Windows, click on the PACKAGE target in the Visual Studio
interface. Then choose Build PACKAGE from the Build menu.

7.5.3 Usage

To use BF-ITK, you must set your ITK_AUTOLOAD_PATH to point to the folder containing the BF-ITK binaries
(including the BioFormatsIO and BioFormatsIOPlugin shared libraries, and the loci_tools.jar Java library). For
example:

export ITK_AUTOLOAD_PATH=~/bf-itk-build/dist/bf-itk

Once this variable is set, ITK’s ImagelO routines will automatically use Bio-Formats as needed to read and write
supported file formats.

If you build ITK with examples, you can test using various programs:

cd ~/itk-build/bin
./ImageReadWrite ~/data/inputFile.ics ~/data/outputFile.mha

ZShttp://git-scm.com/
26http://ant.apache.org/
2Thttp://www.cmake.org/
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7.6 Qu for MATLAB

Qu for MATLAB?® is a MATLAB toolbox for the visualization and analysis of N-dimensional datasets targeted to the
field of biomedical imaging, developed by Aaron Ponti.

* Uses Bio-Formats to read files

* Open source software available under the Mozilla Public License
See Also
Qu for MATLAB download page®

7.7 Subimager

Subimager®’, the SUBprocess IMAGE servER, is an HTTP server that uses Bio-Formats as a back-end to serve .TIF
images. Subimager is designed to be run as a subprocess of CellProfiler to provide CellProfiler with the capability to
read and write a variety of image formats. It can be used as a stand-alone image server. It was developed by the Broad
Institute®! to facilitate integration with their CellProfiler’> image analysis application.

Z8http://www.scs2.net/home/index.php?option=com_content&view=article&id=46%3 Aqu-for-matlab&catid=34%3Aqu&Itemid=55
Dhttp://www.scs2.net/home/index php?option=com_content&view=article&id=46%3 Aqu-for-matlab&catid=34%3 Aqué&Itemid=55&limitstart=3
30nttps://github.com/CellProfiler/subimager

31http://www.broadinstitute.org/

32http://www.cellprofiler.org/
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CHAPTER
EIGHT

NUMERICAL DATA PROCESSING APPLICATIONS

8.1 IDL

IDL' (Interactive Data Language) is a popular data visualization and analysis platform used for interactive processing
of large amounts of data including images.

IDL possesses the ability to interact with Java applications via its IDL-Java bridge. Karsten Rodenacker has written a
script that uses Bio-Formats to read in image files to IDL.

8.1.1 Installation

Download the i j_read_bio_formats.pro2 script from Karsten Rodenacker’s IDL goodies (7)® web site. See the com-
ments at the top of the script for installation instructions and caveats.

8.1.2 Upgrading

To use a newer version of Bio-Formats, overwrite the requisite JAR files with the newer version®* and restart IDL.

8.2 KNIME

KNIME’ (Konstanz Information Miner) is a user-friendly and comprehensive open-source data integration, process-
ing, analysis, and exploration platform. KNIME supports image import using Bio-Formats using the KNIME Image
Processing® (a.k.a. KNIP) plugin.

8.3 MATLAB

MATLAB” is a high-level language and interactive environment that facilitates rapid development of algorithms for
performing computationally intensive tasks.

Thttp://www.exelisvis.com/ProductsServices/IDL.aspx
Zhttp://www.helmholtz-muenchen.de/ibb/homepage/karsten.rodenacker/IDL/_pro/ij_read_bio_formats.pro
3http://www.helmholtz-muenchen.de/ibb/homepage/karsten.rodenacker/IDL/index.php
“http://www.openmicroscopy.org/site/products/bio-formats/downloads/

Shttp://knime.org/

Shttp://tech.knime.org/community/image-processing

7http://www.mathworks.com/products/matlab/
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http://tech.knime.org/community/image-processing
http://www.mathworks.com/products/matlab/
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Calling Bio-Formats from MATLAB is fairly straightforward, since MATLAB has built-in interoperability with Java.
We have created a simple script for reading image files: bfopen.m®.

We are not MATLAB experts—any comments on improving the script are welcome.

8.3.1 Performance

In our tests (MATLAB R14 vs. java 1.6.0_20), the script executes at approximately half the speed of our showinf
command line tool, due to overhead from copying arrays.

8.3.2 Installation

To use the script, download bfopen.m” and loci_tools.jar' and place them in your MATLAB work directory.

8.3.3 Upgrading

To use a newer version of Bio-Formats, overwrite loci_tools.jar with the newer version'! and restart MATLAB.

8.3.4 More information

For further instructions on working with Bio-Formats from MATLAB, see the Bio-Formats MATLAB Guide.

8.4 VisAD

The VisAD'? visualization toolkit is a Java component library for interactive and collaborative visualization and anal-
ysis of numerical data. VisAD uses Bio-Formats to read many image formats, notably TIFF.

8.4.1 Installation

The visad.jar file has Bio-Formats bundled inside, so no further installation is necessary.

8.4.2 Upgrading

It should be possible to use a newer version of Bio-Formats by putting the latest loci_tools.jar'? or bio-formats jar'*
before visad.jar in the class path. Alternately, you can create a “VisAD Lite” using the make lite command
from VisAD source, and use the resultant visad-lite.jar, which is a stripped down version of VisAD without sample
applications or Bio-Formats bundled in.

8https://github.com/openmicroscopy/bioformats/blob/develop/components/bio-formats/matlab/bfopen.m
9https://github.com/openmicroscopy/bioformats/blob/develop/components/bio-formats/matlab/bfopen.m
10http://www.openmicroscopy.org/site/products/bio-formats/downloads/
http://www.openmicroscopy.org/site/products/bio-formats/downloads/
Zhttp://www.ssec.wisc.edu/%7Ebillh/visad.html
Bhttp://www.openmicroscopy.org/site/products/bio-formats/downloads/
4http://www.openmicroscopy.org/site/products/bio-formats/downloads/
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CHAPTER
NINE

VISUALIZATION AND ANALYSIS APPLICATIONS

9.1 Bitplane Imaris

Imaris' is Bitplane’s core scientific software module that delivers all the necessary functionality for data visualization,
analysis, segmentation and interpretation of 3D and 4D microscopy datasets. Combining speed, precision and ease-
of-use, Imaris provides a complete set of features for working with three- and four-dimensional multi-channel images
of any size, from a few megabytes to multiple gigabytes in size.

As of version 7.22, Imaris integrates with Fiji, which includes Bio-Formats. See this page® for a detailed list of Imaris’
features.

9.2 CellProfiler

CellProfiler*—developed by the Broad Institute’ ‘s Imaging Platform®—is free open-source software designed to en-
able biologists without training in computer vision or programming to quantitatively measure phenotypes from thou-
sands of images automatically. CellProfiler uses Bio-Formats to read images from disk, as well as write movies.

9.2.1 Installation

The CellProfiler distribution comes with Bio-Formats included, so no further installation is necessary.

9.2.2 Upgrading
It should be possible to use a newer version of Bio-Formats by replacing the bundled loci_tools.jar with a newer
version.

 For example, on Mac OS X, Ctrl+click the CellProfiler icon, choose Show Package Contents, and replace the
following files:

— Contents/Resources/bioformats/loci_tools.jar

— Contents/Resources/lib/python2.5/bioformats/loci_tools.jar

Uhttp://www.bitplane.com/

Zhttp://www.bitplane.com/go/releasenotes ?product=Imaris&version=7.2&patch=0
3http://www.bitplane.com/index.cfm?objectid=0D8067BB-B4BA-B42D-00D7454EF75DB9AS
“http://www.cellprofiler.org/

Shttp://www.broadinstitute.org/
Shttp://www.broadinstitute.org/science/platforms/imaging/imaging-platform
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See also:

CellProfiler web site’

9.3 Comstat2

Comstat2 is a Java-based computer program for the analysis and treatment of biofilm images in 3D. It is the Master’s
project of Martin Vorregaard®.

Comstat2 uses the Bio-Formats Importer plugin for ImageJ to read files in TIFF and Leica LIF formats.
See also:

Comstat2 - a modern 3D image analysis environment for biofilms®

9.4 Endrov

Endrov'” (or http://www.endrov.net) (EV) is a multi-purpose image analysis program developed by the Thomas Bur-
glin group'! at Karolinska Institute'?, Department of Biosciences and Nutrition.

9.4.1 Installation

The EV distribution comes bundled with the core Bio-Formats library (bio-formats.jar), so no further installation is
necessary.

9.4.2 Upgrading
It should be possible to use a newer version of Bio-Formats by downloading the latest bio-formats.jar'? and putting it
into the 1ibs folder of the EV distribution, overwriting the old file.

You could also include some optional libraries, to add support for additional formats, if desired.

9.5 FocalPoint

FocalPoint'* is an image browser, similar to Windows Explorer'> or other file manager'® application, specifically

designed to work with more complex image types. FocalPoint uses Bio-Formats to generate thumbnails for some
formats.

http://www.cellprofiler.org/

8http://www.comstat.dk/
http://www2.imm.dtu.dk/pubdb/views/publication_details.php?id=5628
10https://github.com/mahogny/Endrov

http://www.biosci ki.se/groups/tbu

http://www.ki.se/
Bhttp://www.openmicroscopy.org/site/products/bio-formats/downloads/
4http://www.bioinformatics.bbsrc.ac.uk/projects/focalpoint/
5http://en.wikipedia.org/wiki/Windows_Explorer
16http://en.wikipedia.org/wiki/File_manager
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9.5.1 Installation

FocalPoint is bundled with Bio-Formats, so no further installation is necessary.

9.5.2 Upgrading

It should be possible to use a newer version of Bio-Formats'” by overwriting the old loci_tools.jar within the Focal-
Point distribution. For Mac OS X, you will have to control click the FocalPoint program icon, choose “Show Package
Contents” and navigate into Contents/Resources/Java to find the loci_tools.jar file.

9.6 Graphic Converter

Graphic Converter'® is a Mac OS application for opening, editing, and organizing photos. Versions 6.4.1 and later use
Bio-Formats to open all file formats supported by Bio-Formats.

9.7 lcy

Icy! is an open-source image analysis and visualization software package that combines a user-friendly graphical
interface with the ability to write scripts and plugins that can be uploaded to a centralized website. It uses Bio-
Formats internally to read images and acquisition metadata, so no further installation is necessary.

9.8 imago

Mayachitra imago? is an advanced desktop image management package that enables scientists to easily store, manage,
search, and analyze 5D biological images and their analysis results. imago integrates flexible annotation and metadata
management with advanced image analysis tools.

imago uses Bio-Formats to read files in some formats, including Bio-Rad PIC, Image-Pro Workspace, Metamorph
TIFF, Leica LCS LEI, Olympus FluoView FV1000, Nikon NIS-Elements ND2, and Zeiss LSM.

A free 30-day trial version of imago is available here’!.

9.9 Igm

Iqm?? is an image processing application written in Java. It is mainly constructed around the Java JAI library and
furthermore it incorporates the functionality of the popular ImageJ image processing software.

Because iqgm integrates with ImagelJ, it can take advantage of the Bio-Formats ImageJ plugin to read image data.

Thttp://www.openmicroscopy.org/site/products/bio-formats/downloads/
8http://www.lemkesoft.com

http://icy.bioimageanalysis.org/
20pttp://mayachitra.com/imago/index.html

2l http://mayachitra.com/imago/download-trial.php
22pttp://code.google.com/p/igm/
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9.10 Macnification

Macnification?® is a Mac OS X application for organizing, editing, analyzing and annotating microscopic images,
designed for ease of use. It is being developed by Orbicule?*.

Macnification uses Bio-Formats to read files in some formats, including Gatan DM3, ICS, ImagePro SEQ, ImagePro
IPW, Metamorph STK, OME-TIFF and Zeiss LSM.

See also:

Free trial download?

9.11 MIPAV

The MIPAV?® (Medical Image Processing, Analysis, and Visualization) application—developed at the Center for Infor-
mation Technology?®’ at the National Institutes of Health’®—enables quantitative analysis and visualization of medical
images of numerous modalities such as PET, MRI, CT, or microscopy. You can use Bio-Formats as a plugin for MIPAV
to read images in the formats it supports.

9.11.1 Installation

Follow these steps to install the Bio-Formats plugin for MIPAV:
1. Download loci_tools.jar*® and drop it into your MIPAV folder.

2. Download the plugin source code’”

into your user mipav/plugins folder.
3. From the command line, compile the plugin with:

cd mipav/plugins
javac —-cp SMIPAV:S$SMIPAV/loci\_tools.jar \\
PlugInBioFormatsImporter. java

4. where $MIPAV is the location of your MIPAV installation.
5. Add loci_tools.jar to MIPAV’s class path:
* How to do so depends on your platform.
* E.g., in Mac OS X, edit the mipav.app/Contents/Info.plist file.
6. Run MIPAV and a new “BioFormatsImporter - read image” menu item will appear in the Plugins > File submenu.
See the readme file*! for more information.

To upgrade, just overwrite the old loci_tools.jar with the latest one*”. You may want to download the latest version of
MIPAV first, to take advantage of new features and bug-fixes.

Zhttp://www.orbicule.com/macnification/

24http://www.orbicule.com

Zhttp://www.orbicule.com/macnification/download

26http://mipav.cit.nih.gov/

2Thttp://cit.nih.gov/

28http://nih.gov/

2http://www.openmicroscopy.org/site/products/bio-formats/downloads/
30https://github.com/openmicroscopy/bioformats/blob/develop/components/scifio/utils/mipav/PlugInBioFormatsImporter.java
31 https://github.com/openmicroscopy/bioformats/blob/develop/components/scifio/utils/mipav/readme.txt

3 http://www.openmicroscopy.org/site/products/bio-formats/downloads/
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9.12 Vaa3D

Vaa3D?33, developed by the Peng Lab’* at the HHMI Janelia Farm Research Catmpus35 , is a handy, fast, and versatile
3D/4D/5D Image Visualization & Analysis System for Bioimages & Surface Objects.

Vaa3D can use Bio-Formats via the Bio-Formats C++ bindings*°® to read images.

9.13 VisBio

VisBio? is a biological visualization tool designed for easy visualization and analysis of multidimensional image data.
VisBio uses Bio-Formats to import files as the Bio-Formats library originally grew out of our efforts to continually
expand the file format support within VisBio.

9.13.1 Installation

VisBio is bundled with Bio-Formats, so no further installation is necessary.

9.13.2 Upgrading

It should be possible to use a newer version of Bio-Formats*® by overwriting the old bio-formats.jar and optional
libraries within the VisBio distribution. For Mac OS X, you’ll have to control click the VisBio program icon, choose
“Show Package Contents” and navigate into Contents/Resources/Java to find the JAR files.

9.14 XuvTools

XuvTools? is automated 3D stitching software for biomedical image data. As of release 1.8.0, XuvTools uses Bio-
Formats to read image data.

3http://vaa3d.org

34http://penglab.janelia.org/

3Shttp://www.hhmi.org/janelia/
36http://www.farsight-toolkit.org/wiki/FARSIGHT_Tutorials/Building_Software/Bio-Formats/Building_C%2B%2B_Bindings
3http://www.loci.wisc.edu/visbio/

38 http://www.openmicroscopy.org/site/products/bio-formats/downloads/

http://www.xuvtools.org
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CHAPTER
TEN

USING BIO-FORMATS

10.1 An in-depth guide to using Bio-Formats

10.1.1 Overview

This document describes various things that are useful to know when working with Bio-Formats. It is recommended
that you obtain the Bio-Formats source by following the directions on the source code page, rather than using an
official release. It is also recommended that you have a copy of the Javadocs' nearby - the notes that follow will make
more sense when you see the APL.

For a complete list of supported formats, see the Bio-Formats supported formats table.

For a few working examples of how to use Bio-Formats, see these Github pages?

10.1.2 Basic file reading

Bio-Formats provides several methods for retrieving data from files in an arbitrary (supported) format. These methods
fall into three categories: raw pixels, core metadata, and format-specific metadata. All methods described here are
present and documented in loci.formats.IFormatReader- it is advised that you take a look at the source and/or the
Javadocs. In general, it is recommended that you read files using an instance of ImageReader*. While it is possible to
work with readers for a specific format, ImageReader contains additional logic to automatically detect the format of a
file and delegate subsequent calls to the appropriate reader.

Prior to retrieving pixels or metadata, it is necessary to call setld(String)’ on the reader instance, passing in the name
of the file to read. Some formats allow multiple series (5D image stacks) per file; in this case you may wish to call
setSeries(int)° to change which series is being read.

Raw pixels are always retrieved one plane at a time. Planes are returned as raw byte arrays, using one of the openBytes
methods.

Core metadata is the general term for anything that might be needed to work with the planes in a file. A list of core
metadata fields is given below, with the appropriate accessor method in parentheses:

« image width (getSizeX()")
« image height (getSizeY()®)

Thttp://hudson.openmicroscopy.org.uk/job/BIOFORMATS-stable/javadoc/
Zhttp://github.com/openmicroscopy/bioformats/tree/develop/components/bio-formats/utils
3https://github.com/openmicroscopy/bioformats/blob/develop/components/scifio/src/loci/formats/IFormatReader.java
“https://github.com/openmicroscopy/bioformats/blob/develop/components/scifio/src/loci/formats/ImageReader.java
Shttp://hudson.openmicroscopy.org.uk/job/BIOFORMATS-stable/javadoc/loci/formats/IFormatHandler.html#setId(java.lang. String)
Shttp://hudson.openmicroscopy.org.uk/job/BIOFORMATS-stable/javadoc/loci/formats/IFormatReader.html#setSeries(int)
7http://hudson.openmicroscopy.org.uk/job/BIOFORMATS-stable/javadoc/loci/formats/IFormatReader.html#getSize X ()
8http://hudson.openmicroscopy.org.uk/job/BIOFORMATS-stable/javadoc/loci/formats/IFormatReader.html#getSize Y ()
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* number of series per file (getSeriesCount()”)
* total number of images per series (getmageCount()'?)
* number of slices in the current series (getSizeZ()'")
* number of timepoints in the current series (getSizeT()'?)
 number of actual channels in the current series (getSizeC()'?)
* number of channels per image (getRGBChannelCount()'*)
« the ordering of the images within the current series (getDimensionOrder()!”)
» whether each image is RGB (isRGB()'®)
« whether the pixel bytes are in little-endian order (isLittleEndian()'”)
« whether the channels in an image are interleaved (isInterleaved()'®)
» the type of pixel data in this file (getPixel Type()'?)
All file formats are guaranteed to accurately report core metadata.

Format-specific metadata refers to any other data specified in the file - this includes acquisition and hardware param-
eters, among other things. This data is stored internally in a java.util. Hashtable, and can be accessed in one of two
ways: individual values can be retrieved by calling getMetadataValue(String)*’, which gets the value of the specified
key. Alternatively, getMetadata()?! will return the entire Hashtable. Note that the keys in this Hashtable are different
for each format, hence the name “format-specific metadata”.

See Bio-Formats metadata processing for more information on the metadata capabilities that Bio-Formats provides.

10.1.3 File reading extras

The previous section described how to read pixels as they are stored in the file. However, the native format is not
necessarily convenient, so Bio-Formats provides a few extras to make file reading more flexible.

* There are a few “wrapper” readers (that implement IFormatReader) that take a reader in the constructor, and ma-
nipulate the results somehow, for convenience. Using them is similar to the java.io InputStream/OutputStream
model: just layer whichever functionality you need by nesting the wrappers.

— BufferedImageReader”” extends IFormatReader, and allows pixel data to be returned as BufferedImages
instead of raw byte arrays.

— FileStitcher®® extends IFormatReader, and uses advanced pattern matching heuristics to group files that
belong to the same dataset.

9http://hudson.openmicroscopy.org.uk/job/BIOFORMATS-stable/javadoc/loci/formats/IFormatReader. html#getSeriesCount()
10http://hudson.openmicroscopy.org.uk/job/BIOFORMATS-stable/javadoc/loci/formats/[FormatReader. html#getImageCount()
http://hudson.openmicroscopy.org.uk/job/BIOFORMATS-stable/javadoc/loci/formats/IFormatReader. html#getSizeZ()
1Zhttp://hudson.openmicroscopy.org.uk/job/BIOFORMATS-stable/javadoc/loci/formats/IFormatReader.html#getSize T()
Bhttp://hudson.openmicroscopy.org.uk/job/BIOFORMATS-stable/javadoc/loci/formats/IFormatReader.html#getSizeC()
14http://hudson.openmicroscopy.org.uk/job/BIOFORMATS-stable/javadoc/loci/formats/IFormatReader.html#getR GBChannel Count()
I5http://hudson.openmicroscopy.org.uk/job/BIOFORMATS-stable/javadoc/loci/formats/IFormatReader.html#getDimensionOrder()
16http://hudson.openmicroscopy.org.uk/job/BIOFORMATS-stable/javadoc/loci/formats/IFormatReader.html#isRGB()
http://hudson.openmicroscopy.org.uk/job/BIOFORMATS-stable/javadoc/loci/formats/IFormatReader.html#isLittleEndian()
18http://hudson.openmicroscopy.org.uk/job/BIOFORMATS-stable/javadoc/loci/formats/IFormatReader.html#isInterleaved()
9http://hudson.openmicroscopy.org.uk/job/BIOFORMATS-stable/javadoc/loci/formats/IFormatReader.html#getPixel Type()
20http://hudson.openmicroscopy.org.uk/job/BIOFORMATS-stable/javadoc/loci/formats/IFormatReader. html#getMetadataValue(java.lang.String)
21 http://hudson.openmicroscopy.org.uk/job/BIOFORMATS-stable/javadoc/loci/formats/IFormatReader.html#getMetadata()
22https://github.com/openmicroscopy/bioformats/blob/develop/components/scifio/src/loci/formats/gui/BufferedimageReader.java
Zhttps://github.com/openmicroscopy/bioformats/blob/develop/components/scifio/src/loci/formats/FileStitcher.java
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* ImageTools?* and loci.formats.gui. AW TImageTool

ChannelSeparator’* extends IFormatReader, and makes sure that all planes are grayscale - RGB images
are split into 3 separate grayscale images.

ChannelMerger? extends IFormatReader, and merges grayscale images to RGB if the number of channels
is greater than 1.

ChannelFiller’® extends IFormatReader, and converts indexed color images to RGB images.

MinMaxCalculator’” extends IFormatReader, and provides an API for retrieving the minimum and maxi-

mum pixel values for each channel.

DimensionSwapper’® extends IFormatReader, and provides an API for changing the dimension order of a
file.

30 provide a number of methods for manipulating Buffered-

Images and primitive type arrays. In particular, there are methods to split and merge channels in a BufferedIm-
age/array, as well as converting to a specific data type (e.g. convert short data to byte data).

10.1.4 Writing files

The following file formats can be written using Bio-Formats:
TIFF (uncompressed, LZW, JPEG, or JPEG-2000)
OME-TIFF (uncompressed, LZW, JPEG, or JPEG-2000)
JPEG

PNG

AVI (uncompressed)

QuickTime (uncompressed is supported natively; additional codecs use QTJava)

Encapsulated PostScript (EPS)
OME-XML (not recommended)

The writer API (see loci.formats. IFormatWriter?') is very similar to the reader APIL in that files are written one plane
at time (rather than all at once).

All writers allow the output file to be changed before the last plane has been written. This allows you to write to
any number of output files using the same writer and output settings (compression, frames per second, etc.), and is
especially useful for formats that do not support multiple images per file.

Please see loci.formats.tools.ImageConverter*” and this guide to exporting to OME-TIFF files for examples of how to
write files.

10.1.5 Arcane notes and implementation details

Known oddities:

24https://github.com/openmicroscopy/bioformats/blob/develop/components/scifio/src/loci/formats/ChannelSeparator.java
ZShttps://github.com/openmicroscopy/bioformats/blob/develop/components/scifio/src/loci/formats/ChannelMerger.java
26https://github.com/openmicroscopy/bioformats/blob/develop/components/scifio/src/loci/formats/ChannelFiller java
2Thttps://github.com/openmicroscopy/bioformats/blob/develop/components/scifio/src/loci/formats/MinMaxCalculator java

28 https://github.com/openmicroscopy/bioformats/blob/develop/components/scifio/src/loci/formats/DimensionSwapper.java
https://github.com/openmicroscopy/bioformats/blob/develop/components/scifio/src/loci/formats/ImageTools java
30https://github.com/openmicroscopy/bioformats/blob/develop/components/scifio/src/loci/formats/gui/ AW TImageTools.java
31https://github.com/openmicroscopy/bioformats/blob/develop/components/scifio/src/loci/formats/IFormatWriter. java

3 https://github.com/openmicroscopy/bioformats/blob/develop/components/scifio-tools/src/loci/formats/tools/TmageConverter. java
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https://github.com/openmicroscopy/bioformats/blob/develop/components/scifio/src/loci/formats/ChannelSeparator.java
https://github.com/openmicroscopy/bioformats/blob/develop/components/scifio/src/loci/formats/ChannelMerger.java
https://github.com/openmicroscopy/bioformats/blob/develop/components/scifio/src/loci/formats/ChannelFiller.java
https://github.com/openmicroscopy/bioformats/blob/develop/components/scifio/src/loci/formats/MinMaxCalculator.java
https://github.com/openmicroscopy/bioformats/blob/develop/components/scifio/src/loci/formats/DimensionSwapper.java
https://github.com/openmicroscopy/bioformats/blob/develop/components/scifio/src/loci/formats/ImageTools.java
https://github.com/openmicroscopy/bioformats/blob/develop/components/scifio/src/loci/formats/gui/AWTImageTools.java
https://github.com/openmicroscopy/bioformats/blob/develop/components/scifio/src/loci/formats/IFormatWriter.java
https://github.com/openmicroscopy/bioformats/blob/develop/components/scifio-tools/src/loci/formats/tools/ImageConverter.java
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* Importing multi-file formats (Leica LEI, PerkinElmer, FV1000 OIF, ICS, and Prairie TIFF, to name a few) can
fail if any of the files are renamed. There are “best guess” heuristics in these readers, but they are not guaranteed
to work in general. So please do not rename files in these formats.

* If you are working on a Macintosh, make sure that the data and resource forks of your image files are stored
together. Bio-Formats does not handle separated forks (the native QuickTime reader tries, but usually fails).

10.2 Generating test images

Sometimes it is nice to have a file of a specific size or pixel type for testing. To generate a file (that contains gradient
images):

touch "my-special-test-file&pixelType=uint8&sizeX=8192&sizeY¥=8192.fake"

Whatever is before the & is the image name; remaining key value pairs should be pretty self-explanatory. Just replace
the values with whatever you need for testing.

There are a few other keys that can be added as well:

Key Value

sizeZ number of Z sections

sizeC number of channels

sizeT number of timepoints

bitsPerPixel number of valid bits (<= number of bits implied by pixel type)
rgb number of channels that are merged together

dimOrder dimension order (e.g. XYZCT)

little whether or not the pixel data should be little-endian
interleaved whether or not merged channels are interleaved

indexed whether or not a color lookup table is present

falseColor whether or not the color lookup table is just for making the image look pretty
series number of series (Images)

lutLength number of entries in the color lookup table

You can often work with the .fake file directly, but in some cases support for those files is disabled and so you will need
to convert the file to something else. Make sure that you have Bio-Formats built and the JARs in your CLASSPATH
(individual JARs or just loci_tools.jar):

bfconvert test&pixelType=uint8&sizeX=8192&size¥=8192.fake test.tiff

If you do not have the command line tools installed, substitute loci.formats.tools.ImageConverter** for bfconvert.

3 https://github.com/openmicroscopy/bioformats/blob/develop/components/scifio-tools/src/loci/formats/tools/ImageConverter.java
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CHAPTER
ELEVEN

BIO-FORMATS AS A JAVA LIBRARY

11.1 APl documentation

11.1.1 Using Bio-Formats as a Java library

If you wish to make use of Bio-Formats within your own software, you can download bio-formats.jar' to use it as
a library. Just add bio-formats.jar to your CLASSPATH or build path. You will also need loci-common.jar for
common I/O functions, ome-xml.jar for metadata standardization, and SLF4J? for logging.

Beyond bio-formats.jar, loci-common.jar, ome-xml.jar, and SLF4]J 3 no additional libraries are required. However,
there are certain packages that if present will be utilized to provide additional functionality. To include one, just place
it in the same folder.

Package Filename License Notes

Apache Jakarta POI* library, LOCI poi-loci.jar’ Apache For OLE-based formats (zvi, oib,

fork ipw, cxd)

MDB Tools project® Java port, | mdbtools-java.jar’ LGPL For Olympus CellR and Zeiss LSM

LOCI fork metadata (mdb)

JAT Tmage 1/0 Tools® pure Javaim- | jai_imageio.jar’ BSD For JPEG2000-based formats (nd2,

plementation, LOCI fork ip2)

NetCDF Java library™ netcdf-4.0.jar!! LGPL For HDF5-based formats (Imaris
5.5, MINC MRI)

QuickTime for Java'® QTJava.zip Commercial | For additional QuickTime codecs

See the list in the Bio-Formats toplevel build file'® for a complete and up-to-date list of all optional libraries, which
can all be found in our Git repository'*.

Uhttp://www.openmicroscopy.org/site/products/bio-formats/downloads/

Zhttp://slf4].org/

3http://slf4].org/

“http://jakarta.apache.org/poi/
Shttp://hudson.openmicroscopy.org.uk/job/BIOFORMATS-stable/lastSuccessfulBuild/artifact/artifacts/poi-loci.jar
Shttp://sourceforge.net/projects/mdbtools
7http://hudson.openmicroscopy.org.uk/job/BIOFORMATS-stable/lastSuccessfulBuild/artifact/artifacts/mdbtools-java.jar
8http://java.net/projects/jai-imageio
9http://hudson.openmicroscopy.org.uk/job/BIOFORMATS-stable/lastSuccessfulBuild/artifact/artifacts/jai_imageio.jar
10http://www.unidata.ucar.edu/software/netcdf-java/
http://hudson.openmicroscopy.org.uk/job/BIOFORMATS-stable/lastSuccessfulBuild/artifact/artifacts/netcdf-4.0.jar
Zhttp://www.apple.com/quicktime/download/standalone.html
Bhttps://github.com/openmicroscopy/bioformats/blob/develop/build.xml
4https://github.com/openmicroscopy/bioformats/blob/develop/jar
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http://www.apple.com/quicktime/download/standalone.html
https://github.com/openmicroscopy/bioformats/blob/develop/build.xml
https://github.com/openmicroscopy/bioformats/blob/develop/jar
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Examples of usage

ImageConverter'® - A simple command line tool for converting between formats.

Imagelnfo'® - A more involved command line utility for thoroughly reading an input file, printing some information
about it, and displaying the pixels onscreen using the Bio-Formats viewer.

MinimumWriter!” - A command line utility demonstrating the minimum amount of metadata needed to write a file.
PrintTimestamps'® - A command line example demonstrating how to extract timestamps from a file.
Simple_Read'”’ - A simple Image]J plugin demonstrating how to use Bio-Formats to read files into ImageJ (see ImagelJ).

Read_Image®® - An Image] plugin that uses Bio-Formats to build up an image stack, reading image planes one by one
(see Imagel).

Mass_Importer’' - A simple plugin for ImageJ that demonstrates how to open all image files in a directory using
Bio-Formats, grouping files with similar names to avoiding opening the same dataset more than once (see /mageJ).

A Note on Java Web Start (loci_tools.jar vs. bio-formats.jar)

To use Bio-Formats with your Java Web Start application, we recommend using bio-formats.jar rather than
loci_tools.jar—the latter is merely a bundle of bio-formats.jar plus all its optional dependencies.

The loci_tools.jar bundle is intended as a convenience (e.g. to simplify installation as an ImageJ plugin), but is by no
means the only solution for developers. We recommend using bio-formats.jar as a separate entity depending on your
needs as a developer.

The bundle is quite large because we have added support for several formats that need large helper libraries (e.g.
Imaris’ HDF-based format). However, these additional libraries are optional; Bio-Formats has been coded using
reflection so that it can both compile and run without them.

When deploying a JNLP-based application, using loci_tools.jar directly is not the best approach, since every time
Bio-Formats is updated, the server would need to feed another 8+ MB JAR file to the client. Rather, Web Start is a
case where you should keep the JARs separate, since JNLP was designed to make management of JAR dependencies
trivial for the end user. By keeping bio-formats.jar and the optional dependencies separate, only a <1 MB JAR needs
to be updated when bio-formats.jar changes.

As a developer, you have the option of packaging bio-formats.jar with as many or as few optional libraries as you
wish, to cut down on file size as needed. You are free to make whatever kind of “stripped down” version you require.
You could even build a custom bio-formats.jar that excludes certain classes, if you like.

For an explicit enumeration of all the optional libraries included in loci_tools.jar, see the
loci-tools.libraries variable of the ant/toplevel.properties’® file of the distribution. You can also
read our notes about each in the source distribution’s Ant build.xml?? script.

Also see Bio-Formats Javadocs®*

https://github.com/openmicroscopy/bioformats/blob/develop/components/scifio-tools/src/loci/formats/tools/TmageConverter.java
16https://github.com/openmicroscopy/bioformats/blob/develop/components/scifio-tools/src/loci/formats/tools/Imagelnfo.java
Thttps://github.com/openmicroscopy/bioformats/blob/develop/components/bio-formats/utils/MinimumWriter. java
18https://github.com/openmicroscopy/bioformats/blob/develop/components/bio-formats/utils/Print Timestamps.java
19https://github.com/openmicroscopy/bioformats/blob/develop/components/loci-plugins/utils/Simple_Read.java
20https://github.com/openmicroscopy/bioformats/blob/develop/components/loci-plugins/utils/Read_Image java

21 https://github.com/openmicroscopy/bioformats/blob/develop/components/loci-plugins/utils/Mass_Importer.java
22https://github.com/openmicroscopy/bioformats/blob/develop/ant/toplevel.properties

2 https://github.com/openmicroscopy/bioformats/blob/develop/build. xmI#1.240
Z*http://hudson.openmicroscopy.org.uk/job/BIOFORMATS-stable/javadoc/
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11.2 Examples

11.2.1 Exporting files using Bio-Formats

This guide pertains to version 4.2 and later.

Basic conversion

The first thing we need to do is set up a reader:

// create a reader that will automatically handle any supported format
IFormatReader reader = new ImageReader();

// tell the reader where to store the metadata from the dataset
reader.setMetadataStore (MetadataTools.createOMEXMLMetadata ()) ;

// initialize the dataset

reader.setId("/path/to/file");

Now, we set up our writer:

// create a writer that will automatically handle any supported output format
IFormatWriter writer = new ImageWriter();

// give the writer a MetadataRetrieve object, which encapsulates all of the

// dimension information for the dataset (among many other things)
writer.setMetadataRetrieve (MetadataTools.asRetrieve (reader.getMetadataStore()));
// initialize the writer

writer.setId("/path/to/output/file");

Note that the extension of the file name passed to ‘writer.setld(...)” determines the file format of the exported file.
Now that everything is set up, we can start writing planes:

for (int series=0; series<reader.getSeriesCount (); series++) {
reader.setSeries (series);
writer.setSeries (series);

for (int image=0; image<reader.getImageCount (); image++) {
writer.saveBytes (image, reader.openBytes (image));

Finally, make sure to close both the reader and the writer. Failure to do so can cause:
* file handle leaks
* memory leaks
e truncated output files

Fortunately, closing the files is very easy:

reader.close();
writer.close();

Converting large images

The flaw in the previous example is that it requires an image plane to be fully read into memory before it can be saved.
In many cases this is fine, but if you are working with very large images (especially > 4 GB) this is problematic.
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The solution is to break each image plane into a set of reasonably-sized tiles and save each tile separately - thus
substantially reducing the amount of memory required for conversion.

For now, we’ll assume that your tile size is 1024 x 1024, though in practice you will likely want to adjust this.
Assuming you have an I[FormatReader and IFormatWriter set up as in the previous example, let’s start writing planes:

int tileWidth = 1024;
int tileHeight = 1024;

for (int series=0; series<reader.getSeriesCount (); series++) {
reader.setSeries (series);
writer.setSeries (series);

// determine how many tiles are in each image plane
// for simplicity, we’ll assume that the image width and height are
// multiples of 1024

int tileRows = reader.getSizeY() / tileHeight;
int tileColumns = reader.getSizeX() / tileWidth;

for (int image=0; image<reader.getImageCount (); image++) {
for (int row=0; row<tileRows; row++) {
for (int col=0; col<tileColumns; col++) {
// open a tile - in addition to the image index, we need to specify
// the (x, y) coordinate of the upper left corner of the tile,
// along with the width and height of the tile

int xCoordinate = col * tileWidth;
int yCoordinate = row x tileHeight;
byte[] tile =
reader.openBytes (image, xCoordinate, yCoordinate, tileWidth, tileHeight);
writer.saveBytes (
image, tile, xCoordinate, yCoordinate, tileWidth, tileHeight);

As noted, the example assumes that the width and height of the image are multiples of the tile dimensions. Be careful,
as this is not always the case; the last column and/or row may be smaller than preceding columns/rows. An exception
will be thrown if you attempt to read or write a tile that is not completely contained by the original image plane. Most
writers perform best if the tile width is equal to the image width, although specifying any valid width should work.

As before, you need to close the reader and writer.

Converting to multiple files

The recommended method of converting to multiple files is to use a single [FormatWriter, like so:

// you should have set up a reader as in the first example
ImageWriter writer = new ImageWriter();
writer.setMetadataRetrieve (MetadataTools.asRetrieve (reader.getMetadataStore()));
// replace this with your own filename definitions
// in this example, we’re going to write half of the planes to one file
// and half of the planes to another file
String[] outputFiles =
new String[] {"/path/to/file/1.tiff", "/path/to/file/2.tiff"};
writer.setId (outputFiles([0]);
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int planesPerFile = reader.getImageCount () / outputFiles.length;
for (int file=0; file<outputFiles.length; file++) {
writer.changeOutputFile (outputFiles[file]);
for (int image=0; image<planesPerFile; image++) {
int index = file x planesPerFile + image;
writer.saveBytes (image, reader.openBytes (index));

reader.close();
writer.close();

The advantage here is that the relationship between the files is preserved when converting to formats that support
multi-file datasets internally (namely OME-TIFF). If you are only converting to graphics formats (e.g. JPEG, AVI,
MOV), then you could also use a separate [FormatWriter for each file, like this:

// again, you should have set up a reader already
String[] outputFiles = new String[] {"/path/to/file/l.avi", "/path/to/file/2.avi"};
int planesPerFile = reader.getImageCount () / outputFiles.length;
for (int file=0; file<outputFiles.length; file++) {
ImageWriter writer = new ImageWriter();
writer.setMetadataRetrieve (MetadataTools.asRetrieve (reader.getMetadataStore()));
writer.setId (outputFiles[file]);
for (int image=0; image<planesPerFile; image++) {
int index = file » planesPerFile + image;
writer.saveBytes (image, reader.openBytes (index));

}

writer.close();

Known issues

List of Trac tickets?

11.2.2 Further details on exporting raw pixel data to OME-TIFF files

This document explains how to export pixel data to OME-TIFF using Bio-Formats version 4.2 and later.
The first thing that must happen is we must create the object that stores OME-XML metadata. This is done as follows:

ServiceFactory factory = new ServiceFactory();
OMEXMLService service = factory.getInstance (OMEXMLService.class);
IMetadata omexml = service.createOMEXMLMetadata () ;

The ‘omexml’ object can now be used in our code to store OME-XML metadata, and by the file format writer to
retrieve OME-XML metadata.

Now that we have somewhere to put metadata, we need to populate as much metadata as we can. The minimum
amount of metadata required is:

* endianness of the pixel data
e the order in which dimensions are stored

* the bit depth of the pixel data

ZShttp://trac.openmicroscopy.org.uk/ome/query ?status=accepted &status=new&status=reopened&keywords= export&component=Bio-
Formats&col=id&col=summary&col=status&col=type&col=priority &col=milestone&col=component&order=priority
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* the number of channels

¢ the number of timepoints

* the number of Z sections

¢ the width (in pixels) of an image

* the height (in pixels) of an image

* the number of samples per channel (3 for RGB images, 1 otherwise)
We populate that metadata as follows:

omexml.setImageID ("Image:0", 0);
omexml.setPixelsID("Pixels:0", 0);

// specify that the pixel data is stored in big-endian order
// replace ’'TRUE’ with ’'FALSE’ to specify little-endian order
omexml.setPixelsBinDataBigEndian (Boolean.TRUE, 0, O0);

omexml.setPixelsDimensionOrder (DimensionOrder.XYCZT, 0);
omexml.setPixelsType (PixelType.UINT16, O0);
omexml.setPixelsSizeX (new Positivelnteger
(new PositiveInteger
omexml.setPixelsSizeZ (new PositivelInteger
omexml.setPixelsSizeC (new Positivelnteger
samplesPerChannel), 0);
omexml.setPixelsSizeT (new PositivelInteger (timepointCount), 0);

width), 0);
height), 0);
zSectionCount), 0);
channelCount =«

omexml.setPixelsSizeY

for (int channel=0; channel<channelCount; channel++) {
omexml.setChannelID ("Channel:0:" + channel, 0, channel);
omexml.setChannelSamplesPerPixel (new PositivelInteger (samplesPerChannel),
0, channel);

}

There is much more metadata that can be stored; please see the Javadoc for loci.formats.meta.MetadataStore for a
complete list.

Now that we have defined all of the metadata, we need to create a file writer:

ImageWriter writer = new ImageWriter();

Now we must associate the ‘omexml’ object with the file writer:

writer.setMetadataRetrieve (omexml) ;

The writer now knows to retrieve any metadata that it needs from ‘omexml’.
We now tell the writer which file it should write to:

writer.setId("output-file.ome.tiff");

It is critical that the file name given to the writer ends with ”.ome.tiff” or ”.ome.tif”, as it is the file name extension
that determines which format will be written.

Now that everything is set up, we can save the image data. This is done plane by plane, and we assume that the pixel
data is stored in a 2D byte array ‘pixelData’:

int sizeC = omexml.getPixelsSizeC (0).getValue();

int sizeZ = omexml.getPixelsSizeZ (0) .getValue();
int sizeT = omexml.getPixelsSizeT (0).getValue();
int samplesPerChannel = omexml.getChannelSamplesPerPixel (0) .getValue();
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sizeC /= samplesPerChannel;
int imageCount = sizeC % sizeZ * sizeT;

for (int image=0; image<imageCount; image++) {
writer.saveBytes (image, pixelData[image]);

}

Finally, we must tell the writer that we are finished, so that the output file can be properly closed:

writer.close();

There should now be a complete OME-TIFF file at whichever path was specified above.

11.2.3 Converting files from FV1000 OIB/OIF to OME-TIFF

This document explains how to convert a file from FV1000 OIB/OIF to OME-TIFF using Bio-Formats version 4.2 and
later.

The first thing that must happen is we must create the object that stores OME-XML metadata. This is done as follows:

ServiceFactory factory = new ServiceFactory();
OMEXMLService service = factory.getInstance (OMEXMLService.class);
IMetadata omexml = service.createOMEXMLMetadata () ;

The ‘omexml’ object can now be used by both a file format reader and a file format writer for storing and retrieving
OME-XML metadata.

Now that have somewhere to put metadata, we need to create a file reader and writer:

ImageReader reader = new ImageReader();
ImageWriter writer = new ImageWriter();

Now we must associate the ‘omexml’ object with the file reader and writer:

reader.setMetadataStore (omexml) ;
writer.setMetadataRetrieve (omexml) ;

The reader now knows to store all of the metadata that it parses into ‘omexml’, and the writer knows to retrieve any
metadata that it needs from ‘omexml’.

We now tell the reader and writer which files will be read from and written to, respectively:

reader.setId("input-file.oib");
writer.setId("output-file.ome.tiff");

It is critical that the file name given to the writer ends with ”.ome.tiff” or ”.ome.tif”, as it is the file name extension
that determines which format will be written.

Now that everything is set up, we can convert the image data. This is done plane by plane:

for (int series=0; series<reader.getSeriesCount (); series++) {
reader.setSeries (series);
writer.setSeries (series);

byte[] plane = new byte[FormatTools.getPlaneSize (reader)];
for (int image=0; image<reader.getImageCount (); image++) {
reader.openBytes (image, plane);
writer.saveBytes (image, plane);
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}

The body of the outer ‘for’ loop may also be replaced with the following:

reader.setSeries (series);
writer.setSeries (series);

for (int image=0; image<reader.getImageCount (); image++) {
byte[] plane = reader.openBytes (image);
writer.saveBytes (image, plane);

}

But note that this will be a little slower.
Finally, we must tell the reader and writer that we are finished, so that the input and output files can be properly closed:

reader.close();
writer.close();

There should now be a complete OME-TIFF file at whichever path was specified above.

11.2.4 Using Bio-Formats in Matlab

This section assumes that you have installed the bfopen.m script and loci_tools.jar, as instructed /ere.

The first thing to do is initialize a file:

data = bfopen ('’ /path/to/data/file’);

‘data’ is an array whose structure is a bit complicated. It is an n-by-4 array, where n is the number of series in the
dataset:

* The {s, 1} element (if s is the series index between 1 and n) is an m-by-2 array, where m is the number of planes
in the series:

— The {s, 1, t, 1} element (where t is the image index between 1 and m) contains the pixel data for the t-th
image in the s-th series.

— The {s, 1, t, 2} element contains the label for said image.
e The {s, 2} element of ‘data’ contains original metadata key/value pairs that apply to the s-th series.
* The {s, 3} element of ‘data’ contains color lookup tables for each image in the series.

e The {s, 4} element of ‘data’ contains a standardized OME metadata structure, which is the same regardless of
the input file format, and contains common metadata values such as physical pixel sizes—see “Accessing OME
metadata” below for examples.

Accessing planes

Here is an example of how to unwrap specific image planes for easy access:

data = bfopen ('’ /path/to/data/file’);
seriesCount = size(data, 1);

seriesl = data{l, 1};

series2 = data{2, 1};

series3 = data{3, 1};

metadatalList = data{l, 2};
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% ...etc.

seriesl_planeCount = size(seriesl, 1);
seriesl_planel = seriesl{l, 1};
seriesl_labell = seriesl{l, 2};
seriesl_plane2 = seriesl{2, 1};
seriesl_label2 = seriesl{2, 2};
seriesl_plane3 = seriesl{3, 1};
seriesl_label3 = seriesl{3, 2};

% ...etc.

Displaying images

If you want to display one of the images, you can do so as follows:

data = bfopen(’/path/to/data/file’);
% plot the 1st series’s 1lst image plane in a new figure
seriesl = data{l, 1};
seriesl_planel = seriesl{l, 1};
seriesl_labell = seriesl{l, 2};
seriesl_colorMaps = data{l, 3};
figure ('Name’, seriesl_labell);
if (isempty (seriesl_colorMaps{1l}))
colorMap (gray) ;
else
colorMap (seriesl_colorMaps{l});
end
imagesc (seriesl_planel);

This will display the first image of the first series with its associated color map (if present). If you would prefer not to
apply the color maps associated with each image, simply comment out the calls to ‘colorMap’.

Using the image processing toolbox

If you have the image processing toolbox, you could instead use:

imshow (seriesl_planel, [1);

Displaying an animation

Here is an example that animates as a movie (assumes 8-bit unsigned data):

v = linspace (0, 1, 256)7;

cmap = [v v Vv];
for p = l:seriesl_numPlanes

M(p) = im2frame (uint8 (seriesl{p, 1}), cmap);
end

movie (M) ;

Retrieving metadata

There are two kinds of metadata:

¢ Original metadata is a set of key/value pairs specific to the input format of the data. It is stored in the [s, 2]
element of the data structure returned by bfopen.
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* OME metadata is a standardized metadata structure, which is the same regardless of input file format. It is
stored in the [s, 4] element of the data structure returned by bfopen, and contains common metadata values such
as physical pixel sizes, instrument settings, and much more. See the OME Model and Formats®® pages for full
details.

Accessing original metadata

To retrieve the metadata value for specific keys:

data = bfopen ('’ /path/to/data/file’);

% Query some metadata fields (keys are format-dependent)
metadata = data{l, 2};

subject = metadata.get ('’ Subject’);

title = metadata.get (' Title’);

To print out all of the metadata key/value pairs for the first series:

data = bfopen ('’ /path/to/data/file’);
metadata = data{l, 2};
metadataKeys = metadata.keySet ().iterator();
for i1=1l:metadata.size ()

key = metadataKeys.nextElement () ;

value = metadata.get (key);

fprintf ('%$s = %$s\n’, key, value)
end

Accessing OME metadata

Conversion of metadata to the OME standard is one of Bio-Formats’ primary features. The OME metadata is always
stored the same way, regardless of input file format.

To access physical voxel and stack sizes of the data:

data = bfopen ('’ /path/to/data/file’);

omeMeta = data{l, 4};

stackSizeX = omeMeta.getPixelsSizeX (0) .getValue();
stackSizeY = omeMeta.getPixelsSizeY (0) .getValue();
stackSizeZ = omeMeta.getPixelsSizeZ (0) .getValue();

image width, pixels
image height, pixels
number of Z slices

o o oP

voxelSizeX = omeMeta.getPixelsPhysicalSizeX (0).getValue(); % in um
voxelSizeY = omeMeta.getPixelsPhysicalSizeY (0).getValue(); % in um
voxelSizeZ = omeMeta.getPixelsPhysicalSizeZ (0) .getValue(); % in pm
Saving files

First, make sure that you have loci_tools.jar installed in your MATLAB work folder.
Now, here is the basic code for saving planes (2 channels x 2 timepoints) to a file:

javaaddpath (fullfile(fileparts (mfilename (' fullpath’)), ’loci_tools.jar’));
writer = loci.formats.ImageWriter();

metadata = loci.formats.MetadataTools.createOMEXMLMetadata () ;
metadata.createRoot () ;

metadata.setImagelID (' Image:0", 0);

metadata.setPixelsID ('Pixels:0’, 0);

26http://www.openmicroscopy.org/site/support/ome-model/

11.2. Examples 73


http://www.openmicroscopy.org/site/support/ome-model/

Bio-Formats Documentation, Release 4.4.8-DEV

metadata.setPixelsBinDataBigEndian (java.lang.Boolean.TRUE, 0, 0);
metadata.setPixelsDimensionOrder (ome.xml.model.enums.DimensionOrder.XYZCT, O0);
metadata.setPixelsType (ome.xml.model.enums.PixelType.UINT8, O0);

imageWidth = ome.xml.model.primitives.PositivelInteger (java.lang.Integer (64))
imageHeight = ome.xml.model.primitives.PositivelInteger (java.lang.Integer (64))
numZSections = ome.xml.model.primitives.PositivelInteger (java.lang.Integer (1))
numChannels = ome.xml.model.primitives.PositivelInteger (java.lang.Integer(2))
numTimepoints = ome.xml.model.primitives.PositivelInteger (java.lang.Integer(2))
samplesPerPixel = ome.xml.model.primitives.PositivelInteger (java.lang.Integer(1l))

metadata.setPixelsSizeX (imageWidth, 0);
metadata.setPixelsSizeY (imageHeight, O0);
metadata.setPixelsSizeZ (numZSections, 0);
metadata.setPixelsSizeC (numChannels, 0);
metadata.setPixelsSizeT (numTimepoints, O0);
metadata.setChannelID ('’ Channel:0:0", 0, 0);
metadata.setChannelSamplesPerPixel (samplesPerPixel, 0, 0);
metadata.setChannelID ('’ Channel:0:1", 0, 1);
metadata.setChannelSamplesPerPixel (samplesPerPixel, 0, 1);

’

writer.setMetadataRetrieve (metadata);
writer.setId("my-file.ome.tiff");

writer.saveBytes (0, plane); % channel 0, timepoint 0
writer.saveBytes(l, plane); % channel 1, timepoint O
writer.saveBytes (2, plane); % channel 0, timepoint 1
writer.saveBytes (3, plane); % channel 1, timepoint 1

writer.close();

This example will write a single plane to an OME-TIFF file. It assumes that there are 8 unsigned bits per pixel, and
that the image is 64 pixels x 64 pixels. In your own code, you will need to adjust the dimensions and pixel type
accordingly. Also, ‘plane’ is an array constructed like so:

plane = zeros(l, 64 = 64, ’'uint8’);

There is also a script that can save MATLAB arrays to supported formats:

bfsave.m?’

11.2.5 Source code

If you are interested in the latest Bio-Formats source code from our Git*® repository, you can access it using the
repository path:

git@github.com:openmicroscopy/bioformats.git
You can also browse the Bio-Formats source on GitHub*’

To build the code, you can use our Ant build script—try “ant —p” for a list of targets. In general, “ant jars” or “ant
tools” is the correct command.

Lastly, you can browse the Bio-Formats Javadocs online®, or generate them yourself using the “docs” Ant target.

2Thttps://github.com/openmicroscopy/bioformats/blob/develop/components/bio-formats/matlab/bfsave.m
Z8http://git-scm.com/

2https://github.com/openmicroscopy/bioformats
30http://hudson.openmicroscopy.org.uk/job/BIOFORMATS-stable/javadoc/
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CHAPTER
TWELVE

INTERFACING FROM NON-JAVA CODE

12.1 Solutions for interfacing from non-Java code

Bio-Formats is written in Java, and is easiest to use with other Java code. However, it is possible to call Bio-Formats
from a program written in another language. But how to do so depends on your program’s needs.

Technologically, there are two broad categories of solutions: in-process approaches, and inter-process communi-

cation. See below for discussion and examples of each. For further reading, check out Codemesh’s technology

comparison'.

Recommended in-process solution: Bio-Formats C++ bindings

Recommended inter-process solution: Subimager

12.1.1 In-process approaches

With an in-process approach, your application directly invokes Java code, either by spawning its own internal Java
Virtual Machine (JVM) and passing data across a bridge, or otherwise executing the Java code within a single envi-
ronment.

Strengths Weaknesses

Tight (API-level) integration No shared state between processes
Minimal performance overhead | Limited portability

Few security considerations

Paradigms:

* JNI — The most common paradigm is the Java Native Interface’, an API for interfacing Java programs with
native’ C/C++ code. Functionality exists to 1) call C/C++ methods from Java, and 2) spawn a Java Virtual
Machine and execute Java instructions from C/C++. The latter direction, known as Java Invocation®, is the
relevant one for calling Bio-Formats from C++. Because using the JNI directly involves writing a lot of tedious
glue code, several projects have emerged for autogenerating such code. See below: raw JNI, Jace, JunC++ion,
JuggerNET

* Compilers — The dominant paradigm in Java is to compile Java source to Java bytecode, then execute the byte-
code in a Java interpreter. However, an alternative is to compile the Java source directly to native code so that
it can link with other native programs. Such an approach requires that the compiler provide correct support for
all necessary Java standard library features. It may also exhibit much different performance (for better or for
worse) than Sun’s Java implementation does. See below: GCJ

Ihttp://codemesh.com/technology.html
Zhttp://en.wikipedia.org/wiki/Java_Native_Interface
3http://en.wikipedia.org/wiki/Native_mode
“http://java.sun.com/javase/6/docs/technotes/guides/jni/spec/invocation.html

75


http://codemesh.com/technology.html
http://codemesh.com/technology.html
http://en.wikipedia.org/wiki/Java_Native_Interface
http://en.wikipedia.org/wiki/Native_mode
http://java.sun.com/javase/6/docs/technotes/guides/jni/spec/invocation.html

Bio-Formats Documentation, Release 4.4.8-DEV

* Runtimes — The safest way to guarantee correct program behavior is to execute Java bytecode using the Java
interpreter(s) with which it has been tested (which in the case of Bio-Formats is Sun’s implementation). How-
ever, a Java runtime written using a specific framework (e.g., .NET) could enable seamless integration with
other (non-Java) programs within the same framework. Like the compiler-based paradigm above, though, it is
reliant on the correctness, completeness and performance of the Java implementation in question. See below:
IKVM.NET

12.1.2 Inter-process communication

The other approach is inter-process communication’, a broad collection of techniques for exchanging data between
multiple running programs. Such techniques take many forms in computing; one ubiquitous example is web browsers
and web servers. Most solutions in this category are some form of middleware®.

Strengths Weaknesses
Share state between multiple Object marshalling” incurs significant overhead
processes on multiple machines
Broad portability and language Potentially vulnerable to security exploits
support

Paradigms:

* Local communication — Modern operating systems provide several ways to share information between processes,
including shared memory, file system access, and passing data back and forth with standard input and output
streams®. See below: pipes, files

* Messaging — Networking technology allows a process on one computer to send and receive messages from
another process on a different machine. The client-server’ model is probably most applicable for Java/native
integration, with the Java portion acting as a server that can be queried from the native code. See below: sockets,
XML-RPC

* ORB - An object request broker'” (ORB) is a high-level form of middleware for transferring objects between
multiple running programs. ORBs provide an abstraction that can reduce and simplify code written by providing
access to a wealth of higher-level messaging features. See below: Ice, CORBA, Codemesh Shared JVM

12.1.3 List of solutions

It is a significant challenge to access a complex Java API from code written in another language, especially in a cross-
platform and high performance way. The table below provides an overview of viable approaches, further details are
provided below it with links to source code and instructions where appropriate. Which approach to use depends on
your application’s target platforms and languages, and the interaction model between your application and the Java
code—see the discussion of in-process solutions versus inter-process communication above for details.

A note about SWIG. The Simplified Wrapper and Interface Generator'! (SWIG) is an excellent tool for exposing
C++ functionality to higher level languages such as Java. Unfortunately, calling native code from Java is the wrong
direction for our purposes. However, when combined with an integration solution specific to C++, SWIG could be
used to extend that solution into other languages (see SWIG’s list of supported languages'? for a complete list).

Shttp://en.wikipedia.org/wiki/Inter-process_communication
Shttp://en.wikipedia.org/wiki/Middleware
"http://en.wikipedia.org/wiki/Marshalling_%?28computer_science%29
8http://en.wikipedia.org/wiki/Standard_streams
9http://en.wikipedia.org/wiki/Client-server
10http://en.wikipedia.org/wiki/Object_request_broker
Uhttp://www.swig.org/
Rhttp://www.swig.org/compat.htm#SupportedLanguages
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Summary table

Solution Type Languages
Raw JNI In-process (JNI) C/C++

Jace In-process (JNI) C/C++
JunC++ion In-process (JNI) C/C++
JuggerNET In-process (JNI) .NET

GCJ In-process (compiler) C/C++ (GCC only)
IKVM.NET In-process (runtime) .NET/Mono
Pipes Inter-process (local) Any

Files Inter-process (local) Any
Sockets Inter-process (messaging) | Any
XML-RPC Inter-process (messaging) | Many'?

Ice Inter-process (ORB) Several
CORBA Inter-process (ORB) Many
Codemesh Shared JVM | Inter-process (ORB) C++/.NET

Further details

Raw JNI'#

* You can code your integration layer using pure JNI calls (but we don’t recommend it).

¢ Low-level JNI offers full control over the interface between Java and native code.

* We have coded a simple example

16

Raw JNI solutions are time-consuming and error-prone'” to implement.

for calling Bio-Formats this way.

* We recommend a higher level integration solution such as Jace instead.

Jace!”

* Jace generates C++ proxy classes, one per Java class, mirroring the original functionality as much as possible.

* The C++ proxy classes use JNI under the hood but handle most of the usual JNI pitfalls.

* We provide a set of Bio-Formats C++ bindings using Jace.

JunC++ion'8

* JunC++ion is a commercial in-process integration solution for C/C++ available from Codemesh, Inc.'”

JuggerNET?

* JuggerNET is a commercial in-process integration solution for .NET available from Codemesh, Inc.?!

GCJ?*?

* GCIJ can compile Java code into machine code.

Bhttp://en.wikipedia.org/wiki/XML-RPC#Implementations
4http://java.sun.com/javase/6/docs/technotes/guides/jni/spec/invocation.html
Shttp://codemesh.com/technology.html#jni
16https://github.com/openmicroscopy/bioformats/blob/develop/components/bio-formats/utils/showinfJNILcpp
Thttp://sourceforge.net/projects/jace/

18http://codemesh.com/products/junction/

http://www.codemesh.com/

20pttp://codemesh.com/products/juggernet/

2lhttp://www.codemesh.com/

22http://gce.gnu.org/javal
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« Instead of JNI, GCJ uses its Compiler Native Interface>® (CNI) to enable access to Java code from C++.

* Works with GCC only (i.e., not with Microsoft Visual C++ or other compilers).

» Correctness and performance is dependent on the compiler implementation.
IKVM.NET*

e IKVM.NET interprets Java byte code on the fly into the .NET/Mono framework.

* Interoperability is limited to applications in the . NET/Mono framework.

 Correctness and performance is dependent on the runtime implementation.
Pipes®

* Pipes can work well when quantity of data being transferred is limited.

* Be careful about blocking operations causing deadlock.

+ The OME Perl server’ uses a combination of pipes and files to interface with Bio-Formats.
Files?’

» Communication via files is slower than pipes, since messages go through disk.

* The size of the communication buffer is limited only by available disk space.

» The OME Perl server” uses a combination of pipes and files to interface with Bio-Formats.
Sockets?’

* You can use a sockets API directly to create a custom solution (but we don’t recommend it).

+ JVMLink" was our first cut at such a solution, before we realized that we were essentially inventing our own
middleware.

* We recommend using Ice or CORBA instead.
XML-RPC?!
+ XML-RPC is a cross-platform remote procedure call** (RPC) technology using XML.
e XML-RPC is a human readable, but inefficient, means of transporting information.
* See also: SOAP**
Ice®*
¢ Ice is high-performance middleware for cross-platform client/server communication.

 ZeroC? argues that Ice is superior to CORBA™,
CORBA?’

Zhttp://gce.gnu.org/java/papers/cni/t].html

2 http://www.ikvm.net/
ZShttp://en.wikipedia.org/wiki/Pipeline_%28Unix%29
20http://www.openmicroscopy.org/site/products/legacy/ome-server
2Thttp://en.wikipedia.org/wiki/Computer_file

28 http://www.openmicroscopy.org/site/products/legacy/ome-server
http://en.wikipedia.org/wiki/Unix_domain_socket
3Ohttp://www.loci.wisc.edu/software/jvmlink
31http://en.wikipedia.org/wiki/XML-RPC
3http://en.wikipedia.org/wiki/Remote_procedure_call
3Bhttp://en.wikipedia.org/wiki/SOAP_%28protocol %29
34http://www.zeroc.com

3Shttp://www.zeroc.com
36http://www.zeroc.com/iceVsCorba.html
3Thttp://java.sun.com/j2ee/corba/
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+ Java RMI over IIOP* enables communication between Java and other CORBA-supported languages.
* CORBA is a mature technology with widespread use in the enterprise community.
 Support for CORBA is built in to the Java 2 platform.
* Nonetheless, where possible we suggest you use Ice instead.
Codemesh Shared JVM*»
* The Codemesh Shared JVM is a commercial inter-process integration solution available from Codemesh, Inc.*”

Know a great integration solution that we missed? Let us know*!!

12.2 Bio-Formats C++ bindings

To make Bio-Formats accessible to software written in C++, we have created a Bio-Formats C++ interface (BF-CPP
for short). It uses LOCI’s jar2lib** program to generate a C++ proxy class for each equivalent Bio-Formats Java class.
The resulting proxies are then compiled into a library, which represents the actual interface from C++ to Bio-Formats.
Using this library in your projects gives you access to the image support of Bio-Formats.

BF-CPP comes with some standalone examples which you can use as a starting point in your own project:
* showinf*
o minimum_writer*
Other projects using BF-CPP include:
* WiscScan*®? which uses BF-CPP to write OME-TIFF*° files.
 XuvTools which uses an adapted version of BF-CPP called BlitzBioFormats*’.

See the build instructions (Windows, Mac OS X, Linux) for details on compiling BF-CPP from source. Once this is
done, simply include it in your project as you would any other external library.

12.3 Build instructions for C++ bindings

This package provides language bindings for calling into the Bio-Formats Java library from C++ in a cross-platform
manner. As of this writing the bindings are functional with GCC on Linux and Mac OS X systems, as well as with
Visual C++ 2005 and Visual C++ 2008 on Windows.

12.3.1 Compile-time dependencies

To build the Bio-Formats C++ bindings from source, the following modules are required:

3 http://java.sun.com/products/rmi-iiop/

3http://codemesh.com/shared_jvm.html

4Ohttp://www.codemesh.com/

41 http://www.openmicroscopy.org/site/community/mailing-lists

“http://loci.wisc.edu/software/jar2lib
“3https://github.com/openmicroscopy/bioformats/blob/develop/components/scifio/cppwrap/showinf.cpp
“https://github.com/openmicroscopy/bioformats/blob/develop/components/scifio/cppwrap/minimum_writer.cpp
#http://loci.wisc.edu/software/wiscscan

46http://www.openmicroscopy.org/site/support/ome-model/ome-tiff
“Thttp://www.xuvtools.org/devel:libblitzbioformats
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+ Apache Maven*® Maven is a software project management and comprehension tool. Along with Ant, it is one
of the supported build systems for the Bio-Formats Java library, and is used to generate the Bio-Formats
C++ bindings.

CMake* CMake is a cross-platform, open source build system generator, commonly used to build C++ projects
in a platform-independent manner. CMake supports GNU make as well as Microsoft Visual Studio, allow-
ing the Bio-Formats C++ bindings to be compiled on Windows, Mac OS X, Linux and potentially other
platforms.

* Boost Thread>” Boost is a project providing open source portable C++ source libraries. It has become a suite
of de facto standard libraries for C++. The Bio-Formats C++ bindings require the Boost Thread module in
order to handle C++ threads in a platform independent way.

« Java Development Kit’! At runtime, only the Java Runtime Environment (JRE) is necessary to execute the
Bio-Formats code. However, the full J2SE development kit is required at compile time on some platforms
(Windows in particular), since it comes bundled with the JVM shared library (jvm.lib) necessary to link
with Java.

For information on installing these dependencies, refer to the page for your specific platform: Windows, Mac OS X,
Linux.

12.3.2 How to build

The process of building the Bio-Formats C++ bindings is divided into two steps:

1. Generate a C++ project consisting of “proxies” which wrap the Java code. This step utilizes the Maven project
management tool, specifically a Maven plugin called cppwrap.

2. Compile this generated C++ project. This step utilizes the cross-platform CMake build system.

For details on executing these build steps, refer to the page for your specific platform: Windows, Mac OS X, Linux.

12.3.3 Build results

If all goes well, the build system will:

1. Generate the Bio-Formats C++ proxy classes;

2. Build the Jace C++ library;

3. Build the Java Tools C++ library;

4. Build the Bio-Formats C++ shared library;

5. Build the showinf and minimum_writer command line tools, for testing the functionality.
Please be patient, as the build may require several minutes to complete.
Afterwards, the dist/scifio subdirectory will contain the following files:

1. libjace.so / libjace.jnilib / jace.dll : Jace shared library
. libscifio.so / libscifio.dylib / scifio.dll : SCIFIO C++ shared library
. jace-runtime.jar : Jace Java classes needed at runtime
. loci_tools.jar : Bio-Formats Java library needed at runtime
. libjtools.so / libjtools.jnilib / jtools.dll : Java Tools shared library

. showinf / showinf.exe : Example command line application

e =) WY B - L US B )

. minimum_writer / minimum_writer.exe : Example command line application
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Items 1-4 are necessary and required to deploy Bio-Formats with your C++ application. Item 5 (jtools) is a useful
helper library for managing the Java virtual machine from C++, but is not strictly necessary to use Bio-Formats. All
other files, including the example programs and various build files generated by CMake, are not needed.

If you prefer, instead of using the loci_tools.jar bundle, you can provide individual JAR files as appropriate for your
application. For details, see using Bio-Formats as a Java library.

Please direct any questions to the OME team on the forums>? or mailing lists>®.

12.4 Building C++ bindings in Windows

12.4.1 Compile-time dependencies — Windows
Windows users will need to visit the appropriate web sites and download and install the relevant binaries for all the
dependencies.

To configure the tools, you will need to edit or create several environment variables on your system. Access them by
clicking the “Environment Variables” button from Control Panel, System, Advanced tab. Use semicolons to separate
multiple directories in the PATH variable.

12.4.2 Compile-time dependencies — Windows — Maven

Download Maven>*.

Unpack the Maven archive into your Program Files, then add the folder’s bin subdirectory to your PATH environment
variable; e.g.:

C:\Program Files\apache-maven-3.0.4\bin

Once set, new Command Prompts will recognize “mvn” as a valid command.

12.4.3 Compile-time dependencies — Windows — CMake

Download and run the CMake installer™.

During installation, select the “Add CMake to the system PATH for all users” option to ensure that Bio-Formats build
system can find your CMake executable.

Once installed, new Command Prompts will recognize “cmake” and “cmake-gui” as valid commands.

12.4.4 Compile-time dependencies — Windows — Boost

The easiest way to install the Boost Thread library on Windows is to use the free installer from BoostPro™.
When running the installer:
e Under “Compilers,” check the version of Visual C++ matching your system.

» Under “Variants,” check all eight boxes.

S2http://www.openmicroscopy.org/community/

33 http://lists.openmicroscopy.org.uk/mailman/listinfo/
54http://maven.apache.org/

3Shttp://cmake.org/
36http://www.boostpro.com/download/
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* When choosing components, check “Boost DateTime” and “Boost Thread.”

12.4.5 Compile-time dependencies — Windows — Java Development Kit

Download and install the JDK?’.

After the installation is complete, create a new environment variable called JAVA_HOME pointing to your Java instal-
lation; e.g.:

C:\Program Files\Java\jdkl.6.0_25

Setting JAVA_HOME is the easiest way to ensure that Maven can locate Java.

You will also need to append your JDK’s client or server VM folder to the PATH; e.g.:
$JAVA_HOMES%\Jjre\bin\client

This step ensures that a directory containing jvm.dll is present in the PATH. If you do not perform this step, you will
receive a runtime error when attempting to initialize a JVM from native code.

Optionally, you can add the bin subdirectory to the PATH; e.g.:
$JAVA_HOME%\bin

Once set, new Command Prompts will recognize (e.g.) “javac” as a valid command.

12.4.6 Compile-time dependencies — Windows — Visual C++

In addition to the other prerequisites, you will also need a working copy of Visual C++. We have tested compilation
with Visual C++ 2005 Professional and Visual C++ 2008 Express; other versions may or may not work.

You can download Visual C++ Express for free’.

You must launch the environment at least once before you will be able to compile the Bio-Formats C++ bindings.

12.4.7 How to build - Windows

Run Command Prompt and change to your Bio-Formats working copy. Then run:

# generate the Bio-Formats C++ bindings
cd components\scifio
mvn -DskipTests package dependency:copy-dependencies cppwrap:wrap

# build the Bio-Formats C++ bindings
cd target\cppwrap

mkdir build

cd build

cmake-gui ..

The CMake GUI will open. Click the Configure button, and a dialog will appear. Select your installed version of
Visual Studio, and click Finish.

When configuring, you can use the J2L_ WIN_BUILD_DEBUG flag to indicate if this will be a Debug or Release
build. If the flag is checked it will build as Debug, unchecked will build as Release.

Once configuration is complete, click Configure again, repeating as necessary until the Generate button becomes
available. Then click Generate. Once generation is complete, close the CMake window.

SThttp://www.oracle.com/technetwork/java/javase/downloads/
38 http://www.microsoft.com/express/
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Back at the Command Prompt, type:
start jace.sln

The solution will then open in Visual Studio. Select Release or Debug as appropriate from the drop-down menu. Press
F7 to compile (or select Build Solution from the Build menu).

12.5 Building C++ bindings in Mac OS X

12.5.1 Compile-time dependencies — Mac OS X

To install dependencies on Mac OS X, we advise using Homebrew?”:

brew install maven cmake boost

Unless otherwise configured, this will install binaries into /ust/local/.

12.5.2 How to build — Mac OS X

The following commands will generate and build the Bio-Formats C++ bindings:

# generate the C++ bindings
cd components/scifio
mvn -DskipTests package dependency:copy-dependencies cppwrap:wrap

# compile the C++ bindings
cd target/cppwrap

mkdir build

cd build

cmake ..

make

12.6 Building C++ bindings in Linux

12.6.1 Compile-time dependencies — Linux

The following directions are specific to Ubuntu Linux. Other Linux distributions may have similar packages available;
check your package manager.

To install dependencies on Ubuntu Linux, execute:

# install code generation prerequisites
sudo aptitude install maven2

# install build prerequisites
sudo aptitude install build-essential cmake libboost-thread-dev

# install Java Development Kit
sudo aptitude install sun-java6-jdk
sudo update—alternatives —--config java

http://mxcl.github.com/homebrew/
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Then select Sun’s Java implementation as the system default.

It may be possible to use a different Java compiler (i.e., omit the sun-java6-jdk package and update-alternatives step),
but we have only tested the compilation process with Sun’s Java compiler.

12.6.2 How to build - Linux

The following commands will generate and build the Bio-Formats C++ bindings:

# generate the Bio-Formats C++ bindings
cd components/scifio
mvn -DskipTests package dependency:copy-dependencies cppwrap:wrap

# build the Bio-Formats C++ bindings
cd target/cppwrap

mkdir build

cd build

cmake

make
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THIRTEEN

SCIFIO

SCIFIO provides the core architecture of the Bio-Formats library and also includes reader and writer implementations
for open file formats. The more permissive BSD license enables non-GPL third party software to read and write
OME-TIFF using SCIFIO alone.

13.1 SCientific Imaging Formats Input and Output

13.1.1 Motivation

SCIFIO is a refactoring of Bio-Formats. Classic Bio-Formats uses OME-XML! to model the metadata for a given
image, standardizing all supported formats to this schema. This tight integration, along with the naming itself of Bio-
Formats, discourages potential users from outside the life sciences (if their imaging requirements include metadata
outside the OME-XML specification). Furthermore, the steps of processing image formats are obfuscated by their
consolidation into a single Reader class; this increases the entry barrier for 3rd party developers to add support for
additional formats. Finally, the GPL licensing of Bio-Formats precludes its inclusion in non-GPL software packages
such as Image]J, ITK, VCell and VisAD.

SCIFIO aims to resolve these issues by reversing the OME-XML dependency and teasing apart the stages of image
format conversion and processing. SCIFIO will define the core components of flexible image format support. OME-
XML will become one type of metadata, which Bio-Formats will still use to standardize the metadata of a wide variety
of image formats. Thus Bio-Formats will become an extension to SCIFIO, but the underlying structure will allow any
number of such extensions to coexist. Dynamic discovery mechanisms will allow these modules to be used as needed,
as long as the underlying program incorporates the SCIFIO core. Further, the SCIFIO core will include support only
for the open source formats currently supported by Bio-Formats, allowing distribution under the BSD license (though
individual modules can fall under any licensing framework, and Bio-Formats will continue to have a dual GPL +
commercial license).

For further information, see the SCIFIOGrant.pdf”.

13.1.2 Components

Metadata

Metadata is the currency of SCIFIO. Practically every component will either create a Metadata object, take one as
input, or both. It is the tangible representation of how a particular format structures its image metadata. One immediate
improvement in this representation of the metadata is the opportunity for a dramatic speedup in performance: by
serializing and writing a Metadata object to disk, we can eliminate the need to parse an image more than once. Come

Uhttp://www.openmicroscopy.org/site/support/ome-model/ome-xml
Zhttp://loci.wisc.edu/files/loci/software/SCIFIOGrant.pdf
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back after a week or a month to reanalyze a dataset and one of the most significant performance bottlenecks in Bio-
Formats will be gone.

Checker

The Checker series of classes will encapsulate the functionality represented in the current Bio-Formats Reader classes
by the isThisType method. A Checker for a given image format takes as input a file name and tests whether or not it
is recognized, and thus supported, returning the result of the test. This separation lightens the process of finding an
appropriate Parser for the image and helps to elucidate the flow of image I/O.

Parser

The first step of actually interacting with an image file will be determining its metadata. A Parser must be created for
each supported image format. If its corresponding Checker indicates the current image file matches a Parser’s type, the
Parser examines the image’s header and returns a Metadata object with information specific to its type. This Metadata
object can then be passed to a Translator for continued analysis, written to disk for future use, and/or passed directly
to a Reader.

Translator
Once the Metadata is isolated, a Translator can be used to convert the original Metadata format to a new format. Each
Translator encodes a 1:1 conversion between formats of Metadata objects. In general, the goal of each Translator is to

convert from a specific Metadata format to something more general, allowing format-agnostic components to accept
the Metadata object even if it originated from a PFF image.

Reader

A Reader takes in an appropriate format-specific Metadata object and uses it to interpret the raw pixels of the original
image. The final output is a set of byte arrays, which can be interpreted by a Writer and/or the parent software.

Writer
Writers will likely be very similar to their current form in Bio-Formats. Each Writer will take a Metadata object (often,

but not necessarily, format-agnostic) and byte array as input, and write to a random access output stream (e.g. a file on
disk).

13.1.3 Additional Improvements
LOCI Common
With a tighter integration of the random access streams from the loci.common library, it made sense to migrate these

parts to SCIFIO. As this removed some significant functionality from loci.common, the entire library was incorporated
into sub-packages of SCIFIO.

Multi-dimensionality

As classic Bio-Formats was bound to the OME-XML schema, any image processed by Bio-Formats was forced to a
five-dimensional format. However, there is nothing inherently tied to dimensionality in SCIFIO. Thus, SCIFIO will
support full N-dimensionality in data and leave any restrictions to the dictation of individual modules.
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WRITING NEW BIO-FORMATS FILE FORMAT READERS

14.1 Bio-Formats file format reader guide

This document is a brief guide to writing new Bio-Formats file format readers.

All format readers should extend either loci.formats. FormatReader' or a reader in loci.formats.in?.

14.1.1 Methods to override

* boolean isSingleFile(String id)* Whether or not the named file is expected to be the only file in the dataset. This
only needs to be overridden for formats whose datasets can contain more than one file.

* boolean isThisType(RandomAccessInputStream)* Check the first few bytes of a file to determine if the file can
be read by this reader. You can assume that index O in the stream corresponds to the index 0 in the file. Return
true if the file can be read; false if not (or if there is no way of checking).

« int fileGroupOption(String id)’ Returns an indication of whether or not the files in a multi-file dataset can be
handled individually. The return value should be one of the following:

— FormatTools.MUST_GROUP: the files cannot be handled separately
— FormatTools.CAN_GROUP: the files may be handled separately or as a single unit
— FormatTools.CANNOT_GROUP: the files must be handled separately
This method only needs to be overridden for formats whose datasets can contain more than one file.

» String|[] getSeriesUsedFiles(boolean noPixels)® You only need to override this if your format uses multiple files
in a single dataset. This method should return a list of all files associated with the given file name and the current
series (i.e. every file needed to display the current series). If the noPixels flag is set, then none of the files
returned should contain pixel data. For an example of how this works, see loci.formats.in.PerkinElmerReader’.
It is recommended that the first line of this method be FormatTools.assertId (currentId, true,
1) - this ensures that the file name is non-null.

* byte[] openBytes(int, byte[], int, int, int, int)® Returns a byte array containing the pixel data for a subim-
age specified image from the given file. The dimensions of the subimage (upper left X coordinate, upper
left Y coordinate, width, and height) are specified in the final four int parameters. This should throw a

Thttps://github.com/openmicroscopy/bioformats/blob/develop/components/scifio/src/loci/formats/FormatReader.java
Zhttps://github.com/openmicroscopy/bioformats/blob/develop/components/bio-formats/src/loci/formats/in/
3http://hudson.openmicroscopy.org.uk/job/BIOFORMATS-stable/javadoc/loci/formats/IFormatReader.html#isSingleFile(java.lang. String)
“4http://hudson.openmicroscopy.org.uk/job/BIOFORMATS-stable/javadoc/loci/formats/IFormatReader.html#is This Type(loci.common.RandomAccessInputStream)
Shttp://hudson.openmicroscopy.org.uk/job/BIOFORMATS-stable/javadoc/loci/formats/IFormatReader.html#fileGroupOption(java.lang.String)
Shttp://hudson.openmicroscopy.org.uk/job/BIOFORMATS-stable/javadoc/loci/formats/TFormatReader.html#getSeriesUsedFiles(boolean)
7https://github.com/openmicroscopy/bioformats/blob/develop/components/bio-formats/src/loci/formats/in/PerkinElmerReader.java
8http://hudson.openmicroscopy.org.uk/job/BIOFORMATS-stable/javadoc/loci/formats/IFormatReader.html#openBytes(int, byte[], int, int, int,

int)
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FormatException if the image number is invalid (less than O or >= the number of images). The order-
ing of the array returned by openBytes should correspond to the values returned by isLittleEndian ()
and isInterleaved (). Also, the length of the byte array should be [image width * image height *
bytes per pixel]. Extra bytes will generally be truncated. It is recommended that the first line of this method
be FormatTools.checkPlaneParameters (this, no, buf.length, x, vy, w, h) -thisen-
sures that all of the parameters are valid.

* protected void initFile(String)’ The majority of the file parsing logic should be placed in this method. The idea
is to call this method once (and only once!) when the file is first opened. Generally, you will want to start by
calling super.initFile (String). You will also need to set up the stream for reading the file, as well
as initializing any dimension information and metadata. Most of this logic is up to you; however, you should
populate the ‘core’ variable (see loci.formats.CoreMetadata'”).

Note that each variable is initialized to O or null when super.initFile (String) is called. Also,
super.initFile (String) constructs a Hashtable called “metadata” where you should store any relevant
metadata.

+ public void close(boolean fileOnly)'! Cleans up any resources used by the reader. Global variables should be
reset to their initial state, and any open files or delegate readers should be closed.

Note that if the new format is a variant of a format currently supported by Bio-Formats, it is more efficient to make
the new reader a subclass of the existing reader (rather than subclassing FormatReader'?). In this case, it is usually
sufficient to override initFile (String) and isThisType (byte[]).

Every reader also has an instance of loci.formats.CoreMetadata'®. All readers should populate the fields in CoreMeta-
data, which are essential to reading image planes.

If you read from a file using something other than RandomAccessInputStream'* or Location', you must use the file
name returned by Location.getMappedId (String), not the file name passed to the reader. Thus, a stub for
initFile (String) might look like this:

protected void initFile(String id) throws FormatException, IOException ({
super.initFile (id);

RandomAccessInputStream in = new RandomAccessInputStream(id);
// alternatively,
//FileInputStream in = new FileInputStream(Location.getMappedId(id));

// read basic file structure and metadata from stream

For more details, see the Bio-Formats Javadocs'®

tion.getMappedId(String).

for Location.mapld(String, String) and Loca-

14.1.2 Variables to populate

There are a number of global variables defined in loci.formats.FormatReader'” that should be populated in the con-
structor of any implemented reader.

These variables are:

9http://hudson.openmicroscopy.org.uk/job/BIOFORMATS-stable/javadoc/loci/formats/FormatReader.html#initFile(java.lang.String)
10https://github.com/openmicroscopy/bioformats/blob/develop/components/scifio/src/loci/formats/CoreMetadata.java
http://hudson.openmicroscopy.org.uk/job/BIOFORMATS-stable/javadoc/loci/formats/IFormatReader.html#close(boolean)
Zhttps://github.com/openmicroscopy/bioformats/blob/develop/components/scifio/src/loci/formats/FormatReader.java
Bhttps://github.com/openmicroscopy/bioformats/blob/develop/components/scifio/src/loci/formats/CoreMetadata.java
14https://github.com/openmicroscopy/bioformats/blob/develop/components/common/src/loci/common/RandomAccessInputStream.java
Shttps://github.com/openmicroscopy/bioformats/blob/develop/components/common/src/loci/common/Location.java
16http://hudson.openmicroscopy.org.uk/job/BIOFORMATS-stable/javadoc/
Thttps://github.com/openmicroscopy/bioformats/blob/develop/components/scifio/src/loci/formats/FormatReader.java
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boolean suffixNecessary Indicates whether or not a file name suffix is required; true by default

boolean suffixSufficient Indicates whether or not a specific file name suffix guarantees that this
reader can open a particular file; true by default

boolean hasCompanionFiles Indicates whether or not there is at least one file in a dataset of this format
that contains only metadata (no images); false by default

String datasetDescription A brief description of the layout of files in datasets of this format; only
necessary for multi-file datasets

String[] domains An array of imaging domains for which this format is used. Domains are defined in
loci.formats.FormatTools'S.

14.1.3 Other useful things

loci.common.RandomAccessInputStream' is a hybrid RandomAccessFile/InputStream class that is generally

more efficient than either RandomAccessFile or InputStream, and implements the Datalnput interface. It is
recommended that you use this for reading files.

loci.formats.Location?” provides an API similar to java.io.File, and supports File-like operations on URLs. It is
highly recommended that you use this instead of File. See the Javadocs®! for additional information.

loci.common.DataTools?” provides a number of methods for converting bytes to shorts, ints, longs, etc. It also
supports reading most primitive types directly from a RandomAccessInputStream (or other Datalnput imple-
mentation).

loci.formats.ImageTools?® provides several methods for manipulating primitive type arrays that represent im-
ages. Consult the source or Javadocs for more information.

If your reader relies on third-party code which may not be available to all users, it is strongly suggested that

you make a corresponding service class that interfaces with the third-party code. Please see Bio-Formats service

and dependency infrastructure for a description of the service infrastructure, as well as the loci.formats.services
24

package™.

Several common image compression types are supported through subclasses of loci.formats.codec.BaseCodec™.
These include JPEG, LZW, LZO, Base64, ZIP and RLE (PackBits).

If you wish to convert a file’s metadata to OME-XML (strongly encouraged), please see Bio-Formats metadata
processing for further information.

Utility methods for reading and writing individual bits from a byte array can be found in
loci.formats.codec.BitBuffer?® and loci.formats.codec.BitWriter?’.

Once you have written your file format reader, add a line to the readers.txt*® file with the fully qualified name of
the reader, followed by a ‘#’ and the file extensions associated with the file format. Note that ImageReader®, the
master file format reader, tries to identify which format reader to use according to the order given in readers.txt*,
so be sure to place your reader in an appropriate position within the list.

8https://github.com/openmicroscopy/bioformats/blob/develop/components/scifio/src/loci/formats/FormatTools.java
19https://github.com/openmicroscopy/bioformats/blob/develop/components/common/src/loci/common/RandomAccessInputStream.java
20https://github.com/openmicroscopy/bioformats/blob/develop/components/common/src/loci/common/Location.java

21 http://hudson.openmicroscopy.org.uk/job/BIOFORMATS-stable/javadoc/
22https://github.com/openmicroscopy/bioformats/blob/develop/components/common/src/loci/common/DataTools.java

2 https://github.com/openmicroscopy/bioformats/blob/develop/components/scifio/src/loci/formats/ImageTools. java
24https://github.com/openmicroscopy/bioformats/blob/develop/components/bio-formats/src/loci/formats/services/
ZShttps://github.com/openmicroscopy/bioformats/blob/develop/components/scifio/src/loci/formats/codec/BaseCodec java
26https://github.com/openmicroscopy/bioformats/blob/develop/components/scifio/src/loci/formats/codec/BitBuffer.java
2Thttps://github.com/openmicroscopy/bioformats/blob/develop/components/scifio/src/loci/formats/codec/BitWriter.java

2 https://github.com/openmicroscopy/bioformats/blob/develop/components/scifio/src/loci/formats/readers.txt
2https://github.com/openmicroscopy/bioformats/blob/develop/components/scifio/src/loci/formats/ImageReader.java
30https://github.com/openmicroscopy/bioformats/blob/develop/components/scifio/src/loci/formats/readers. txt
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* The easiest way to test your new reader is by calling “java loci.formats.tools.Imagelnfo <file name>". If all goes
well, you should see all of the metadata and dimension information, along with a window showing the images
in the file. ImagcReader31 can take additional parameters; a brief listing is provided below for reference, but it
is recommended that you take a look at the contents of loci.formats.tools. Imagelnfo” to see exactly what each

one does.
Argument | Action
-version print the library version and exit
file the image file to read
-nopix read metadata only, not pixels
-nocore do not output core metadata
-nometa do not parse format-specific metadata table
-nofilter do not filter metadata fields
-thumbs read thumbnails instead of normal pixels
-minmax compute min/max statistics
-merge combine separate channels into RGB image
-nogroup force multi-file datasets to be read as individual files
-stitch stitch files with similar names
-separate split RGB image into separate channels
-expand expand indexed color to RGB
-omexml populate OME-XML metadata
-normalize normalize floating point images*
-fast paint RGB images as quickly as possible*
-debug turn on debugging output
-range specify range of planes to read (inclusive)
-series specify which image series to read
-swap override the default input dimension order
-shuffle override the default output dimension order
-map specify file on disk to which name should be mapped
-preload pre-read entire file into a buffer; significantly reduces the time required to read the images, but
requires more memory
-crop crop images before displaying; argument is ‘x,y,w,h’
-autoscale used in combination with ‘-fast’ to automatically adjust brightness and contrast
-novalid do not perform validation of OME-XML
-omexml- only output the generated OME-XML
only
-format read file with a particular reader (e.g., ZeissZVI)

e =may result in loss of precision

* If you wish to test using TestNG, loci.tests.testng. FormatReaderTest* provides several basic tests that work
with all Bio-Formats readers. See the FormatReaderTest source code for additional information.

+ For more details, please look at the source code and Javadocs*. Studying existing readers is probably the best
way to get a feel for the API; we would recommend first looking at loci.formats.in.ImarisReader® (this is the
most straightforward one). loci.formats.in.LIFReader*® and InCellReader®’ are also good references that show
off some of the nicer features of Bio-Formats.

If you have questions about Bio-Formats, please contact the OME team?®.

8

31https://github.com/openmicroscopy/bioformats/blob/develop/components/scifio/src/loci/formats/ImageReader.java

3 https://github.com/openmicroscopy/bioformats/blob/develop/components/scifio-tools/src/loci/formats/tools/Imagelnfo. java

3 https://github.com/openmicroscopy/bioformats/blob/develop/components/test-suite/src/loci/tests/testng/FormatReaderTest java
34http://hudson.openmicroscopy.org.uk/job/BIOFORMATS-stable/javadoc/
35https://github.com/openmicroscopy/bioformats/blob/develop/components/bio-formats/src/loci/formats/in/ImarisReader java
36https://github.com/openmicroscopy/bioformats/blob/develop/components/bio-formats/src/loci/formats/in/LIFReader.java
3Thttps://github.com/openmicroscopy/bioformats/blob/develop/components/bio-formats/src/loci/formats/in/InCellReader.java

3 http://www.openmicroscopy.org/site/community

14.1. Bio-Formats file format reader guide

90


https://github.com/openmicroscopy/bioformats/blob/develop/components/scifio/src/loci/formats/ImageReader.java
https://github.com/openmicroscopy/bioformats/blob/develop/components/scifio-tools/src/loci/formats/tools/ImageInfo.java
https://github.com/openmicroscopy/bioformats/blob/develop/components/test-suite/src/loci/tests/testng/FormatReaderTest.java
http://hudson.openmicroscopy.org.uk/job/BIOFORMATS-stable/javadoc/
https://github.com/openmicroscopy/bioformats/blob/develop/components/bio-formats/src/loci/formats/in/ImarisReader.java
https://github.com/openmicroscopy/bioformats/blob/develop/components/bio-formats/src/loci/formats/in/LIFReader.java
https://github.com/openmicroscopy/bioformats/blob/develop/components/bio-formats/src/loci/formats/in/InCellReader.java
http://www.openmicroscopy.org/site/community

CHAPTER
FIFTEEN

CONTRIBUTING TO BIO-FORMATS

15.1 Developing Bio-Formats

If you are interested in working on the Bio-Formats source code itself, you can load it into your favorite IDE, or
develop with your favorite text editor.

The Bio-Formats code is divided into several projects. Core components are located in subfolders of the components'
folder, with some components further classified into components/forks”, components/legacy®, components/native* or
components/stubs’, depending on the nature of the project.

Each project has a corresponding Maven POM file, which can be used to work with the project in your favorite IDE,
or from the command line, once you have cloned the source. Instructions for several popular options follow.

15.1.1 NetBeans

NetBeans comes with Maven support built in. To import the Bio-Formats source, perform the following steps:
1. Choose File > Open Project from the menu
2. Select the top-level folder of your Bio-Formats working copy
3. Expand the Modules folder and double-click desired project(s) to work with them

Alternately, you can clone the source directly from NetBeans into a project by selecting “Team > Git > Clone Other...”
from the menu.

15.1.2 Eclipse

Eclipse uses the M2E plugin to work with Maven projects. It is more flexible than Eclipse’s built-in project manage-
ment because M2E transparently converts between project dependencies and JAR dependencies (stored in the Maven
repository in ~/.m2/repository) on the build path, depending which projects are currently open.

To import the Bio-Formats source into Eclipse 3.7 (Indigo), you must first install the M2E plugin:
1. From the Eclipse menu, choose Help > Install New Software...
2. In the “Work with:” dropdown, choose “~All Available Sites—*
3. In the filter box, type “m2e”

Uhttps://github.com/openmicroscopy/bioformats/blob/develop/components/
Zhttps://github.com/openmicroscopy/bioformats/blob/develop/components/forks/
3https://github.com/openmicroscopy/bioformats/blob/develop/components/legacy/
“https://github.com/openmicroscopy/bioformats/blob/develop/components/native/
Shttps://github.com/openmicroscopy/bioformats/blob/develop/components/stubs/
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4. Check the box next to “m2e - Maven Integration for Eclipse” under “Collaboration”
5. Click Next, then Finish

You can then import the Bio-Formats source by choosing “File > Import > Existing Maven Projects” from the menu
and browsing to the top-level folder of your Bio-Formats working copy.

15.1.3 Command line

If you prefer developing code with a text editor such as vim or emacs, you can use the Ant or Maven command line
tools to compile Bio-Formats. The Bio-Formats source tree provides parallel build systems for both Ant and Maven,
so you can use either one to build the code.

For a list of Ant targets, run:
ant -p

When using Maven, Bio-Formats is configured to run the “install” target by default, so all JARs will be copied into
your local Maven repository in ~/.m2/repository. Simply run:

mvn

With either Ant or Maven, you can use similar commands in any subproject folder to build just that component.

15.2 Testing individual commits (internal developers)

At the bottom of many commit messages in https://github.com/openmicroscopy/bioformats, you will find a few lines
similar to this:

To test, please run:
ant -Dtestng.directory=$DATA/metamorph test-automated

This shows the command(s) necessary to run automated tests against the files likely to be affected by that commit. If
you want to run these tests, you will need to do the following:

Clone bioformats.git and checkout the appropriate branch (by following the directions on the Git usage® page). Run
this command to build all of the JAR files:

$ ant clean Jjars

Switch to the test-suite component:

$ cd components/test-suite

Run the tests, where $DATA is the path to the full data repository:
$ ant -Dtestng.directory=$DATA/metamorph test-automated

3

By default, 512 MB of memory are allocated to the JVM. You can increase this by adding the ‘-
Dtestng.memory=XXXm’ option. You should now see output similar to this:

Buildfile: build.xml

init-title:
[echo] —-—————————=========== loci-testing-framework ===========—---—————-

Shttp://www.openmicroscopy.org/site/support/omero4/developers/using-git.html
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init-timestamp:
init-version:
init-manifest-cp:
init:
copy-source:
compile:

test—-automated:
[testng] [Parser] Running:

[testng] LOCI software test suite

[testng]

[testng] Scanning for files...

[testng] Building list of tests...

[testng] Ready to test 490 files

o= o L

and then eventually:

[testng]

[testng] LOCI software test suite

[testng] Total tests run: 19110, Failures: 0, Skips: O
[testng]

[testng]

BUILD SUCCESSFUL
Total time: 16 minutes 42 seconds

Each of the dots represents a single passed test; a ‘-‘ is a skipped test, and an ‘F’ is a failed test. This is mostly just
for your amusement if you happen to be staring at the console while the tests run, as a more detailed report is logged
to loci-software-test-$DATE.log (where “$DATE” is the date on which the tests started in “yyyy-MM-dd_hh-mm-ss”
format).

If Ant reports that the build was successful, then there is nothing that you need to do. Otherwise, it is helpful if you
can provide the command, branch name, number of failures at the bottom of the Ant output, and the loci-software-
test-*.1og file.

15.3 Public test data

Most of the data-driven tests would benefit from having a comprehensive set of public sample data (see also #40867).
Formats for which we already have public sample data:
A “*’ indicates that we could generate more public data in this format.

* ICS (%)

* Leica LEI

« IPLab

* BMP (¥)

http://trac.openmicroscopy.org.uk/ome/ticket/4086
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* Image-Pro SEQ

¢ QuickTime (*)

 Bio-Rad PIC

* Image-Pro Workspace

* Fluoview/ABD TIFF (*)

* Perkin Elmer Ultraview

* Gatan DM3

» Zeiss LSM

* Openlab LIFF (*)

¢ Leica LIF (*)

 TIFF (¥)

» Khoros (http://netghost.narod.ru/gff/sample/images/viff/index.htm)

* MNG (Download®) (¥)
Formats for which we can definitely generate public sample data:

* PNG/APNG

* JPEG

* PGM

e FITS

* PCX

* GIF

* Openlab Raw

* OME-XML

¢ OME-TIFF

e AVI

e PICT

« LIM

* PSD

* Targa

* Bio-Rad Gel

 Fake

¢ ECAT-7 (minctoecat)

* NRRD

* JPEG-2000

* Micromanager

o Text

8http://sourceforge.net/projects/libmng/files/libmng-testsuites/Release-20030305/MNGsuite-20030305.zip/download ?use_mirror=freefr&download=
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DICOM

MINC (rawtominc)
NIfTT (dicomnifti)
Analyze 7.5 (medcon)
SDT

FV1000 .oib/.o0if
Zeiss ZV1

Leica TCS

Aperio SVS

Imaris (raw)

Formats for which I need to check whether or not we can generate public sample data:

IPLab Mac (Ivision)
Deltavision
MRC

Gatan DM2
Imaris (HDF)
EPS

Alicona AL3D
Visitech

InCell

L2D

FEI

NAF

MRW

ARF

LI-FLIM
Oxford Instruments
VG-SAM
Hamamatsu HIS
WA-TOP

Seiko
TopoMetrix
UBM

Quesant

RHK

Molecular Imaging

15.3.
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JEOL

Amira

Unisoku

Perkin Elmer Densitometer
Nikon ND2
SimplePCI .cxd

Imaris (TIFF)
Molecular Devices Gel
Imacon .fff

LEO

JPK

Nikon NEF

Nikon TIFF

Prairie

Metamorph TIFF/STK/ND
Improvision TIFF
Photoshop TIFF

FEI TIFF

SimplePCI TIFF
Burleigh

SM-Camera

SBIG

Formats for which we definitely cannot generate public sample data:

TillVision

Olympus CellR/APL
Slidebook
Cellomics
CellWorX

Olympus ScanR

BD Pathway

Opera Flex

MIAS

15.3.
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15.4 Bio-Formats service and dependency infrastructure

15.4.1 Description

The Bio-Formats service infrastructure is an interface driven pattern for dealing with external and internal dependen-
cies. The design goal was mainly to avoid the cumbersome usage of ReflectedUniverse where possible and to
clearly define both service dependency and interface between components. This is generally referred to as dependency
injection’, dependency inversion'? or component based design'.

It was decided, at this point, to forgo the usage of potentially more powerful but also more complicated solutions such
as:

e Spring (http://www.springsource.org/)
* Guice (http://code.google.com/p/google-guice/)

The Wikipedia page for dependency injection'? contains many other implementations in many languages.

An added benefit is the potential code reuse possibilities as a result of decoupling of dependency and usage in Bio-
Formats readers. Implementations of the initial Bio-Formats services were completed as part of BioFormatsCleanup
and tickets #463' and #4644,

15.4.2 Writing a service
+ Interface — The basic form of a service is an interface which inherits from loci.common.services.Service'”.
Here is the very basic OMENotesService'® from the initial implementation in r5894:

public interface OMENotesService extends Service {

/ x %

* Creates a new OME Notes instance.

* @param filename Path to the file to create a Notes instance for.
x/

public void newNotes (String filename) ;

¢ Implementation — This service then has an implementation, which is usually located in the Bio-Formats com-
ponent or package which imports classes from an external, dynamic or other dependency. Again looking at the
OMENotesService, the implementation is this time in the legacy ome-notes component as OMENotesServi-
celmpl!’:
public class OMENotesServiceImpl extends AbstractService
implements OMENotesService {

/ x %

* Default constructor.

9http://en.wikipedia.org/wiki/Dependency_injection

10http://en.wikipedia.org/wiki/Dependency_inversion_principle

Uhttp://en.wikipedia.org/wiki/Component-based_software_engineering

Zhttp://en.wikipedia.org/wiki/Dependency_injection

Bhttp://trac.openmicroscopy.org.uk/ome/ticket/463

4http://trac.openmicroscopy.org.uk/ome/ticket/464
I5https://github.com/openmicroscopy/bioformats/blob/develop/components/common/src/loci/common/services/Service java
16https://github.com/openmicroscopy/bioformats/blob/develop/components/common/src/loci/common/services/OMENotesService java
Thttps://github.com/openmicroscopy/bioformats/blob/develop/components/legacy/ome-notes/src/loci/ome/notes/servicessOMENotesServiceImpl.java
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*/
public OMENotesServiceImpl () {
checkClassDependency (Notes.class) ;

/* (non—-Javadoc)
* @see loci.formats.dependency.OMENotesService#newNotes ()
*/

public void newNotes (String filename) {
new Notes (null, filename);

* Style

— Extension of AbstractService to enable uniform runtime dependency checking is recommended.
Java does not check class dependencies until classes are first instantiated so if you do not do this, you may
end up with ClassNotFound or the like exceptions being emitted from your service methods. This is
to be strongly discouraged. If a service has unresolvable classes on its CLASSPATH instantiation should
fail, not service method invocation.

— Service methods should not burden the implementer with numerous checked exceptions. Also external
dependency exception instances should not be allowed to directly leak from a service interface. Please
wrap these using a ServiceException.

— By convention both the interface and implementation are expected to be in a package named
loci.*.services. Thisis not a hard requirement but should be followed where possible.

* Registration — A service’s interface and implementation must finally be registered with the
loci.common.services.ServiceFactory'® via the services.properties'® file. Following the OMENotesService
again, here is an example registration:

# OME notes service (implementation in legacy ome-notes component)
loci.common.services.OMENotesService=loci.ome.notes.services.OMENotesServiceImpl

15.4.3 Using a service

OMENotesService service = null;

try |
ServiceFactory factory = new ServiceFactory();
service = factory.getInstance (OMENotesService.class);

}

catch (DependencyException de) {
LOGGER.info ("", de);

See open Trac tickets for Bio-Formats®” for information on work currently planned or in progress.

18https://github.com/openmicroscopy/bioformats/blob/develop/components/common/src/loci/common/services/ServiceFactory.java
9https://github.com/openmicroscopy/bioformats/blob/develop/components/common/src/loci/common/services/Service java
2https://trac.openmicroscopy.org.uk/ome/report/44
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Bio-Formats supports over 120 different file formats. The Dataset Structure Table explains the file extension you
should choose to open/import a dataset in any of these formats, while the Supported Formats table lists all of the
formats and gives an indication of how well they are supported and whether Bio-Formats can write, as well as read,
each format. The Summary of supported metadata fields table shows an overview of the OME data model fields
populated for each format.

We are always looking for examples of files to help us provide better support for different formats. If you would
like to help, you can upload files using our QA system uploader?!. If you have any questions, or would prefer not to
use QA, please email the ome-users mailing list*>. If your format is already supported, please refer to the ‘we would
like to have’ section on the individual page for that format, to see if your dataset would be useful to us.

2l http://qa.openmicroscopy.org.uk/qa/upload/
22http://www.openmicroscopy.org/site/community/mailing-lists
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CHAPTER
SIXTEEN

DATASET STRUCTURE TABLE

This table shows the extension of the file that you should choose if you want to open/import a dataset in a particular
format.

Format name

File to choose

Structure of files

AIM .aim Single file
ARF .arf Single file
Adobe Photoshop .psd Single file
Adobe Photoshop TIFF if, tiff Single file
Alicona AL3D .al3d Single file
Amersham Biosciences | .gel Single file
GEL
Amira .am, .amiramesh, | Single file
.grey, .hx, Jabels
Analyze 7.5 .mg, .hdr One .img file and one similarly-named .hdr file
Andor SIF sif Single file
Animated PNG .png Single file
Aperio SVS .SVS Single file
Audio Video Interleave .avi Single file
BD Pathway .exp, .tif Multiple files (.exp, .dye, .1tp, ...) plus one or more direc-
tories containing .tif and .bmp files
Bio-Rad GEL dsc Single file
Bio-Rad PIC .pic, .xml, .raw One or more .pic files and an optional Ise.xml file
Bitplane Imaris .ims Single file
Bitplane Imaris 3 (TIFF) .ms Single file
Bitplane Imaris 5.5 (HDF) ims Single file

Bruker

(no extension)

One ‘fid’ and one ‘acqp’ plus several other metadata files
and a ‘pdata’ directory

Burleigh .img Single file
Canon RAW .cr2, .crw, .jpg, .thm, | Single file
.wav

CellSens VSI .vsi, .ets One .vsi file and an optional directory with a similar name
that contains at least one subdirectory with .ets files

CellWorx .pnl, .htd, .log One .htd file plus one or more .pnl or .tif files and option-
ally one or more .log files

Cellomics CO1 .c01, .dib One or more .c01 files

Compix Simple-PCI .cxd Single file

DICOM dic, .dcm, .dicom, | One or more .dcm or .dicom files

Jp2, .j2ki, .j2kr, .raw,
.ima

Continued on next page
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Table 16.1 — continued from previous page

Format name

File to choose

Structure of files

DNG .cr2, .crw, .jpg, -thm, | Single file
.wav, .tif, .tiff

Deltavision .dv, .r3d, .r3d_d3d, | One .dv, .r3d, or .d3d file and up to two optional .log files
.dv.log, .r3d.log

ECAT7 v Single file

Encapsulated PostScript .eps, .epsi, .ps Single file

Evotec Flex

flex, .mea, .res

the flex file(s).

One directory containing one or more .flex files, and an
optional directory containing an .mea and .res file. The
.mea and .res files may also be in the same directory as

FEI TIFF f, tiff Single file

FEI/Philips .img Single file

Flexible Image Transport | fits, .fts Single file

System

Fuji LAS 3000 .img, .inf Single file

Gatan DM2 .dm2 Single file

Gatan Digital Micrograph .dm3 Single file

Graphics Interchange For- | .gif Single file

mat

Hamamatsu Aquacosmos .naf Single file

Hamamatsu HIS .his Single file

Hamamatsu NDPI .ndpi Single file

Hamamatsu NDPIS .ndpis One .ndpis file and at least one .ndpi file

Hamamatsu VMS .vms One .vms file plus several .jpg files

Hitachi Jtxt One .txt file plus one similarly-named .tif, .bmp, or .jpg
file

IMAGIC .hed, .img One .hed file plus one similarly-named .img file

IMOD .mod Single file

INR .inr Single file

IPLab .ipl Single file

IVision .ipm Single file

Imacon Riii Single file

Image Cytometry Standard Jcs, .ids One .ics and possibly one .ids with a similar name

Image-Pro Sequence .seq Single file

Image-Pro Workspace ipw Single file

Improvision TIFF tif, tiff Single file

InCell 1000/2000 xdce, .xml, .tiff, .tif, | One .xdce file with at least one .tif/.tiff or .im file

xlog

InCell 3000 frm Single file

JEOL .dat, .img, .par A single .dat file or an .img file with a similarly-named
.par file

JPEG .jpg, .jpeg, .jpe Single file

JPEG-2000 Jp2, j2k, .jpf Single file

JPK Instruments Jjpk Single file

JPX Jpx Single file

Khoros XV XV Single file

Kodak Molecular Imaging .bip Single file

LEO .sxm, .tif, .tiff Single file

LI-FLIM Ai Single file

Continued on next page
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Table 16.1 — continued from previous page

Format name

File to choose

Structure of files

Laboratory Imaging

Jim

Single file

Leica Jei, .tif, .tiff, .raw One .lei file with at least one .tif/.tiff file and an optional
.txt file

Leica Image File Format Jdif Single file

Leica SCN .scn Single file

Leica TCS TIFF if, tiff, .xml Single file

Li-Cor L2D J12d, .scn, .tif One .12d file with one or more directories containing
tif/ tiff files

MIAS f, Ltiff, .txt One directory per plate containing one directory per well,
each with one or more .tif/.tiff files

MINC MRI .mnc Single file

Medical Research Council .mrc, .st, .ali, .map, | Single file

IecC

Metamorph STK

.stk, .nd, .tif, .tiff

One or more .stk or .tif/.tiff files plus an optional .nd file

Metamorph TIFF Atif, tiff One or more .tif/.tiff files

Micro-Manager Aif, tiff, Ltxt, .xml A ‘metadata.txt’ file plus or or more .tif files
Minolta MRW .mrw Single file

Molecular Imaging .stp Single file

Multiple Network Graphics | .mng Single file

NIfTI

.nii, .img, .hdr

A single .nii file or one .img file and a similarly-named
.hdr file

NOAA-HRD Gridded Data
Format

(no extension)

Single file

NRRD .nrrd, .nhdr A single .nrrd file or one .nhdr file and one other file con-
taining the pixels

Nikon Elements TIFF tif, tiff Single file

Nikon ND2 .nd2 Single file

Nikon NEF .nef, tif, .tiff Single file

Nikon TIFF Aif, Ltiff Single file

OME-TIFF .ome.tif, .ome.tiff One or more .ome.tiff files

OME-XML .ome Single file

Olympus APL .apl, .tnb, .mtb, .tif One .apl file, one .mtb file, one .tnb file, and a directory
containing one or more .tif files

Olympus FV1000 .oib, .oif, .pty, .lut Single .oib file or one .oif file and a similarly-named di-
rectory containing .tif/.tiff files

Olympus  Fluoview/ABD | tif, .tiff One or more .tif/.tiff files, and an optional .txt file

TIFF

Olympus SIS TIFF if, tiff Single file

Olympus ScanR .dat, .xml, .tif One .xml file, one ‘data’ directory containing .tif/.tiff
files, and optionally two .dat files

Olympus Slidebook .sld, .spl Single file

Openlab LIFF Jiff Single file

Openlab RAW raw Single file

Oxford Instruments .top Single file

PCX .pex Single file

PICT .pict, .pct Single file

POV-Ray .df3 Single file

Perkin Elmer Densitometer | .hdr, .img One .hdr file and a similarly-named .img file

Continued on next page

103




Bio-Formats Documentation, Release 4.4.8-DEV

Table 16.1 — continued from previous page

Format name

File to choose

Structure of files

PerkinElmer .ano, .cfg, .csv, .htm, | One .htm file, several other metadata files (.tim, .ano, .csv,
.rec, .tim, .zpo, .tif ...) and either .tif files or .2, .3, .4, etc. files

PerkinElmer Operetta f, tiff, .xml Directory with XML file and one .tif/.tiff file per plane
Portable Gray Map .pgm Single file

Prairie TIFF f, tiff, .cfg, .xml One .xml file, one .cfg file, and one or more .tif/.tiff files
Pyramid TIFF i, tiff Single file

Quesant AFM .afm Single file

QuickTime .mov Single file

RHK Technologies .sm2, .sm3 Single file

SBIG (no extension) Single file

SM Camera (no extension) Single file

SPCImage Data .sdt Single file

SPIDER .spi Single file

Seiko .xqd, .xqf Single file

SimplePCI TIFF if, tiff Single file

Simulated data fake Single file

Tagged Image File Format Aif, tiff, .tf2, .tf8, .btf | Single file

Text AXt, .csV Single file

TillVision .VWs, .pst, .inf One .vws file and possibly one similarly-named directory
TopoMetrix A, Afr, .zfr, .zfp, .2f1 | Single file
Trestle if One .tif file plus several other similarly-named files (e.g.
.FocalPlane-, .sld, .slx, .ROI)
Truevision Targa .tga Single file
UBM .pr3 Single file
Unisoku STM .hdr, .dat One .HDR file plus one similarly-named .DAT file
VG SAM .dti Single file
Varian FDF fdf Single file
Visitech XYS .Xys, .html One .html file plus one or more .xys files
Volocity Library .mvd2, .aisf, .aiix, | One .mvd?2 file plus a ‘Data’ directory
.dat, .atsf
Volocity Library Clipping .acff Single file
WA Technology TOP .wat Single file
Windows Bitmap .bmp Single file
Zeiss AxioVision TIFF tif, .xml Single file
Zeiss CZI .czi Single file
Zeiss Laser-Scanning Mi- | Ism, .mdb One or more .Ism files; if multiple .1sm files are present,
Croscopy an .mdb file should also be present
Zeiss Vision Image (ZVI) .Zvi Single file
Zip .Zip Single file

16.1 Flex Support

OMERO.importer supports importing analyzed Flex files from an Opera system.

Basic configuration is done via the importer.ini. Once the user has run the Importer once, this file will be in the
following location:

e C:\Documents and Settings\<username>\omero\importer.ini

The user will need to modify or add the [FlexReaderServerMaps] section of the INI file as follows:
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[FlexReaderServerMaps]
CIA-1 = \\\\hostnamel\\mount; \\\\archivehostl\\mount
CIA-2 = \\\\hostname2\\mount; \\\\archivehost2\\mount

where the key of the INI file line is the value of the “Host” tag in the .mea measurement XML file (here: <Host
name="CIA-1">) and the value is a semicolon-separated list of escaped UNC path names to the Opera workstations
where the Flex files reside.

Once this resolution has been encoded in the configuration file and you have restarted the importer, you will be able
to select the . mea measurement XML file from the Importer user interface as the import target.
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CHAPTER

SEVENTEEN

Ratings legend and definitions

SUPPORTED FORMATS

Format Extensions

3i SlideBook .sld

Andor  Bio-Imaging | .tif

Division (ABD)

TIFF

AIM .aim

Alicona 3D .al3d

Amersham Bio- | .gel

sciences Gel

Amira Mesh .am, .ami-
ramesh, .grey,
.hx, .labels

Analyze 7.5 .img, .hdr

Animated PNG .png

Aperio SVS TIFF .SVs

Applied  Precision | .htd, .pnl

CellWorX

AVI (Audio Video In- | .avi

terleave)

Axon Raw Format .arf

BD Pathway .exp, .tif

Becker &  Hickl | .sdt

SPClmage

Bio-Rad Gel dsc

Bio-Rad PIC .pic, .raw,
.xml

Bitplane Imaris .ims

Continued on next page
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Table 17.1 — continued from previous page

Format Extensions
Bruker MRI .ims

Burleigh .img

Canon DNG .Cr2, .crw
Cellomics .c01

cellSens VSI .vsi
DeltaVision .dv, .r3d
DICOM .dcm, .dicom
ECAT7 v

EPS (Encapsulated | .eps, .epsi, .ps
PostScript)

Evotec/PerkinElmer Aflex, .mea,
Opera Flex .res

FEI .img
FEITIFF tiff

FITS (Flexible Image | .fits
Transport System)

Gatan Digital Micro- | .dm3
graph

Gatan Digital Micro- | .dm2
graph 2

GIF (Graphics Inter- | .gif
change Format)

Hamamatsu  Aqua- | .naf

cosmos NAF

Hamamatsu HIS .his

Hamamatsu ndpi .ndpi

Hamamatsu VMS .vms

Hitachi S-4800 .txt, .tif, .bmp,
Jpg

ICS (Image Cytome- | .ics, .ids
try Standard)

Imacon Biid

ImagePro Sequence .seq

ImagePro Workspace | .ipw

IMAGIC .hed, .img

IMOD .mod

Continued on next page
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Table 17.1 — continued from previous page

Format Extensions

Improvision Openlab | liff

LIFF

Improvision Openlab | .raw

Raw

Improvision TIFF Aif

InCell 1000 xdce, .tif

InCell 3000 frm

INR .Anr

IPLab .ipl

IPLab-Mac .ipm

JEOL .dat, .img,
.par

JPEG Jpg

JPEG 2000 jp2

JPK Jjpk

JPX Jjpx

Khoros VIFF (Visu- | xXv

alization Image File

Format) Bitmap

Kodak BIP .bip

Lambert Instruments | fli

FLIM

Leica LCS LEI Jei, .tif

Leica LAS AF LIF | lif

(Leica Image File

Format)

Leica SCN .scn

LEO .SXm

Li-Cor L2D 124, .tif, .scn

LIM (Laboratory | .lim

Imaging/Nikon)

MetaMorph 7.5 | .tiff

TIFF

MetaMorph Stack | .stk, .nd

(STK)

MIAS (Maia Scien- | .tif

tific)

Continued on next page
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Table 17.1 — continued from previous page

Format Extensions

Micro-Manager Aif, Ltxt, .xml

MINC MRI .mnc

Minolta MRW .mrw

MNG (Multiple- | .mng

image Network

Graphics)

Molecular Imaging .Stp

MRC (Medical Re- | .mrc

search Council)

NEF (Nikon Elec- | .nef, .tif

tronic Format)

NIfTI .img, .hdr

Nikon Elements | .tiff

TIFF

Nikon EZ-C1 TIFF tiff

Nikon NIS-Elements | .nd2

ND2

NRRD (Nearly Raw | .nrrd, .nhdr,

Raster Data) .raw, .txt

Olympus CellR/APL | .apl, .mtb,
.tnb, tif,
.obsep

Olympus  FluoView | .oib, .0if

FV1000

Olympus  FluoView | .tif

TIFF

Olympus ScanR xml, .dat, .tif

Olympus SIS TIFF tff

OME-TIFF .ome.tiff

OME-XML .ome

Oxford Instruments .top

PCX (PC  Paint- | .pcx

brush)

Perkin Elmer Densit- | .pds

ometer

PerkinElmer Op- | tiff, xml

eretta

Continued on next page
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Table 17.1 — continued from previous page

Format Extensions

PerkinElmer Ultra- | tif, .2, .3, .4

View

PGM (Portable Gray | .pgm

Map)

Adobe  Photoshop | .psd

PSD

Photoshop TIFF if, Ltiff

PICT  (Macintosh | .pict

Picture)

PNG (Portable Net- | .png

work Graphics)

Prairie Technologies | .tif, xml, .cfg

TIFF

Quesant .afm

QuickTime Movie .mov

RHK .sm2, .sm3

SBIG .sm2, .sm3

Seiko .xqd, .xqf

SimplePCI & HCIm- | .cxd

age

SimplePCI & HCIm- | .tiff

age TIFF

SM Camera tff

SPIDER .spi, .stk

Targa .tga

Text .xt

TIFF (Tagged Image | .tif

File Format)

TillPhotonics TillVi- | .vws

sion

Topometrix Afr, ffr, .zfr,
.zfp, .21l

Trestle Aif, .sld, .jpg

UBM .pr3

Unisoku .dat, .hdr

Varian FDF fdf

Continued on next page
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Table 17.1 — continued from previous page

Format Extensions
VG SAM .dti
VisiTech XYS .Xys, .html
Volocity .mvd2
Volocity Library | .acff
Clipping

WA-TOP .wat
Windows Bitmap .bmp
Zeiss AxioVision | .xml, .tiff
TIFF

Zeiss AxioVision ZVI | .zvi

(Zeiss Vision Image)

Zeiss CZI .CZi

Zeiss LSM  (Laser | .sm, .mdb
Scanning Micro-

scope) 510/710

Bio-Formats currently supports 127 formats

Outstanding

Very good
Good

Fair

Ratings legend and definitions

Poor

Pixels Our estimation of Bio-Formats’ ability to reliably extract complete and accurate pixel values from files in that
format. The better this score, the more confident we are that Bio-Formats will successfully read your file without
displaying an error message or displaying an erroneous image.

Metadata Our certainty in the thoroughness and correctness of Bio-Formats’ metadata extraction and conversion
from files of that format into standard OME-XML. The better this score, the more confident we are that all
meaningful metadata will be parsed and populated as OME-XML.

Openness This is not a direct expression of Bio-Formats’ performance, but rather indicates the level of cooperation
the format’s controlling interest has demonstrated toward the scientific community with respect to the format.
The better this score, the more tools (specification documents, source code, sample files, etc.) have been made
available.

Presence This is also not directly related to Bio-Formats, but instead represents our understanding of the format’s
popularity, and is also as a measure of compatibility between applications. The better this score, the more
common the format and the more software packages include support for it.

Utility Our opinion of the format’s suitability for storing metadata-rich microscopy image data. The better this score,
the wider the variety of information that can be effectively stored in the format.
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Export This indicates whether Bio-Formats is capable of writing the format (Bio-Formats can read every format on
this list).

SCIFIO This indicates whether format is supported by the SCIFIO core library (See the license section on the Bio-
Formats documentation page for why this matters).

17.1 3i SlideBook

Extensions: .sld
Developer: Intelligent Imaging Innovations'
Owner: Intelligent Imaging Innovations?

Support
SCIFIO:

Export:
Officially Supported Versions: 4.1, 4.2
Supported Metadata Fields: 3i SlideBook
We currently have:
¢ Numerous SlideBook datasets
We would like to have:
* A SlideBook specification document
* More SlideBook datasets (preferably acquired with the most recent SlideBook software)
Ratings
Pixels:
Metadata:

Openness:

Presence:

Utility:

Additional Information

Source Code: SlidebookReader.java’
Notes:

We strongly encourage users to export their .sld files to OME-TIFF using the SlideBook software. Bio-Formats is not
likely to support the full range of metadata that is included in .sld files, and so exporting to OME-TIFF from SlideBook
is the best way to ensure that all metadata is preserved.

See also:

Slidebook software overview”

Uhttp://www.intelligent-imaging.com/

Zhttp://www.intelligent-imaging.com/
3https://github.com/openmicroscopy/bioformats/blob/develop/components/bio-formats/src/loci/formats/in/SlidebookReader. java
“https://www.slidebook.com
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17.2 Andor Bio-Imaging Division (ABD) TIFF

Extensions: .tif

Developer: Andor Bioimaging Department

Owner: Andor Technology®

Support

SCIFIO:

Export:

Officially Supported Versions:

Supported Metadata Fields: Andor Bio-Imaging Division (ABD) TIFF

We currently have:
* an ABD-TIFF specification document (from 2005 November, in PDF)
» afew ABD-TIFF datasets

We would like to have:

Ratings

Pixels:

Metadata:

Openness:

Presence:

Utility:

Additional Information

Source Code: FluoviewReader.java®
Notes:

Please note that while we have specification documents for this format, we are not able to distribute them to
third parties.

With a few minor exceptions, the ABD-TIFF format is identical to the Fluoview TIFF format.

17.3 AIM

Extensions: .aim

Developer: SCANCO Medical AG’
Support

SCIFIO:

Export:

Shttp://www.andor.com/
Shttps://github.com/openmicroscopy/bioformats/blob/develop/components/bio-formats/src/loci/formats/in/FluoviewReader.java
7http://www.scanco.ch
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Officially Supported Versions:
Supported Metadata Fields: AIM
We currently have:
* one .aim file
We would like to have:
* an .aim specification document
¢ more .aim files
Ratings
Pixels:
Metadata:

Openness:

Presence:

Utility:

Additional Information
Source Code: AIMReader.java®

Notes:

17.4 Alicona 3D

Extensions: .al3d
Owner: Alicona Imaging’

Support

SCIFIO:

Export:

Officially Supported Versions: 1.0
Supported Metadata Fields: Alicona 3D

We currently have:

* an AL3D specification document'? (v1.0, from 2003, in PDF)

e afew AL3D datasets

‘We would like to have:

* more AL3D datasets (Z series, T series, 16-bit)

8https://github.com/openmicroscopy/bioformats/blob/develop/components/bio-formats/src/loci/formats/in/AIMReader. java

9http://www.alicona.com/

1%http://www.alicona.com/home/fileadmin/alicona/downloads/AL3DFormat.pdf

17.4. Alicona 3D
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Ratings
Pixels:
Metadata:

Openness:

Presence:
Utility:
Additional Information
Source Code: AliconaReader.java'!
Notes:
Known deficiencies:
 Support for 16-bit AL3D images is present, but has never been tested.

 Texture data is currently ignored.

17.5 Amersham Biosciences Gel

Extensions: .gel
Developer: Molecular Dynamics
12

Owner: GE Healthcare Life Sciences

Support

SCIFIO:

Export:

Officially Supported Versions:

Supported Metadata Fields: Amersham Biosciences Gel

We currently have:
* a GEL specification document (Revision 2, from 2001 Mar 15, in PDF)
» afew GEL datasets

We would like to have:

Ratings

Pixels:

Metadata:

Openness:

Presence:

Utility:

Mhttps://github.com/openmicroscopy/bioformats/blob/develop/components/bio-formats/src/loci/formats/in/AliconaReader.java
Zhttp://www.gelifesciences.com/
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Additional Information
Source Code: GelReader.java'?

Notes:

Please note that while we have specification documents for this format, we are not able to distribute them to

third parties.
See also:

GEL Technical Overview!'4

17.6 Amira Mesh

Extensions: .am, .amiramesh, .grey, .hx, .labels
Developer: Visage Imaging'?
Support
SCIFIO:
Export:
Officially Supported Versions:
Supported Metadata Fields: Amira Mesh
We currently have:

* afew Amira Mesh datasets
We would like to have:

* more Amira Mesh datasets
Ratings
Pixels:

Metadata:

Openness:

Presence:

Utility:

Additional Information

Source Code: AmiraReader.java'®

Notes:

Bhttps://github.com/openmicroscopy/bioformats/blob/develop/components/bio-formats/src/loci/formats/in/GelReader java

4http://www.awaresystems.be/imaging/tiff/tifftags/docs/gel.html

Shttp://www.amiravis.com/

16https://github.com/openmicroscopy/bioformats/blob/develop/components/bio-formats/src/loci/formats/in/AmiraReader.java

17.6. Amira Mesh
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17.7 Analyze 7.5

Extensions: .img, .hdr
Developer: Mayo Foundation Biomedical Imaging Resource!’

Support

SCIFIO:
Export:
Officially Supported Versions:
Supported Metadata Fields: Analyze 7.5
We currently have:
* an Analyze 7.5 specification document!®
* several Analyze 7.5 datasets
We would like to have:
Ratings
Pixels:
Metadata:

Openness:

Presence:

Utility:

Additional Information

Source Code: AnalyzeReader.java'”

Notes:

17.8 Animated PNG

Extensions: .png

Developer: The Animated PNG Project?
Support

SCIFIO:

Export:

Officially Supported Versions:

Supported Metadata Fields: Animated PNG

Freely Available Software:

7http://www.mayo.edu/bir

18http://analyzedirect.com/support/10.0Documents/Analyze_Resource_01.pdf
9https://github.com/openmicroscopy/bioformats/blob/develop/components/bio-formats/src/loci/formats/in/AnalyzeReader.java
2Ohttp://www.animatedpng.com/
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* Firefox 3+%!
 Opera 9.5+
+ KSquirrel??
We currently have:
* a specification document?*
* several APNG files
We would like to have:
Ratings
Pixels:

Metadata:

Openness:

Presence:

Utility:

Additional Information

Source Code: APNGReader.java®

Notes:

17.9 Aperio SVS TIFF

Extensions: .svs
26

Owner: Aperio

Support
SCIFIO:

Export:
Officially Supported Versions: 8.0, 8.2, 9.0
Supported Metadata Fields: Aperio SVS TIFF
We currently have:

* many SVS datasets

* an SVS specification document

* the ability to generate additional SVS datasets

2l http://www.mozilla.com/firefox
22http://www.opera.com/download
Zhttp://ksquirrel.sourceforge.net/download.php
24http://wiki.mozilla.org/ APNG_Specification

Z5https://github.com/openmicroscopy/bioformats/blob/develop/components/scifio/src/loci/formats/in/APNGReader java

http://www.aperio.com/

17.9. Aperio SVS TIFF
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We would like to have:
Ratings

Pixels:

Metadata:

Openness:

Presence:

Utility:

Additional Information
Source Code: SVSReader.java®’

Notes:

Please note that while we have specification documents for this format, we are not able to distribute them to

third parties.
See also:

Aperio ImageScope?®

17.10 Applied Precision CellWorX

Extensions: .htd, .pnl
Developer: Applied Precision®

Support

SCIFIO:
Export:
Officially Supported Versions:
Supported Metadata Fields: Applied Precision CellWorX
We currently have:
* afew CellWorX datasets
We would like to have:
* a CellWorX specification document
» more CellWorX datasets
Ratings
Pixels:
Metadata:

Openness:

2Thttps://github.com/openmicroscopy/bioformats/blob/develop/components/bio-formats/src/loci/formats/in/SVSReader.java

Z8http://www.aperio.com/#imagescope-request
http://www.api.com

17.10. Applied Precision CellWorX
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Presence:

Utility:

Additional Information

Source Code: CellWorxReader.java®

Notes:

17.11 AVI (Audio Video Interleave)

Extensions: .avi
Developer: Microsoft®!

Support
SCIFIO:

Export:
Officially Supported Versions:
Supported Metadata Fields: AVI (Audio Video Interleave)
Freely Available Software:
* AVI Reader plugin for Image]J??
* AVI Writer plugin for ImageJ??
We currently have:
 several AVI datasets
We would like to have:
* more AVI datasets, including:
— files with audio tracks and/or multiple video tracks
— files compressed with a common unsupported codec
- 2+ GB files
Ratings
Pixels:
Metadata:
Openness:
Presence:
Utility:

Additional Information

30https://github.com/openmicroscopy/bioformats/blob/develop/components/bio-formats/src/loci/formats/in/CellWorxReader.java
31http://www.microsoft.com/

3http://rsb.info.nih.gov/ij/plugins/avi-reader.html

3Bhttp://rsb.info.nih.gov/ij/plugins/avi.html
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Source Code: AVIReader.java®

Notes:

* Bio-Formats can save image stacks as AVI (uncompressed).

* The following codecs are supported for reading:

Microsoft Run-Length Encoding (MSRLE)

Microsoft Video (MSV1)
— Raw (uncompressed)

JPEG

See also:

AVI RIFF File Reference®® AVI on Wikipedia®®

17.12 Axon Raw Format

Extensions: .arf
Owner: INDEC BioSystems®’
Support
SCIFIO:
Export:
Officially Supported Versions:
Supported Metadata Fields: Axon Raw Format
We currently have:

» one ARF dataset

* a specification document3®
We would like to have:

* more ARF datasets
Ratings
Pixels:
Metadata:
Openness:
Presence:
Utility:

Additional Information

34https://github.com/openmicroscopy/bioformats/blob/develop/components/scifio/src/loci/formats/in/AVIReader java

35http://msdn2.microsoft.com/en-us/library/ms779636.aspx

36http://en.wikipedia.org/wiki/Audio_Video_Interleave
3Thttp://www.indecbiosystems.com/

38http://www.indecbiosystems.com/imagingworkbench/ApplicationNotes/IWAppNote 1 1-ARF_File_Format.pdf

17.12. Axon Raw Format
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Source Code: ARFReader.java®

Notes:

17.13 BD Pathway

Extensions: .exp, .tif
Owner: BD Biosciences*

Support
SCIFIO:
Export:
Officially Supported Versions:
Supported Metadata Fields: BD Pathway
We currently have:
* afew BD Pathway datasets
We would like to have:
* more BD Pathway datasets
Ratings
Pixels:
Metadata:
Openness:
Presence:
Utility:
Additional Information
Source Code: BDReader.java*!

Notes:

17.14 Becker & Hickl SPCImage

Extensions: .sdt
Owner: Becker-Hickl*?
Support

SCIFIO:

Export:

3https://github.com/openmicroscopy/bioformats/blob/develop/components/bio-formats/src/loci/formats/in/ARFReader. java

4Ohttp://www.bdbiosciences.com

41 https://github.com/openmicroscopy/bioformats/blob/develop/components/bio-formats/src/loci/formats/in/BDReader.java

“http://www.becker-hickl.de/

17.13. BD Pathway
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Officially Supported Versions:

Supported Metadata Fields: Becker & Hickl SPCImage

We currently have:
 an SDT specification document (from 2008 April, in PDF)
* an SDT specification document (from 2006 June, in PDF)
* Becker & Hickl’s SPCImage™ software
¢ alarge number of SDT datasets
* the ability to produce new datasets

We would like to have:

Ratings

Pixels:

Metadata:

Openness:

Presence:

Utility:

Additional Information
Source Code: SDTReader.java*
Notes:

Please note that while we have specification documents for this format, we are not able to distribute them to
third parties.

17.15 Bio-Rad Gel

Extensions: .1sc
Owner: Bio-Rad®

Support
SCIFIO:

Export:

Officially Supported Versions:

Supported Metadata Fields: Bio-Rad Gel

We currently have:
* software that can read Bio-Rad Gel files
* several Bio-Rad Gel files

‘We would like to have:

http://www.becker-hickl.de/software/tcspc/softwaretcspespecial.htm
“https://github.com/openmicroscopy/bioformats/blob/develop/components/bio-formats/src/loci/formats/in/SDTReader.java
“Shitp://www.bio-rad.com
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* a Bio-Rad Gel specification
* more Bio-Rad Gel files
Ratings
Pixels:
Metadata:

Openness:

Presence:

Utility:

Additional Information

Source Code: BioRadGelReader.java*®

Notes:

17.16 Bio-Rad PIC

Extensions: .pic, .raw, .xml

Developer: Bio-Rad

Owner: Carl Zeiss, Inc.’

Support

SCIFIO:

Export:

Officially Supported Versions:

Supported Metadata Fields: Bio-Rad PIC

Freely Available Software:
* Bio-Rad PIC reader plugin for ImageJ*3

We currently have:
¢ a PIC specification document (v4.5, in PDF)
¢ an older PIC specification document (v4.2, from 1996 December 16, in DOC)
¢ alarge number of PIC datasets
* the ability to produce new datasets

We would like to have:

Ratings

Pixels:

Metadata:

46https://github.com/openmicroscopy/bioformats/blob/develop/components/bio-formats/src/loci/formats/in/BioRadGelReader.java
“Thttp://www.zeiss.com/
“Bhttp://rsb.info.nih.gov/ij/plugins/biorad.html

17.16. Bio-Rad PIC 124


https://github.com/openmicroscopy/bioformats/blob/develop/components/bio-formats/src/loci/formats/in/BioRadGelReader.java
http://www.zeiss.com/
http://rsb.info.nih.gov/ij/plugins/biorad.html

Bio-Formats Documentation, Release 4.4.8-DEV

Openness:

Presence:

Utility:

Additional Information

Source Code: BioRadReader.java®’
Notes:

Please note that while we have specification documents for this format, we are not able to distribute them to
third parties.
» Commercial applications that support this format include:
— Bitplane Imaris®

- SVI Huygens®!

17.17 Bitplane Imaris

Extensions: .ims
Owner: Bitplane™

Support

SCIFIO:
Export:
Officially Supported Versions: 2.7, 3.0, 5.5
Supported Metadata Fields: Bitplane Imaris
We currently have:
* an Imaris (RAW) specification document®® (from no later than 1997 November 11, in HTML)
¢ an Imaris 5.5 (HDF) specification document
* Bitplane’s bfFileReaderImaris3N code (from no later than 2005, in C++)
« several older Imaris (RAW) datasets
¢ one Imaris 3 (TIFF) dataset
¢ several Imaris 5.5 (HDF) datasets
We would like to have:
e an Imaris 3 (TIFF) specification document

¢ more Imaris 3 (TIFF) datasets

“Ohttps://github.com/openmicroscopy/bioformats/blob/develop/components/bio-formats/src/loci/formats/in/BioRadReader. java
SOhttp://www.bitplane.com/

Sthttp://svi.nl/

S2http://www.bitplane.com/

33http://flash.bitplane.com/support/faqs/fagsview.cfm?inCat=6&inQuestionID=104
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Ratings
Pixels:
Metadata:
Openness:
Presence:
Utility:

Additional Information

Source Code: ImarisHDFReader.java®*, ImarisTiffReader.java®, ImarisReader.java®®

Notes:

¢ There are three distinct Imaris formats:

1. the old binary format (introduced in Imaris version 2.7)

2. Imaris 3, a TIFF variant (introduced in Imaris version 3.0)

3. Imaris 5.5, an HDF variant (introduced in Imaris version 5.5)

17.18 Bruker MRI

Developer: Bruker’’

Support

SCIFIO:
Export:
Officially Supported Versions:
Supported Metadata Fields: Bruker MRI
Freely Available Software:
* Bruker plugin for ImageJ>3
We currently have:
* a few Bruker MRI datasets
We would like to have:
* an official specification document
Ratings
Pixels:
Metadata:

Openness:

34https://github.com/openmicroscopy/bioformats/blob/develop/components/bio-formats/src/loci/formats/in/ImarisHDFReader. java
55 https://github.com/openmicroscopy/bioformats/blob/develop/components/bio-formats/src/loci/formats/in/Imaris TiffReader. java
36https://github.com/openmicroscopy/bioformats/blob/develop/components/bio-formats/src/loci/formats/in/ImarisReader. java

SThttp://www.bruker.com/
3http://rsbweb.nih.gov/ij/plugins/bruker.html
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Presence:

Utility:

Additional Information

Source Code: BrukerReader.java™

Notes:

17.19 Burleigh

Extensions: .img
Owner: Burleigh Instruments

Support
SCIFIO:

Export:

Officially Supported Versions:

Supported Metadata Fields: Burleigh

We currently have:
* Pascal code that can read Burleigh files (from ImageSXM)
 afew Burleigh files

We would like to have:
* a Burleigh file format specification
* more Burleigh files

Ratings

Pixels:

Metadata:

Openness:

Presence:

Utility:

Additional Information

Source Code: BurleighReader.java®

Notes:

3 https://github.com/openmicroscopy/bioformats/blob/develop/components/bio-formats/src/loci/formats/in/BrukerReader java
Ohttps://github.com/openmicroscopy/bioformats/blob/develop/components/bio-formats/src/loci/formats/in/BurleighReader.java
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17.20 Canon DNG

Extensions: .cr2, .crw
Developer: Canon®!

Support

SCIFIO:
Export:
Officially Supported Versions:
Supported Metadata Fields: Canon DNG
Freely Available Software:
o IrfanView®?
We currently have:
» afew example datasets
We would like to have:
* an official specification document
Ratings
Pixels:
Metadata:

Openness:

Presence:

Utility:

Additional Information

Source Code: DNGReader.java®

Notes:

17.21 Cellomics

Extensions: .cO1

Developer: Thermo Fisher Scientific®*
Support

SCIFIO:

Export:

Officially Supported Versions:

61http://canon.com
2 http://www.irfanview.com/

3 https://github.com/openmicroscopy/bioformats/blob/develop/components/bio-formats/src/loci/formats/in/DNGReader. java

http://www.thermofisher.com/
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Supported Metadata Fields: Cellomics

We currently have:
* afew Cellomics .cO1 datasets

We would like to have:
* a Cellomics .cOl specification document
* more Cellomics .cO1 datasets

Ratings

Pixels:

Metadata:

Openness:

Presence:

Utility:

Additional Information

Source Code: CellomicsReader.java®

Notes:

17.22 cellSens VSI

Extensions: .vsi
Developer: Olympus®
Support
SCIFIO:
Export:
Officially Supported Versions:
Supported Metadata Fields: cellSens VSI
We currently have:
* afew example datasets
We would like to have:
* an official specification document
Ratings
Pixels:
Metadata:

Openness:

Presence:

95 https://github.com/openmicroscopy/bioformats/blob/develop/components/bio-formats/src/loci/formats/in/CellomicsReader.java

http://www.olympus.com/
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Utility:
Additional Information
Source Code: CellSensReader.java®’

Notes:

17.23 DeltaVision

Extensions: .dv, .r3d
Owner: Applied Precision®®

Support

SCIFIO:
Export:
Officially Supported Versions:
Supported Metadata Fields: DeltaVision
Freely Available Software:
* DeltaVision Opener plugin for ImageJ®
Sample Datasets:
+ Applied Precision Datasets’®
We currently have:
* a DV specification document (v2.10 or newer, in HTML)
* numerous DV datasets
We would like to have:
Ratings
Pixels:
Metadata:

Openness:

Presence:

Utility:

Additional Information

Source Code: DeltavisionReader.java’!
Notes:

Please note that while we have specification documents for this format, we are not able to distribute them to
third parties.

67https://github.com/openmicroscopy/bioformats/blob/develop/components/bio-formats/src/loci/formats/in/CellSensReader. java
8http://www.api.com/

http://rsb.info.nih.gov/ij/plugins/track/delta.html
TOhttp://www.api.com/downloads/software/softworxexplorer2.0/SampleImages.zip
Thttps://github.com/openmicroscopy/bioformats/blob/develop/components/bio-formats/src/loci/formats/in/DeltavisionReader.java
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¢ The Deltavision format is based on the Medical Research Council (MRC) file format.
* Commercial applications that support DeltaVision include:

- Bitplane Imaris’?
- SVI Huygens’?
— Image-Pro Plus™

See also:

DeltaVision system description”?

17.24 DICOM

Extensions: .dcm, .dicom
Developer: National Electrical Manufacturers Association”®
Support
SCIFIO:
Export:
Officially Supported Versions:
Supported Metadata Fields: DICOM
Freely Available Software:
* OsiriX Medical Imaging Software’’
» ezDICOM’®
 Wikipedia’s list of freeware health software’®
Sample Datasets:
* MRI Chest from FreeVol-3D web site®”
» Medical Image Samples from Sebastien Barre’s Medical Imaging page®!
» DICOM sample image sets from OsiriX web site®?
We currently have:
* DICOM specification documents®? (PS 3 - 2007, from 2006 December 28, in DOC and PDF)

¢ numerous DICOM datasets

72http://www.bitplane.com/

T3http://svi.nl/

T4http://www.mediacy.com/

TShttp://api.com/deltavision.asp

Tohttp://www.nema.org/

"Thttp://www.osirix-viewer.com/
T8http://www.sph.sc.edu/comd/rorden/ezdicom.html
Thttp://en.wikipedia.org/wiki/List_of_freeware_health_software#Imaging.2FVisualization
80http://members.tripod.com/%7Eclunis_immensus/free3d/hk-40.zip
81http://www.barre.nom.fr/medical/samples/
82http://osirix-viewer.com/datasets/
83http://medical.nema.org/dicom/2007/
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We would like to have:
Ratings

Pixels:

Metadata:

Openness:

Presence:

Utility:

Additional Information

Source Code: DicomReader.java®*

Notes:

* DICOM stands for “Digital Imaging and Communication in Medicine”.

* Bio-Formats supports both compressed and uncompressed DICOM files.

See also:

DICOM homepage®’

17.25 ECAT7

Extensions: .v
Developer: Siemens®®

Support

SCIFIO:
Export:
Officially Supported Versions:
Supported Metadata Fields: ECAT7
We currently have:
» afew ECAT7 files
We would like to have:
» an ECATY7 specification document
» more ECATY7 files
Ratings
Pixels:
Metadata:

Openness:

84https://github.com/openmicroscopy/bioformats/blob/develop/components/scifio/src/loci/formats/in/DicomReader. java

85http://medical.nema.org/
86http://www.siemens.com
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Presence:

Utility:

Additional Information

Source Code: Ecat7Reader.java®’

Notes:

17.26 EPS (Encapsulated PostScript)

Extensions: .eps, .epsi, .ps
Developer: Adobe®®
Support

SCIFIO:
Export:
Officially Supported Versions:
Supported Metadata Fields: EPS (Encapsulated PostScript)
Freely Available Software:

 EPS Writer plugin for ImageJ®’
We currently have:

» afew EPS datasets

* the ability to produce new datasets
We would like to have:
Ratings
Pixels:
Metadata:

Openness:

Presence:
Utility:
Additional Information
Source Code: EPSReader.java® Source Code: EPSWriter.java’!
Notes:
* Bio-Formats can save individual planes as EPS.

* Certain types of compressed EPS files are not supported.

87https://github.com/openmicroscopy/bioformats/blob/develop/components/bio-formats/src/loci/formats/in/Ecat7Reader.java
88http://www.adobe.com/

89http://rsb.info.nih.gov/ij/plugins/eps-writer.html
9Ohttps://github.com/openmicroscopy/bioformats/blob/develop/components/scifio/sre/loci/formats/in/EPSReader.java
9https://github.com/openmicroscopy/bioformats/blob/develop/components/scifio/src/loci/formats/out/EPS Writer.java
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17.27 Evotec/PerkinElmer Opera Flex

Extensions: .flex, .mea, .res
Developer: Evotec Technologies, now PerkinElmer®?

Support

SCIFIO:
Export:
Officially Supported Versions:
Supported Metadata Fields: Evotec/PerkinElmer Opera Flex
We currently have:
* many Flex datasets
We would like to have:
* afreely redistributable LuraWave LWF decoder
Ratings
Pixels:
Metadata:

Openness:

Presence:

Utility:

Additional Information
Source Code: FlexReader.java”™

Notes:

The LuraWave LWF decoder library (i.e. Iwf_jsdk2.6.jar) with license code is required to decode wavelet-compressed
Flex files.

See also:

LuraTech (developers of the proprietary LuraWave LWF compression used for Flex image planes)™

17.28 FEI

Extensions: .img
Developer: FEI”

Support

SCIFIO:

92http://www.perkinelmer.com/
93https://github.com/openmicroscopy/bioformats/blob/develop/components/bio-formats/src/loci/formats/in/FlexReader.java
94http://www.luratech.com/

9http://www.fei.com/
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Export:
Officially Supported Versions:
Supported Metadata Fields: FE/
We currently have:
 afew FEI files
We would like to have:
* a specification document
» more FEI files
Ratings
Pixels:
Metadata:

Openness:

Presence:

Utility:

Additional Information
Source Code: FEIReader.java”®

Notes:

17.29 FEI TIFF

Extensions: .tiff
Developer: FEI’

Support
SCIFIO:
Export:
Officially Supported Versions:
Supported Metadata Fields: FEI TIFF
We currently have:

* afew FEI TIFF datasets
We would like to have:
Ratings
Pixels:
Metadata:

Openness:

9 https://github.com/openmicroscopy/bioformats/blob/develop/components/bio-formats/src/loci/formats/in/FEIReader.java

Thttp://www.fei.com
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Presence:

Utility:

Additional Information

Source Code: FEITiffReader.java”

Notes:

17.30 FITS (Flexible Image Transport System)

Extensions: .fits
Developer: National Radio Astronomy Observatory®

Support
SCIFIO:

Export:

Officially Supported Versions:

Supported Metadata Fields: FITS (Flexible Image Transport System)

We currently have:
* a FITS specification document!® (NOST 100-2.0, from 1999 March 29, in HTML)
* several FITS datasets

We would like to have:

Ratings

Pixels:

Metadata:

Openness:

Presence:

Utility:

Additional Information
Source Code: FitsReader.java'?!
Notes:

See also:

MAST:FITS homepage'?? FITS Support Office'®

98 https://github.com/openmicroscopy/bioformats/blob/develop/components/bio-formats/src/loci/formats/in/FEITiffReader.java
http://www.nrao.edu/
100htp://archive.stsci.edu/fits/fits_standard/
10T https://github.com/openmicroscopy/bioformats/blob/develop/components/scifio/src/loci/formats/in/FitsReader.java
102http://archive.stsci.edu/fits/
103http://fits.gsfc.nasa.gov/
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17.31 Gatan Digital Micrograph

Extensions: .dm3
Owner: Gatan'®*

Support

SCIFIO:
Export:
Officially Supported Versions: 3
Supported Metadata Fields: Gatan Digital Micrograph
Freely Available Software:
» DMB3 Reader plugin for ImageJ!®
« EMAN!06
We currently have:
* Gatan’s ImageReader2003 code (from 2003, in C++)
* numerous DM3 datasets
We would like to have:
* a DM3 specification document
Ratings
Pixels:
Metadata:

Openness:

Presence:

Utility:

Additional Information

Source Code: GatanReader.java'’

Notes:

Commercial applications that support .dm3 files include Datasqueeze

17.32 Gatan Digital Micrograph 2

Extensions: .dm2

Developer: Gatan'"”

104http://www.gatan.com/
105http://rsb.info.nih.gov/ij/plugins/DM3_Reader.html
106http://blake.bcm.edu/EMAN/

108

107https://github.com/openmicroscopy/bioformats/blob/develop/components/bio-formats/src/loci/formats/in/GatanReader. java

108http://www.datasqueezesoftware.com/
109http://www.gatan.com
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Support

SCIFIO:
Export:
Officially Supported Versions: 2
Supported Metadata Fields: Gatan Digital Micrograph 2
We currently have:
* Pascal code that can read DM2 files (from ImageSXM)
* afew DM2 files
We would like to have:
* an official DM2 specification document
* more DM2 files
Ratings
Pixels:
Metadata:

Openness:

Presence:

Utility:

Additional Information

Source Code: GatanDM2Reader.java''”

Notes:

17.33 GIF (Graphics Interchange Format)

Extensions: .gif
Developer: CompuServe'!!
Owner: Unisys''?

Support

SCIFIO:

Export:

Officially Supported Versions:

Supported Metadata Fields: GIF' (Graphics Interchange Format)
Freely Available Software:

+ Animated GIF Reader plugin for ImageJ'!3

10nttps://github.com/openmicroscopy/bioformats/blob/develop/components/bio-formats/src/loci/formats/in/GatanDM2Reader. java

http://www.compuserve.com/
2http://www.unisys.com/
1Bhttp://rsb.info.nih.gov/ij/plugins/agr.htm]
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* GIF Stack Writer plugin for ImageJ' !4
We currently have:
* a GIF specification document'" (Version 89a, from 1990, in HTML)
* numerous GIF datasets
* the ability to produce new datasets
We would like to have:
Ratings
Pixels:
Metadata:

Openness:

Presence:

Utility:

Additional Information

116

Source Code: GIFReader.java

Notes:

17.34 Hamamatsu Aquacosmos NAF

Extensions: .naf
Developer: Hamamatsu'!”
Support
SCIFIO:
Export:
Officially Supported Versions:
Supported Metadata Fields: Hamamatsu Aquacosmos NAF
We currently have:
» afew NAF files
We would like to have:
* a specification document
* more NAF files
Ratings
Pixels:

Metadata:

H4http://rsb.info.nih.gov/ij/plugins/gif-stack-writer.html

Shttp://tronche.com/computer-graphics/gif/
16https://github.com/openmicroscopy/bioformats/blob/develop/components/scifio/src/loci/formats/in/GIFReader.java
7 http://www.hamamatsu.com/
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Openness:

Presence:

Utility:

Additional Information

Source Code: NAFReader.java''®

Notes:

17.35 Hamamatsu HIS

Extensions: .his
Owner: Hamamatsu' '
Support
SCIFIO:
Export:
Officially Supported Versions:
Supported Metadata Fields: Hamamatsu HIS
We currently have:
* Pascal code that can read HIS files (from ImageSXM)
* several HIS files
We would like to have:
* an HIS specification
» more HIS files
Ratings
Pixels:
Metadata:

Openness:

Presence:

Utility:

Additional Information
Source Code: HISReader.java'?"

Notes:

118 https://github.com/openmicroscopy/bioformats/blob/develop/components/bio-formats/src/loci/formats/in/NAFReader. java

9http://www.hamamatsu.com

120pttps://github.com/openmicroscopy/bioformats/blob/develop/components/bio-formats/src/loci/formats/in/HISReader.java

17.35. Hamamatsu HIS

140


https://github.com/openmicroscopy/bioformats/blob/develop/components/bio-formats/src/loci/formats/in/NAFReader.java
http://www.hamamatsu.com
https://github.com/openmicroscopy/bioformats/blob/develop/components/bio-formats/src/loci/formats/in/HISReader.java

Bio-Formats Documentation, Release 4.4.8-DEV

17.36 Hamamatsu ndpi

Extensions: .ndpi
Developer: Hamamatsu'?!

Support

SCIFIO:
Export:
Officially Supported Versions:
Supported Metadata Fields: Hamamatsu ndpi
Freely Available Software:
* NDP.view'*
Sample Datasets:
* OpenSlide'?}
We currently have:
* many example datasets
We would like to have:
* an official specification document
Ratings
Pixels:
Metadata:

Openness:

Presence:

Utility:

Additional Information

Source Code: NDPIReader.java'?*

Notes:

17.37 Hamamatsu VMS

Extensions: .vms
Developer: Hamamatsu'?

Support

12 http://www.hamamatsu.com
122http://www.olympusamerica.com/seg_section/seg_vm_downloads.asp
123http://openslide.cs.cmu.edu/download/openslide-testdata/Hamamatsu/

124https://github.com/openmicroscopy/bioformats/blob/develop/components/bio-formats/src/loci/formats/in/NDPIReader. java

125http://www.hamamatsu.com
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SCIFIO:
Export:
Officially Supported Versions:
Supported Metadata Fields: Hamamatsu VMS
Sample Datasets:
 OpenSlide!'?¢
We currently have:
» afew example datasets
* developer documentation from the OpenSlide project!?’
We would like to have:
* an official specification document
* more example datasets
Ratings
Pixels:

Metadata:

Openness:

Presence:

Utility:

Additional Information

Source Code: HamamatsuVMSReader.java'?®

Notes:

17.38 Hitachi S-4800

Extensions: .txt, .tif, .bmp, .jpg
Developer: Hitachi'?’

Support

SCIFIO:

Export:

Officially Supported Versions:

Supported Metadata Fields: Hitachi S-4800
We currently have:

¢ several Hitachi S-4800 datasets

126http://openslide.cs.cmu.edu/download/openslide-testdata/Hamamatsu-vms/
127http://openslide.org/Hamamatsu%20format/

128https://github.com/openmicroscopy/bioformats/blob/develop/components/bio-formats/src/loci/formats/in/Hamamatsu VMSReader. java
129 hitp://www.hitachi-hta.com/sites/default/files/technotes/Hitachi_4800_STEM.pdf
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We would like to have:
Ratings

Pixels:

Metadata:

Openness:

Presence:

Utility:

Additional Information

Source Code: HitachiReader.java'°

Notes:

17.39 ICS (Image Cytometry Standard)

Extensions: .ics, .ids
Developer: P. Dean et al.

Support

SCIFIO:
Export:
Officially Supported Versions: 1.0, 2.0
Supported Metadata Fields: ICS (Image Cytometry Standard)
Freely Available Software:

« Libics (ICS reference library)'3!
» ICS Opener plugin for ImageJ'*
o IrfanView!'??
We currently have:

* numerous ICS datasets
We would like to have:
Ratings
Pixels:

Metadata:

Openness:

Presence:

130https://github.com/openmicroscopy/bioformats/blob/develop/components/bio-formats/src/loci/formats/in/HitachiReader.java
31 http://libics.sourceforge.net/

132http://valelab.ucsf.edu/%7Enico/IIplugins/Ics_Opener.html

B33http://www.irfanview.com/

17.39. ICS (Image Cytometry Standard) 143


https://github.com/openmicroscopy/bioformats/blob/develop/components/bio-formats/src/loci/formats/in/HitachiReader.java
http://libics.sourceforge.net/
http://valelab.ucsf.edu/%7Enico/IJplugins/Ics_Opener.html
http://www.irfanview.com/

Bio-Formats Documentation, Release 4.4.8-DEV

Utility:

Additional Information

Source Code: ICSReader.java'** Source Code: ICSWriter.java'®
Notes:

¢ ICS version 1.0 datasets have two files - an .ics file that contains all of the metadata in plain-text format, and an
.ids file that contains all of the pixel data.

* ICS version 2.0 datasets are a single .ics file that contains both pixels and metadata.
Commercial applications that can support ICS include:
* Bitplane Imaris'®

* SVI Huygens'?’

17.40 Imacon

Extensions: .fff
Owner: Hasselblad'?®

Support
SCIFIO:

Export:
Officially Supported Versions:
Supported Metadata Fields: Imacon
We currently have:
* one Imacon file
We would like to have:
* more Imacon files
Ratings
Pixels:
Metadata:

Openness:

Presence:
Utility:
Additional Information

Source Code: ImaconReader.java'®

134https://github.com/openmicroscopy/bioformats/blob/develop/components/scifio/src/loci/formats/in/ICSReader.java
135https://github.com/openmicroscopy/bioformats/blob/develop/components/scifio/src/loci/formats/out/ICS Writer.java
136http://www.bitplane.com/

B7http://svi.nl/

38http://www.hasselbladusa.com/
139https://github.com/openmicroscopy/bioformats/blob/develop/components/bio-formats/src/loci/formats/in/ImaconReader.java
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Notes:

17.41 ImagePro Sequence

Extensions: .seq
Owner: Media Cybernetics'4?

Support

SCIFIO:
Export:
Officially Supported Versions:
Supported Metadata Fields: /magePro Sequence
We currently have:

+ the Image-Pro Plus'#! software

¢ a few SEQ datasets

* the ability to produce more datasets
We would like to have:

* an official SEQ specification document
Ratings
Pixels:
Metadata:

Openness:

Presence:

Utility:

Additional Information

Source Code: SEQReader.java'4?

Notes:

17.42 ImagePro Workspace

Extensions: .ipw
Owner: Media Cybernetics'#

Support

SCIFIO:

140http://www.mediacy.com/
4T http://www.mediacy.com/index.aspx ?page=IPP

142 https://github.com/openmicroscopy/bioformats/blob/develop/components/bio-formats/src/loci/formats/in/SEQReader.java

193 http://www.mediacy.com/
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Export:
Officially Supported Versions:
Supported Metadata Fields: /magePro Workspace
We currently have:
+ the Image-Pro Plus'** software
 afew IPW datasets
¢ the ability to produce more datasets
We would like to have:
* an official [IPW specification document
* more [PW datasets:
— multiple datasets in one file
— 2+ GB files
Ratings
Pixels:
Metadata:

Openness:

Presence:

Utility:

Additional Information

Source Code: IPWReader.java'®

Notes:

Bio-Formats uses a modified version of the Apache Jakarta POI'* library to read IPW files.

17.43 IMAGIC

Extensions: .hed, .img
Developer: Image Science'*’

Support

SCIFIO:

Export:

Officially Supported Versions:
Supported Metadata Fields: IMAGIC

Freely Available Software:

144 http://www.mediacy.com/index.aspx ?page=IPP

143 hitps://github.com/openmicroscopy/bioformats/blob/develop/components/bio-formats/src/loci/formats/in/IPWReader.java

146http://jakarta.apache.org/poi/
147http://www.imagescience.de
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e em2em!'*®

We currently have:
* one example dataset
* official file format documentation
We would like to have:
* more example datasets
Ratings
Pixels:
Metadata:

Openness:

Presence:

Utility:

Additional Information

Source Code: ImagicReader.java'*’
Notes:

See also:

IMAGIC specification'*°

17.44 IMOD

Extensions: .mod

Developer: Boulder Laboratory for 3-Dimensional Electron Microscopy of Cells

Owner: Boulder Laboratory for 3-Dimensional Electron Microscopy of Cells

Support

SCIFIO:
Export:
Officially Supported Versions:
Supported Metadata Fields: /MOD
Freely Available Software:

« IMOD™?
We currently have:

» afew sample datasets

148http://www.imagescience.de/em2em.html

151

(152

199 https://github.com/openmicroscopy/bioformats/blob/develop/components/bio-formats/src/loci/formats/in/ImagicReader. java

150http://www.imagescience.de/em2em.html
I51http://bio3d.colorado.edu
152http://bio3d.colorado.edu
153http://bio3d.colorado.edu/imod/
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« official documentation'>*
We would like to have:
Ratings

Pixels:

Metadata:

Openness:

Presence:

Utility:

Additional Information

Source Code: IMODReader.java'>

Notes:

17.45 Improvision Openlab LIFF

Extensions: .liff
Developer: Improvision'*®
Owner: PerkinElmer'’

Support

SCIFIO:

Export:

Officially Supported Versions: 2.0, 5.0

Supported Metadata Fields: Improvision Openlab LIFF

We currently have:

* an Openlab specification document (from 2000 February 8, in DOC)

* Improvision’s XLIFFFileImporter code for reading Openlab LIFF vS5 files (from 2006, in C++)

* several Openlab datasets

We would like to have:

* more Openlab datasets (preferably with 32-bit integer data)

Ratings
Pixels:
Metadata:

Openness:

134http://bio3d.colorado.edu/imod/doc/binspec.html

155https://github.com/openmicroscopy/bioformats/blob/develop/components/bio-formats/src/loci/formats/in/IMODReader.java

156 http://www.improvision.com/
57http://www.perkinelmer.com/
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Presence:

Utility:

Additional Information

Source Code: OpenlabReader.java'>®
Notes:

Please note that while we have specification documents for this format, we are not able to distribute them to
third parties.

See also:

Openlab software review'>”

17.46 Improvision Openlab Raw

Extensions: .raw

Developer: Improvision'®’

Owner: PerkinElmer'®!

Support

SCIFIO:

Export:

Officially Supported Versions:

Supported Metadata Fields: Improvision Openlab Raw

We currently have:
« an Openlab Raw specification document'®> (from 2004 November 09, in HTML)
 afew Openlab Raw datasets

We would like to have:

Ratings

Pixels:

Metadata:

Openness:

Presence:
Utility:
Additional Information

Source Code: OpenlabRawReader.java'®

158 https://github.com/openmicroscopy/bioformats/blob/develop/components/bio-formats/src/loci/formats/in/OpenlabReader.java
I5%http://www.improvision.com/products/openlab/

160http://www.improvision.com/

16T htp://www.perkinelmer.com/

162http://cellularimaging.perkinelmer.com/support/technical_notes/detail.php?id=344
163https://github.com/openmicroscopy/bioformats/blob/develop/components/bio-formats/src/loci/formats/in/OpenlabRawReader. java
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Notes:
See also:

Openlab software review!'%

17.47 Improvision TIFF

Extensions: .tif

Developer: Improvision'®

Owner: PerkinElmer'%

Support

SCIFIO:

Export:

Officially Supported Versions:

Supported Metadata Fields: lmprovision TIFF

We currently have:
* an Improvision TIFF specification document
 afew Improvision TIFF datasets

We would like to have:

Ratings

Pixels:

Metadata:

Openness:

Presence:

Utility:

Additional Information

Source Code: ImprovisionTiffReader.java'®’

Notes:

Please note that while we have specification documents for this format, we are not able to distribute them to

third parties.

See also:

Openlab software overview '8

164http://www.improvision.com/products/openlab/
165http://www.improvision.com/
166 http://www.perkinelmer.com/

167https://github.com/openmicroscopy/bioformats/blob/develop/components/bio-formats/src/loci/formats/in/ImprovisionTiffReader.java

18 http://www.improvision.com/products/openlab/
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17.48 InCell 1000

Extensions: .xdce, .tif
Developer: GE'®’
Support

SCIFIO:
Export:
Officially Supported Versions:
Supported Metadata Fields: /nCell 1000
We currently have:
* afew InCell 1000 datasets
We would like to have:
* an InCell 1000 specification document
» more InCell 1000 datasets
Ratings
Pixels:
Metadata:

Openness:

Presence:

Utility:

Additional Information

Source Code: InCellReader.java'”’

Notes:

17.49 InCell 3000

Extensions: .frm

Developer: GE!”!

Support

SCIFIO:

Export:

Officially Supported Versions:
Supported Metadata Fields: /nCell 3000

Sample Datasets:

19http://gelifesciences.com/

170https://github.com/openmicroscopy/bioformats/blob/develop/components/bio-formats/src/loci/formats/in/InCellReader. java

" http://gelifesciences.com/
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* Broad Bioimage Benchmark Collection'”?

We currently have:
* afew example datasets
We would like to have:
* an official specification document
Ratings
Pixels:
Metadata:

Openness:

Presence:

Utility:

Additional Information

Source Code: InCell3000Reader.java'”?

Notes:

17.50 INR

Extensions: .inr
Support
SCIFIO:
Export:
Officially Supported Versions:
Supported Metadata Fields: /NR
We currently have:
* several sample .inr datasets
We would like to have:
Ratings
Pixels:
Metadata:
Openness:
Presence:
Utility:

Additional Information

172 http://www.broadinstitute.org/bbbc/BBBCO013/

B3 nttps://github.com/openmicroscopy/bioformats/blob/develop/components/bio-formats/src/loci/formats/in/InCell3000Reader. java
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Source Code: INRReader.java'’*

Notes:

17.51 IPLab

Extensions: .ipl
Developer: Scanalytics
Owner: was BD Biosystems'”, now BioVision Technologies'”®

Support
SCIFIO:
Export:
Officially Supported Versions:
Supported Metadata Fields: /PLab
Freely Available Software:
« IPLab Reader plugin for Image]'”’
We currently have:
* an [PLab specification document (v3.6.5, from 2004 December 1, in PDF)
* several [PLab datasets
We would like to have:
* more [PLab datasets (preferably with 32-bit integer or floating point data)
Ratings
Pixels:

Metadata:

Openness:

Presence:

Utility:

Additional Information

Source Code: IPLabReader.java'’®
Notes:

Please note that while we have specification documents for this format, we are not able to distribute them to
third parties.

Commercial applications that support IPLab include:

174nttps://github.com/openmicroscopy/bioformats/blob/develop/components/bio-formats/src/loci/formats/in/INRReader. java
175 http://www.bdbiosciences.com/

76http://www.biovis.com/iplab.htm

1"http://rsb.info.nih.gov/ij/plugins/iplab-reader.html

178 https://github.com/openmicroscopy/bioformats/blob/develop/components/bio-formats/src/loci/formats/in/IPLabReader.java
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* Bitplane Imaris'”’

* SVI Huygens!'®
See also:

IPLab software review!®!

17.52 IPLab-Mac

Extensions: .ipm
Owner: BioVision Technologies'8?
Support
SCIFIO:
Export:
Officially Supported Versions:
Supported Metadata Fields: /PLab-Mac
We currently have:

 afew [PLab-Mac datasets

* a specification document
We would like to have:

* more [PLab-Mac datasets
Ratings
Pixels:
Metadata:

Openness:

Presence:

Utility:

Additional Information

Source Code: IvisionReader.java'®?

Notes:

Please note that while we have specification documents for this format, we are not able to distribute them to

third parties.

1" http://www.bitplane.com/
180http://svi.nl/

181 http://www.biovis.com/iplab.htm
182http://biovis.com/

183https://github.com/openmicroscopy/bioformats/blob/develop/components/bio-formats/src/loci/formats/in/IvisionReader.java
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17.53 JEOL

Extensions: .dat, .img, .par
Owner: JEOL '3
Support

SCIFIO:

Export:

Officially Supported Versions:

Supported Metadata Fields: JEOL

We currently have:
¢ Pascal code that reads JEOL files (from ImageSXM)
* afew JEOL files

We would like to have:
* an official specification document
* more JEOL files

Ratings

Pixels:

Metadata:

Openness:

Presence:

Utility:

Additional Information

Source Code: JEOLReader.java'®

Notes:

17.54 JPEG

Extensions: .jpg
Developer: Independent JPEG Group'#

Support
SCIFIO:
Export:

Officially Supported Versions:

184nttp://www.jeol.com

185https://github.com/openmicroscopy/bioformats/blob/develop/components/bio-formats/src/loci/formats/in/JEOLReader.java

186http://www.ijg.org/
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Supported Metadata Fields: JPEG

We currently have:
e a JPEG specification document'®’ (v1.04, from 1992 September 1, in PDF)
* numerous JPEG datasets
¢ the ability to produce more datasets

We would like to have:

Ratings

Pixels:

Metadata:

Openness:

Presence:

Utility:

Additional Information

Source Code: JPEGReader.java'®® Source Code: JPEGWriter.java'®’
Notes:

Bio-Formats can save individual planes as JPEG. Bio-Formats uses the Java Image 1/0'""" API to read and write JPEG
files. JPEG stands for “Joint Photographic Experts Group”.

See also:

JPEG homepage'®!

17.55 JPEG 2000

Extensions: .jp2
Developer: Independent JPEG Group'®?
Support
SCIFIO:
Export:
Officially Supported Versions:
Supported Metadata Fields: JPEG 2000
Freely Available Software:
« JJ2000 (JPEG 2000 library for Java)'®3

We currently have:

187 http://www.w3.org/Graphics/JPEG/jfif3.pdf

188 https://github.com/openmicroscopy/bioformats/blob/develop/components/scifio/src/loci/formats/in/TPEGReader.java
189 https://github.com/openmicroscopy/bioformats/blob/develop/components/scifio/src/loci/formats/out/JPEG Writer java
190http://java.sun.com/j2se/1.4.2/docs/guide/imageio/index.html

9T http://www.jpeg.org/jpeg/index.html

192nttp://www.ijg.org/

193http://code.google.com/p/jj2000/
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 a JPEG 2000 specification document'** (final draft, from 2000, in PDF)

» afew .jp2 files
We would like to have:
Ratings
Pixels:
Metadata:
Openness:
Presence:
Utility:

Additional Information

Source Code: JPEG2000Reader.java'® Source Code: JPEG2000Writer.java'?®

Notes:

Bio-Formats uses the JAI Image 1/0 Tools'"’ library to read JP2 files. JPEG stands for “Joint Photographic Experts

Group”.

17.56 JPK

Extensions: .jpk
Developer: JPK Instruments'”®

Support

SCIFIO:

Export:

Officially Supported Versions:

Supported Metadata Fields: JPK

We currently have:
* Pascal code that can read JPK files (from ImageSXM)
» afew JPK files

We would like to have:
* an official specification document
* more JPK files

Ratings

Pixels:

94nttp://www.jpeg.org/jpeg2000/CDs 15444 html

195https://github.com/openmicroscopy/bioformats/blob/develop/components/scifio/src/loci/formats/in/TPEG2000Reader. java
196 https://github.com/openmicroscopy/bioformats/blob/develop/components/scifio/src/loci/formats/out/JPEG2000Writer.java

19https://java.net/projects/jai-imageio
198nttp://www.jpk.com
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Metadata:

Openness:

Presence:

Utility:

Additional Information

Source Code: JPKReader.java'”®

Notes:

17.57 JPX

Extensions: .jpx
Developer: JPEG Committee’””

Support

SCIFIO:
Export:
Officially Supported Versions:
Supported Metadata Fields: JPX
We currently have:
e afew .jpx files
We would like to have:
Ratings
Pixels:
Metadata:

Openness:

Presence:

Utility:

Additional Information
Source Code: JPXReader.java®"!

Notes:

19https://github.com/openmicroscopy/bioformats/blob/develop/components/bio-formats/src/loci/formats/in/JPKReader.java

200http://www.jpeg.org/jpeg2000/

20Thttps://github.com/openmicroscopy/bioformats/blob/develop/components/bio-formats/src/loci/formats/in/JPXReader.java
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17.58 Khoros VIFF (Visualization Image File Format) Bitmap

Extensions: .xv

202

Developer: Khoral
Owner: AccuSoft*%?

Support
SCIFIO:
Export:
Officially Supported Versions:
Supported Metadata Fields: Khoros VIFF (Visualization Image File Format) Bitmap
Sample Datasets:
* VIFF Images’**
We currently have:

* several VIFF datasets
We would like to have:
Ratings
Pixels:

Metadata:

Openness:

Presence:

Utility:

Additional Information

Source Code: KhorosReader.java®>
Notes:

See also:

VisiQuest software overview (formerly known as KhorosPro)>%

17.59 Kodak BIP

Extensions: .bip

Developer: Kodak/Carestream?’

Support

202http://www.khoral.com/company/

203http://www.accusoft.com/company/

204http://metghost.narod.ru/gff/sample/images/viff/index.htm
205https://github.com/openmicroscopy/bioformats/blob/develop/components/bio-formats/src/loci/formats/in/KhorosReader java
206http://www.accusoft.com/products/visiquest/

207http://carestream.com
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SCIFIO:
Export:
Officially Supported Versions:
Supported Metadata Fields: Kodak BIP
We currently have:

* afew .bip datasets
We would like to have:

* an official specification document
Ratings
Pixels:
Metadata:

Openness:

Presence:

Utility:

Additional Information

Source Code: KodakReader.java®"®
Notes:

See also:

Information on Image Station systems"’

17.60 Lambert Instruments FLIM

Extensions: fli
Developer: Lambert Instruments”!'”

Support
SCIFIO:
Export:
Officially Supported Versions:
Supported Metadata Fields: Lambert Instruments FLIM
We currently have:
* an LI-FLIM specification document

* several example LI-FLIM datasets

208https://github.com/openmicroscopy/bioformats/blob/develop/components/bio-formats/src/loci/formats/in/KodakReader. java

209http://carestream.com/PublicContent.aspx?lang Type=1033&id=448953

210http://www.lambert-instruments.com
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We would like to have:
Ratings

Pixels:

Metadata:

Openness:

Presence:

Utility:

Additional Information

Source Code: LiFlimReader.java’!!
Notes:

Please note that while we have specification documents for this format, we are not able to distribute them to
third parties.

17.61 Leica LCS LEI

Extensions: .lei, .tif
Developer: Leica Microsystems CMS GmbH?!?
Owner: Leica®!?

Support
SCIFIO:

Export:
Officially Supported Versions:
Supported Metadata Fields: Leica LCS LEI
Freely Available Software:
* Leica LCS Lite?'*
We currently have:
* an LEI specification document (beta 2.000, from no later than 2004 February 17, in PDF)
* many LEI datasets
We would like to have:
Ratings
Pixels:
Metadata:

Openness:

21T https://github.com/openmicroscopy/bioformats/blob/develop/components/bio-formats/src/loci/formats/in/LiFlimReader.java
212http://www.leica-microsystems.com/

2B3http://www.leica.com/

214fip://ftp.11t.de/softlib/LCSLite/LCSLite2611537.exe
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Presence:

Utility:

Additional Information

Source Code: LeicaReader.java®!"
Notes:

Please note that while we have specification documents for this format, we are not able to distribute them to
third parties.

LCS stands for “Leica Confocal Software”. LEI presumably stands for “Leica Experimental Information”.
Commercial applications that support LEI include:

* Bitplane Imaris?'®
 SVI Huygens?!”

+ Image-Pro Plus’!®

17.62 Leica LAS AF LIF (Leica Image File Format)

Extensions: .lif
Developer: Leica Microsystems CMS GmbH?!”
Owner: Leica??”

Support

SCIFIO:

Export:

Officially Supported Versions: 1.0, 2.0

Supported Metadata Fields: Leica LAS AF LIF (Leica Image File Format)

Freely Available Software:
o Leica LAS AF Lite?®! (links at bottom of page)

We currently have:
 a LIF specification document (version 2, from no later than 2007 July 26, in PDF)
 a LIF specification document (version 1, from no later than 206 April 3, in PDF)
* numerous LIF datasets

We would like to have:

Ratings

Pixels:

215https://github.com/openmicroscopy/bioformats/blob/develop/components/bio-formats/src/loci/formats/in/LeicaReader.java
218http://www.bitplane.com/

217 http://svi.nl/

28http://www.mediacy.com/

29http://www.leica-microsystems.com/

220http://www.leica.com/

22T http://www.leica-microsystems.com/products/microscope-imaging-software/life-sciences/las-af-advanced-fluorescence/
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Metadata:

Openness:

Presence:

Utility:

Additional Information
Source Code: LIFReader.java®??
Notes:

Please note that while we have specification documents for this format, we are not able to distribute them to
third parties.

LAS stands for “Leica Application Suite”. AF stands for “Advanced Fluorescence”.
Commercial applications that support LIF include:

+ Bitplane Imaris???

 SVI Huygens?*

o Amira?®

17.63 Leica SCN

Extensions: .scn
Developer: Leica Microsystems>>°

Support

SCIFIO:
Export:
Officially Supported Versions: 2012-03-10
Supported Metadata Fields: Leica SCN
We currently have:
 afew sample datasets
We would like to have:
* an official specification document
 sample datasets that cannot be opened
Ratings
Pixels:
Metadata:

Openness:

222https://github.com/openmicroscopy/bioformats/blob/develop/components/bio-formats/src/loci/formats/in/LIFReader java
223http://www.bitplane.com/

224http://svi.nl/

225http://www.amira.com/

226http://www.leica-microsystems.com/
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Presence:

Utility:

Additional Information

Source Code: LeicaSCNReader.java®?’

Notes:

17.64 LEO

Extensions: .sxm
Owner: Zeiss??®

Support
SCIFIO:

Export:

Officially Supported Versions:

Supported Metadata Fields: LEO

We currently have:
* Pascal code that can read LEO files (from ImageSXM)
» afew LEO files

We would like to have:
* an official specification document
* more LEO files

Ratings

Pixels:

Metadata:

Openness:

Presence:

Utility:

Additional Information

Source Code: LEOReader.java®?’

Notes:

227https://github.com/openmicroscopy/bioformats/blob/develop/components/bio-formats/src/loci/formats/in/LeicaSCNReader. java

228http://www.zeiss.de

229https://github.com/openmicroscopy/bioformats/blob/develop/components/bio-formats/src/loci/formats/in/LEOReader java
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17.65 Li-Cor L2D

Extensions: .12d, .tif, .scn
Owner: LiCor Biosciences?

Support

SCIFIO:
Export:
Officially Supported Versions:
Supported Metadata Fields: Li-Cor L2D
We currently have:
» afew L2D datasets
We would like to have:
* an official specification document
* more L2D datasets
Ratings
Pixels:
Metadata:

Openness:

Presence:

Utility:

Additional Information

Source Code: L2DReader.java”!
Notes:

L2D datasets cannot be imported into OME using server-side import. They can, however, be imported from ImagelJ,
or using the omeul utility.

17.66 LIM (Laboratory Imaging/Nikon)

Extensions: .lim

Owner: Laboratory Imaging®*?
Support

SCIFIO:

Export:

Officially Supported Versions:

230http://www.licor.com/
23Thttps://github.com/openmicroscopy/bioformats/blob/develop/components/bio-formats/src/loci/formats/in/L2DReader. java
22http:/fwww.lim.cz/
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Supported Metadata Fields: LIM (Laboratory Imaging/Nikon)
We currently have:
 several LIM files
¢ the ability to produce more LIM files
We would like to have:
* an official specification document
Ratings
Pixels:
Metadata:

Openness:

Presence:

Utility:

Additional Information

Source Code: LLIMReader.java®*

Notes:

Bio-Formats only supports uncompressed LIM files.
Commercial applications that support LIM include:

 NIS Elements**

17.67 MetaMorph 7.5 TIFF

Extensions: .tiff
Owner: Molecular Devices>?

Support

SCIFIO:
Export:
Officially Supported Versions:
Supported Metadata Fields: MetaMorph 7.5 TIFF
We currently have:
* afew Metamorph 7.5 TIFF datasets
We would like to have:
Ratings

Pixels:

233https://github.com/openmicroscopy/bioformats/blob/develop/components/bio-formats/src/loci/formats/in/LIMReader. java
234http://www.nis-elements.com/
235http://www.moleculardevices.com/
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Metadata:

Openness:

Presence:

Utility:

Additional Information

236

Source Code: MetamorphTiffReader.java

Notes:

17.68 MetaMorph Stack (STK)

Extensions: .stk, .nd
. 2
Owner: Molecular Devices®?’

Support

SCIFIO:

Export:

Officially Supported Versions:

Supported Metadata Fields: MetaMorph Stack (STK)

We currently have:

* an STK specification document (from 2006 November 21, in DOC)
* an older STK specification document (from 2005 March 25, in DOC)

* an ND specification document (from 2002 January 24, in PDF)

* alarge number of datasets
We would like to have:
Ratings
Pixels:
Metadata:

Openness:

Presence:

Utility:

Additional Information

2238

Source Code: MetamorphReader.jav

Notes:

236https://github.com/openmicroscopy/bioformats/blob/develop/components/bio-formats/src/loci/formats/in/MetamorphTiffReader.java

27http://www.moleculardevices.com/

238ttps://github.com/openmicroscopy/bioformats/blob/develop/components/bio-formats/src/loci/formats/in/MetamorphReader.java
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Please note that while we have specification documents for this format, we are not able to distribute them to
third parties.

Commercial applications that support STK include:
* Bitplane Imaris?*’
 SVI Huygens?*
 DIMIN**!

See also:

Metamorph imaging system overview>*?

17.69 MIAS (Maia Scientific)

Extensions: .tif
Developer: Maia Scientific?*?
Support
SCIFIO:
Export:
Officially Supported Versions:
Supported Metadata Fields: MIAS (Maia Scientific)
We currently have:
» several MIAS datasets
We would like to have:
Ratings
Pixels:

Metadata:

Openness:

Presence:

Utility:

Additional Information

Source Code: MIASReader.java®**

Notes:

23%ttp://www.bitplane.com/

240http://svi.nl/

24T http://dimin.net/

22http://www.metamorph.com/

23 http://www.maia-scientific.com/
244nttps://github.com/openmicroscopy/bioformats/blob/develop/components/bio-formats/src/loci/formats/in/MIASReader java
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17.70 Micro-Manager

Extensions: .tif, .txt, .xml
Developer: Vale Lab**

Support

SCIFIO:
Export:
Officially Supported Versions:
Supported Metadata Fields: Micro-Manager
Freely Available Software:
* Micro-Manager®*¢
We currently have:
¢ many Micro-manager datasets
We would like to have:
Ratings
Pixels:

Metadata:

Openness:

Presence:

Utility:

Additional Information

Source Code: MicromanagerReader.java®*’

Notes:

17.71 MINC MRI

Extensions: .mnc
Developer: McGill University”*®

Support

SCIFIO:

Export:

Officially Supported Versions:
Supported Metadata Fields: MINC MRI

245http://valelab.ucsf.edu/
246http://micro-manager.org/

24Thttps://github.com/openmicroscopy/bioformats/blob/develop/components/scifio/src/loci/formats/in/MicromanagerReader java

248http://www.bic.mni.mcgill.ca/ServicesSoftware/MINC
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Freely Available Software:
« MINC?*¥®
We currently have:
» afew MINC files
We would like to have:
Ratings
Pixels:
Metadata:

Openness:

Presence:

Utility:

Additional Information

Source Code: MINCReader.java®’

Notes:

17.72 Minolta MRW

Extensions: .mrw
Developer: Minolta®!

Support

SCIFIO:
Export:
Officially Supported Versions:
Supported Metadata Fields: Minolta MRW
Freely Available Software:
* dcraw??
We currently have:
* several .mrw files
We would like to have:
Ratings
Pixels:
Metadata:

Openness:

249http://www.bic.mni.mcgill.ca/ServicesSoftware/MINC

250https://github.com/openmicroscopy/bioformats/blob/develop/components/bio-formats/src/loci/formats/in/MINCReader. java

2Thttp://www.konicaminolta.com/
252http://www.cybercom.net/% 7Edcoffin/dcraw/
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Presence:

Utility:

Additional Information

Source Code: MRWReader java>>?
Notes:

See also:

Description of MRW format?>*

17.73 MNG (Multiple-image Network Graphics)

Extensions: .mng
Developer: MNG Development Group>>
Support

SCIFIO:
Export:
Officially Supported Versions:
Supported Metadata Fields: MNG (Multiple-image Network Graphics)
Freely Available Software:
* libmng (MNG reference library)?>°
Sample Datasets:
* MNG sample files>’
We currently have:
e the libmng-testsuites™® package (from 2003 March 05, in C)
¢ alarge number of MNG datasets
We would like to have:
Ratings
Pixels:

Metadata:
Openness:
Presence:

Utility:

Additional Information

253https://github.com/openmicroscopy/bioformats/blob/develop/components/bio-formats/src/loci/formats/in/MRWReader.java
254http://www.dalibor.cz/files/MRW %20File%20Format.txt

255http://www.libpng.org/pub/mng/mngnews.html

256http://sourceforge.net/projects/libmng/
257http://sourceforge.net/projects/libmng/files/libmng-testsuites/MNGsuite-1.0/MNGsuite.zip/download
258http://downloads.sourceforge.net/libmng/MNGsuite-20030305.zip
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Source Code: MNGReader.java>”’
Notes:
See also:

MNG homepage?® MNG specification?!

17.74 Molecular Imaging

Extensions: .stp
Owner: Molecular Imaging?%?

Support

SCIFIO:

Export:

Officially Supported Versions:

Supported Metadata Fields: Molecular Imaging

We currently have:

* Pascal code that reads Molecular Imaging files (from ImageSXM)

» afew Molecular Imaging files
We would like to have:
* an official specification document
* more Molecular Imaging files
Ratings
Pixels:
Metadata:

Openness:

Presence:

Utility:

Additional Information

3

Source Code: MolecularlmagingReader.java®®

Notes:

259ttps://github.com/openmicroscopy/bioformats/blob/develop/components/scifio/src/loci/formats/in/MNGReader java

260http://www.libpng.org/pub/mng/
261 http://www.libpng.org/pub/mng/spec
26Zhttp://www.molecularimagingcorp.com

263https://github.com/openmicroscopy/bioformats/blob/develop/components/bio-formats/src/loci/formats/in/MolecularimagingReader. java
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17.75 MRC (Medical Research Council)

Extensions: .mrc
Developer: MRC Laboratory of Molecular Biology?*

Support

SCIFIO:
Export:
Officially Supported Versions:
Supported Metadata Fields: MRC (Medical Research Council)
Sample Datasets:
* golgi.mrc?%
We currently have:
* an MRC specification document®®® (in HTML)
« another MRC specification document?®’ (in TXT)
» afew MRC datasets
We would like to have:
Ratings
Pixels:
Metadata:

Openness:

Presence:

Utility:

Additional Information

Source Code: MRCReader.java”®®

Notes:

Commercial applications that support MRC include:
* Bitplane Imaris®®’

See also:

MRC on Wikipedia®”°

264http://www2.mrc-lmb.cam.ac.uk/

265http://bio3d.colorado.edu/imod/files/imod_data.tar.gz

266http://ami.scripps.edu/software/mrctools/mrc_specification.php

267 http://bio3d.colorado.edu/imod/doc/mrc_format.txt
268https://github.com/openmicroscopy/bioformats/blob/develop/components/bio-formats/src/loci/formats/in/MRCReader.java
269http://www.bitplane.com/

2T0http://en.wikipedia.org/wiki/MRC_%28file_format%29
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17.76 NEF (Nikon Electronic Format)

Extensions: .nef, .tif
Developer: Nikon?’!

Support

SCIFIO:
Export:
Officially Supported Versions:
Supported Metadata Fields: NEF (Nikon Electronic Format)
Sample Datasets:
* neffilel.zip?’?
 Sample NEF images?’?
We currently have:
* a NEF specification document (v0.1, from 2003, in PDF)
* several NEF datasets
We would like to have:
Ratings
Pixels:
Metadata:

Openness:

Presence:

Utility:

Additional Information

Source Code: NikonReader.java®’*

Notes:

Please note that while we have specification documents for this format, we are not able to distribute them to
third parties.

See also:

. 2
NEF Conversion?”?

2T http://www.nikon.com/

272http://www.outbackphoto.com/workshop/NEF_conversion/neffile1.zip
2T3http://www.nikondigital.org/articles/library/nikon_d2x_first_impressions.htm
2T4nhttps://github.com/openmicroscopy/bioformats/blob/develop/components/bio-formats/src/loci/formats/in/NikonReader java
275 http://www.outbackphoto.com/workshop/NEF_conversion/nefconversion.html
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17.77 NIfTI

Extensions: .img, .hdr
Developer: National Institutes of Health?’¢

Support

SCIFIO:
Export:
Officially Supported Versions:
Supported Metadata Fields: NIfTI
Sample Datasets:
» Official test data®”’
We currently have:
* NIfTI specification documents®’®
* several NIfTT datasets
We would like to have:
Ratings
Pixels:

Metadata:

Openness:

Presence:

Utility:

Additional Information

9

Source Code: NiftiReader.java®’

Notes:

17.78 Nikon Elements TIFF

Extensions: .tiff
Developer: Nikon”
Support

SCIFIO:

Export:

276http://www.nih.gov/
277 http://nifti.nimh.nih.gov/nifti-1/data
278http://nifti.nimh.nih.gov/nifti-1/

279ttps://github.com/openmicroscopy/bioformats/blob/develop/components/bio-formats/src/loci/formats/in/NiftiReader.java

280http://www.nikon.com

17.77. NIfTI
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Officially Supported Versions:
Supported